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                                                                     Περίληψη 

Σκοπός της παρούσας διπλωματικής εργασίας αποτελεί  η ανάπτυξη και 

υλοποίηση κατάλληλου αλγορίθμου - λογισμικού για την αυτόματη αναγνώριση 

δακτυλικών αποτυπωμάτων με χρήση εξελιγμένων τεχνικών ψηφιακής επεξεργασίας 

εικόνας. Το δακτυλικό αποτύπωμα ενός ατόμου αποτελεί μοναδικό χαρακτηριστικό 

του και συνδέεται άμεσα με την αναγνώριση και ταυτοποίησή του. 

Συγκεκριμένα, στα πλαίσια της διπλωματικής εργασίας, πραγματοποιείται 

αρχικά αναλυτική παρουσίαση των βασικών προβλημάτων που παρουσιάζονται κατά 

την αναγνώριση των δακτυλικών αποτυπωμάτων σε συνδυασμό με μία αναλυτική 

καταγραφή υπαρχόντων συστημάτων και αλγορίθμων που έχουν διεθνώς 

παρουσιαστεί προς την κατεύθυνση της αυτόματης αναγνώρισης δακτυλικών 

αποτυπωμάτων. Το μεγαλύτερο μέρος της διπλωματικής εργασίας αφορά στην 

παρουσίαση ενός αλγόριθμου για την αναγνώριση των δακτυλικών αποτυπωμάτων 

που βασίζεται κυρίως στη βελτίωση της ποιότητας των αρχικών εικόνων και στην 

εφαρμογή τεχνικών ευθυγράμμισης μέσω των απαραίτητων προσαρμογών. Επίσης, 

παρουσιάζονται αναλυτικά ποιοτικά και ποσοτικά αποτελέσματα από την εφαρμογή 

του αλγορίθμου σε πραγματικά δεδομένα συλλεγμένα σε διαφορετικές συνθήκες. 

Η μεθοδολογία αυτή μπορεί να γίνει οδηγός για την πραγματοποίηση 

μετρήσεων πάνω σε βάσεις δεδομένων δακτυλικών αποτυπωμάτων με απλές αλλαγές 

στις παραμέτρους όπως αυτές περιγράφονται στα πλαίσια της διπλωματικής αυτής 

εργασίας. 

Λέξεις Κλειδιά 

Δακτυλικά αποτυπώματα, αυτόματη ευθυγράμμιση, βελτίωση, αυτόματη αναγνώριση 

αποτυπωμάτων, ψηφιακή επεξεργασία εικόνας. 
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Abstract 

The scope of this thesis was the development and implementation of an 

algorithm – software in order to automatically recognize fingerprints using advanced 

digital image processing techniques. The fingerprint of an individual comprises a 

unique characteristic and could be associated with its recognition and identification. 

Specifically, as part of present thesis, there was discussed a detailed 

presentation of the basic problems  that occur during the recognition of fingerprints in 

conjunction with a detailed record of existing systems and algorithms that  

internationally occur in the direction of automatic fingerprint identification. Most of 

the present thesis relates to presenting an algorithm for the identification of 

fingerprints based mainly on improving the quality of the original images and the 

implementation of registration techniques using the required adjustments. It also 

presents extensive qualitative and quantitative results from the algorithm’s application 

on real data collected under different circumstances. 

This methodology can be a guide for making measurements on fingerprint 

databases with simple changes in the parameters described in the present thesis. 

Keywords 

Fingerprints, automatic registration, enhancement, automatic fingerprint recognition, 

digital image processing. 
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Κεφάλαιο 1- Εισαγωγή 

1.1 Σκοπός της Διπλωματικής Εργασίας 

Σκοπός της παρούσας διπλωματικής εργασίας αποτελεί  η ανάπτυξη και 

υλοποίηση κατάλληλου αλγορίθμου - λογισμικού για την αυτόματη αναγνώριση 

δακτυλικών αποτυπωμάτων με χρήση εξελιγμένων τεχνικών ψηφιακής επεξεργασίας 

εικόνας. Το δακτυλικό αποτύπωμα ενός ατόμου αποτελεί μοναδικό χαρακτηριστικό 

του και συνδέεται άμεσα με την αναγνώριση και ταυτοποίησή του. Στα πλαίσια της 

διπλωματικής εργασίας, πραγματοποιείται αρχικά αναλυτική παρουσίαση των 

βασικών προβλημάτων που παρουσιάζονται κατά την αναγνώριση των δακτυλικών 

αποτυπωμάτων σε συνδυασμό με μία αναλυτική καταγραφή υπαρχόντων 

συστημάτων και αλγορίθμων που έχουν διεθνώς παρουσιαστεί προς την κατεύθυνση 

της αυτόματης αναγνώρισης δακτυλικών αποτυπωμάτων. Το μεγαλύτερο μέρος της 

διπλωματικής εργασίας αφορά στην παρουσίαση ενός αλγόριθμου για την 

αναγνώριση των δακτυλικών αποτυπωμάτων που βασίζεται κυρίως στη βελτίωση της 

ποιότητας των αρχικών εικόνων και στην εφαρμογή τεχνικών ευθυγράμμισης μέσω 

των απαραίτητων προσαρμογών. Επίσης, παρουσιάζονται αναλυτικά ποιοτικά και 

ποσοτικά αποτελέσματα από την εφαρμογή του αλγορίθμου σε πραγματικά δεδομένα 

συλλεγμένα σε διαφορετικές συνθήκες. 

1.2 Εισαγωγή 

1.2.1 Βασικοί Βιομετρικοί Παράμετροι 

Ανάμεσα στις βασικές καινοτόμες δυνατότητες της αποκαλούμενης 

Κοινωνίας της Πληροφορίας και μέσα στα πλαίσια των μελλοντικών επικοινωνιακών 

συστημάτων , διαπιστώνει κανείς πως η σχεδίαση των τελευταίων θα πρέπει να 

περιλαμβάνει σειρά από εργαλεία για τη διασφάλιση του προσωπικού απορρήτου. 

Επιπλέον, παρατηρείται σήμερα σε όλο τον κόσμο μία μεγάλη κινητικότητα όσον 

αφορά στο θέμα της προσβασιμότητας σε χώρους αυξημένης ή/και υψηλής 

ασφάλειας. Στην περίπτωση αυτή, απαιτείται ο έλεγχος της πρόσβασης μόνο σε 

εξουσιοδοτημένα άτομα μέσω κατάλληλων συστημάτων. Τέλος, θεωρείται 

απαραίτητη η εγκατάσταση και λειτουργία σε καθημερινή βάση συγκεκριμένων 
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συστημάτων όπως στην Αστυνομία προκειμένου να πραγματοποιείται η αναγνώριση 

και ταυτοποίηση συγκεκριμένων ατόμων για τα οποία υπάρχει ένδειξη τέλεσης 

αξιόποινων πράξεων. Για όλα τα παραπάνω, η τεχνολογία σήμερα είναι σε θέση να 

παρέχει συγκεκριμένες λύσεις – συστήματα τα οποία μπορούν να διασφαλίσουν ως 

ένα βαθμό τις προαναφερθείσες απαιτήσεις. Τα συστήματα αυτά βασίζονται στην 

αξιοποίηση Βιομετρικών Παραμέτρων που συνδέονται κατά μοναδικό τρόπο με 

κάθε άτομο. Στους Βιομετρικούς Παραμέτρους περιλαμβάνονται τα δακτυλικά 

αποτυπώματα, τα χαρακτηριστικά του προσώπου, η ίριδα του οφθαλμού, ο 

αμφιβληστροειδής καθώς και η φωνή του ατόμου. Οι μετρήσεις και οι υπολογισμοί 

των παραπάνω Βιομετρικών Παραμέτρων αποτελούν τη βάση της ανάπτυξης μίας 

πλειάδας συστημάτων και αλγορίθμων μερικά από τα οποία αποτελούν εμπορικά 

πακέτα που χρησιμοποιούνται στην καθημερινή πρακτική με τους όποιους 

περιορισμούς.  

Στη συγκεκριμένη διπλωματική εργασία επικεντρωνόμαστε στην αυτόματη 

αναγνώριση δακτυλικών αποτυπωμάτων ως μία βασική Βιομετρική Παράμετρο που 

χρησιμοποιείται ευρέως στην καθημερινή πρακτική.  

1.2.2 Τα δακτυλικά αποτυπώματα  

Ένα δακτυλικό αποτύπωμα είναι ένα πρότυπο του κάθε ατόμου αποτελούμενο 

από κορυφογραμμές και κοιλάδες πάνω στην επιφάνεια του δακτύλου του. Τα 

δακτυλικά αποτυπώματα κάθε ατόμου είναι μοναδικά. Αυτή η μοναδικότητα 

καθορίζεται αφενός από τα τοπικά χαρακτηριστικά των κορυφογραμμών και 

αφετέρου από τη σχέση που υπάρχει μεταξύ τους. 

1.2.3 Χαρακτηριστικά δακτυλικών αποτυπωμάτων 

 Σε ένα δακτυλικό αποτύπωμα μπορούν να εντοπιστούν έως και 150 

διαφορετικά τοπικά χαρακτηριστικά (νησίδες, κοντές κορυφογραμμές, περιφράξεις 

και άλλα) τα οποία καλούνται μικρολεπτομέρειες1. Αυτά τα τοπικά χαρακτηριστικά 

δεν είναι ομαλά κατανεμημένα πάνω στο δάκτυλο. Τα περισσότερα από αυτά 

εξαρτώνται από τις συνθήκες αποτύπωσης (μέθοδο επίπεδης ή ολισθαίνουσας 

                                                           
1 Στην αγγλική βιβλιογραφία αναφέρονται ως minutiae. 
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αποτύπωσης, με χρήση μελάνης ή ηλεκτρονικού σαρωτή) και την ποιότητα του 

δακτυλικού αποτυπώματος. Τα δύο πιο προεξέχοντα χαρακτηριστικά είναι : 

1. Τελείωμα-Κορυφογραμμής 

2. Διακλαδώσεις-Κορυφογραμμών 

Ως τελείωμα-κορυφογραμμής νοείται το σημείο όπου η κορυφογραμμή 

τερματίζει απότομα. Ως διακλάδωση-κορυφογραμμής νοείται το σημείο όπου μία 

κορυφογραμμή διχαλώνετε ή διαχωρίζεται σε δύο νέες κορυφογραμμές. Μια 

χαρακτηριστική  εικόνα δακτυλικού αποτυπώματος παρουσιάζεται στο Σχήμα 1.1 

στην οποία περιλαμβάνονται  40-100 μικρολεπτομέρειες . 

 

 

Σχήμα 1.1 Μικρολεπτομέρειες σε ένα δακτυλικό αποτύπωμα. 

 

Η μορφολογία και η τοπολογία των κορυφογραμμών και των κοιλάδων πάνω 

στο δακτυλικό αποτύπωμα επιτρέπει  την εφαρμογή κατάλληλων  μαθηματικών 

μοντέλων και αλγορίθμων επεξεργασίας εικόνων προκειμένου να εξαχθούν 

κατάλληλες πληροφορίες που χαρακτηρίζουν κάθε δακτυλικό αποτύπωμα βάσει τις 

οποίες πραγματοποιείται τελικά η αναγνώριση και ταυτοποίηση των ατόμων.  
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1.2.4 Βασικά προβλήματα αναγνώρισης δακτυλικών αποτυπωμάτων 

Η αυτόματη αναγνώριση δακτυλικών αποτυπωμάτων αποτελεί μία δύσκολη 

και επίμονη διαδικασία. Δεν είναι τυχαίο το γεγονός ότι μέχρι σήμερα πολλά από τα 

υπάρχοντα συστήματα που χρησιμοποιούνται στην καθημερινή πρακτική 

παρουσιάζουν μειονεκτήματα και σφάλματα στην αναγνώριση των δακτυλικών 

αποτυπωμάτων. Επιπλέον, υπάρχει σημαντική βιβλιογραφική καταγραφή διεθνώς 

όσον αφορά στην ανάπτυξη τεχνικών και αλγορίθμων για τη βελτίωση των 

σφαλμάτων αυτών και τη διασφάλιση της πιο έγκυρης αναγνώρισης ατόμων με βάση 

τα δακτυλικά τους αποτυπώματα.  

Στα κύρια προβλήματα της αναγνώρισης των δακτυλικών αποτυπωμάτων 

περιλαμβάνονται: 

1. Διαφορετικές συνθήκες αποτύπωσης: όπως μέθοδο επίπεδης ή κυλιόμενης 

(ολισθαίνουσας) αποτύπωσης, με χρήση μελάνης ή ηλεκτρονικού σαρωτή. 

Κατά την μέθοδο της επίπεδης αποτύπωσης το δάκτυλο τοποθετείτε 

κατακόρυφα στην επιφάνεια αποτύπωσης και κατόπιν απομακρύνεται από 

αυτήν. Στην περίπτωση της κυλιόμενης (ολισθαίνουσας) αποτύπωσης το 

δάκτυλο ολισθαίνει πάνω στην επιφάνεια από νύχι προς νύχι. Όσον αφορά 

τους  τύπους αποτύπωσης η μέθοδος που χρησιμοποιείται ευρέως ακόμα και 

σήμερα είναι αυτή της χρήσης μελανωτήρα. Ο μελανωτήρας είναι μία 

σκληρή πορώδης πλαστική επιφάνεια πάνω στην οποία διαγράφεται καθαρά 

το δακτυλικό αποτύπωμα αποκαλύπτοντας τις κορυφογραμμές και τις 

κοιλάδες που το χαρακτηρίζουν. Τέλος ο ηλεκτρονικός σαρωτής είναι μία 

συσκευή που αποτελείται από  γυάλινη κυλινδρική επιφάνεια πάνω από μία 

κάμερα η οποία καταγράφει τις λεπτομέρειες του δακτύλου.       

2. Τρόπος τοποθέτησης του δακτύλου: ο τρόπος με τον οποίο το άτομο 

τοποθετεί το δάκτυλο του πάνω στην επιφάνεια αποτύπωσης επηρεάζει 

σημαντικά την διαδικασία της αυτόματης αναγνώρισης. Ακόμα και αν οι 

λήψεις, του ίδιου δακτύλου, γίνουν διαδοχικά η μία μετά την άλλη, οι εικόνες 

που προκύπτουν μπορεί να διαφέρουν κατά οριζόντια ή/και κατακόρυφη  

μετατόπιση καθώς και κατά γωνία. Αυτό επιβαρύνει την διαδικασία 

Με σχόλια [b1]: Είναι σαφές ότι ακόμα και αν η λήψη του 
αποτυπώματος γίνει η μία μετά την άλλη την ίδια στιγμή οι εικόνες 
θα είναι μετατοπισμένες ? 
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ευθυγράμμισης του αποτυπώματος που απαιτείται πριν από την σύγκριση 

του.     

3. Μεταβολές δακτυλικού αποτυπώματος: Η παραμόρφωση του δακτυλικού 

αποτυπώματος μπορεί να οφείλεται σε αλλοιώσεις λόγο τοπικού εγκαύματος 

ή κοψίματος καθώς και άλλων επιφανειακών τραυματισμών. Αυτή η 

παραμόρφωση στο δακτυλικό αποτύπωμα είναι λογικό να δυσχεράνει την 

διαδικασία αναγνώρισης ιδιαίτερα στην περίπτωση που γίνεται σύγκριση με 

εικόνα που έχει ληφθεί πριν από την αλλοίωση. Παραμόρφωση όμως μπορεί 

να παρατηρηθεί και από τον τρόπο λήψης του αποτυπώματος. Για 

παράδειγμα στην περίπτωση της επίπεδης αποτύπωσης που προαναφέραμε 

εάν το άτομο πιέσει περισσότερο το δάκτυλο σε μία από τις διαδοχικές 

λήψεις, το δακτυλικό αποτύπωμα θα υποστεί μη γραμμική παραμόρφωση. Η 

παραμόρφωση αυτή οφείλεται στην προσπάθεια αποτύπωσης μιας 

τρισδιάστατης επιφάνειας ,όπως είναι το δάκτυλο, πάνω σε μία δισδιάστατη 

που είναι ο μελανωτήρας και ο ηλεκτρονικός σαρωτής. Είναι λογικό λοιπόν η 

πίεση που ασκείται, κατά την λήψη να παίζει σημαντικό ρόλο στην τελική 

εικόνα.     

4. Ύπαρξη θορύβου: Ως θόρυβος νοείται οποιαδήποτε πληροφορία 

εμπεριέχεται στη συλλεγμένη εικόνα δακτυλικού αποτυπώματος η οποία δεν 

σχετίζεται με τα κύρια χαρακτηριστικά του. Ο θόρυβος μπορεί να εισάγεται 

είτε κατά τη συλλογή των δεδομένων (ύπαρξη μικρών στοιχείων – 

σκουπιδιών) είτε από τον τρόπο ψηφιοποίησης και δημιουργίας της εικόνας 

από το εκάστοτε σύστημα συλλογής και αποτύπωσης της πληροφορίας του 

δακτυλικού αποτυπώματος. 

Τα προαναφερθέντα προβλήματα αποτελούν τους βασικούς παραμέτρους για 

τη βελτίωση της επεξεργασίας και αναγνώρισης των δακτυλικών αποτυπωμάτων 

μέσω κατάλληλων τεχνικών και αλγορίθμων ψηφιακής επεξεργασίας εικόνας, όπως 

άλλωστε παρουσιάζονται στα πλαίσια της παρούσας διπλωματικής εργασίας. 

 

Με σχόλια [b2]: Άλλη λέξη πιο κόσμια 

Με σχόλια [b3]: Ίσως σαφέστερη διατύπωση 
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1.3 Διάρθρωση Διπλωματικής Εργασίας 

Η παρούσα διπλωματική εργασία διαρθρώνεται ως εξής:  

Στο Κεφάλαιο 2 γίνεται αναλυτική παρουσίαση των υπαρχόντων συστημάτων 

– τεχνικών προς την κατεύθυνση της αυτόματης αναγνώρισης δακτυλικών 

αποτυπωμάτων. Συγκεκριμένα, στην παράγραφο 2.2 παρουσιάζονται οι βασικές 

περιοχές ενδιαφέροντος στις ήδη υπάρχουσες βάσεις δεδομένων δακτυλικών 

αποτυπωμάτων, καθώς και η μεθοδολογία αποτίμησης των υπαρχόντων συστημάτων 

αναγνώρισης και ταυτοποίησης τους. Επιπλέον στην παράγραφο 2.3 

πραγματοποιείται μία βιβλιογραφική ανασκόπηση σχετικά με τις πρόσφατες τεχνικές 

προς την κατεύθυνση της αυτόματης αναγνώρισης δακτυλικών αποτυπωμάτων.   

Στο Κεφάλαιο 3 πραγματοποιείται αναλυτική παρουσίαση της μεθοδολογικής 

προσέγγισης που προτείνεται στα πλαίσια της διπλωματικής εργασίας. 

Αναλυτικότερα, στην παράγραφο 3.2, παρουσιάζονται τα βασικά τμήματα του 

αλγορίθμου που αναπτύχθηκε. Εν συνεχεία, το κάθε ένα από αυτά, αναλύεται, τόσο 

σε μαθηματικό όσο και σε  τεχνικό επίπεδο και σχολιάζονται ενδεχόμενες 

προτιμήσεις σε βέλτιστες τιμές παραμέτρων και επιλογής κατάλληλων τεχνικών 

ψηφιακής επεξεργασίας εικόνας.  

Στο Κεφάλαιο 4 παρουσιάζονται αποτελέσματα της αυτόματης αναγνώρισης 

δακτυλικών αποτυπωμάτων. Αυτά διαρθρώνονται σε 7 ενότητες. Αρχικά, 

παρουσιάζεται η θεωρητική προσέγγιση των διαφόρων κριτηρίων που επιλέχθηκαν 

για την αξιολόγηση τόσο των ποιοτικών όσο και των ποσοτικών αποτελεσμάτων. Στη 

συνέχεια, πραγματοποιείται παρουσίαση των ποιοτικών αποτελεσμάτων, πρώτα για 

την επιλογή του καταλληλότερου μετασχηματισμού και έπειτα για την εφαρμογή του 

αλγορίθμου σε πραγματική βάση δεδομένων δακτυλικών αποτυπωμάτων. Τέλος 

παρουσιάζονται τα ποσοτικά αποτελέσματα που προέκυψαν από την χρήση της 

διεπαφής που αναπτύχθηκε για το σκοπό αυτό.   

Στο Κεφάλαιο 5 γίνεται παρουσίαση της διαπαφής που αναπτύχθηκε με βάση 

την θεωρητική προσέγγιση του αλγορίθμου που παρουσιάζεται στο κεφάλαιο 3.  

Με σχόλια [b4]: Θα συμπληρωθεί στο τέλος αφού υπάρξει μία 
τελική διάρθρωση των κεφαλαίων. 
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Τέλος, στο Κεφάλαιο 6, πραγματοποιείται μία ανακεφαλαίωση των όσων 

παρουσιάστηκαν στα επιμέρους κεφάλαια, όπως επίσης και μελλοντικές προεκτάσεις 

που ενδέχεται να υπάρξουν προς την βελτιστοποίηση του συγκεκριμένου αλγορίθμου. 

Επίσης πραγματοποιείται μία σύγκριση του τελευταίου, με άλλες μεθόδους που έχουν 

κατά καιρούς αναπτυχθεί προς την κατεύθυνση της αυτόματης αναγνώρισης 

δακτυλικών αποτυπωμάτων με χρήση τεχνικών ψηφιακής επεξεργασίας εικόνων.  

 

 

Κεφάλαιο 2 - Παρουσίαση των υπαρχόντων συστημάτων – τεχνικών  

2.1 Εισαγωγή 

Στο Κεφάλαιο 2 πραγματοποιείται αναλυτική βιβλιογραφική ανασκόπηση των 

σημαντικότερων τεχνικών και αλγορίθμων από το χώρο της ψηφιακής επεξεργασίας 

εικόνων σε τεχνικά θέματα που σχετίζονταιπου έχουν εφαρμοστεί με για την 

αναγνώριση δακτυλικών αποτυπωμάτων και την ταυτοποίησή τους. Συγκεκριμένα, 

παρατίθενται στοιχεία που αφορούν στις κυριότερες βάσεις δεδομένων δακτυλικών 

αποτυπωμάτων διεθνώς και οι οποίες χρησιμοποιούνται για περαιτέρω επεξεργασία 

και ανάλυσή τους καθώς και σε μεθοδολογικές προσεγγίσεις για την αποτίμηση της 

απόδοσης μετά την εφαρμογή τεχνικών αναγνώρισης και ταυτοποίησης δακτυλικών 

αποτυπωμάτων. Στη συνέχεια πραγματοποιείται αναλυτική βιβλιογραφική αναφορά 

με έμφαση σε μεθόδους και τεχνικές από το χώρο της ψηφιακής επεξεργασίας 

εικόνων για την αυτόματη αναγνώριση και ταυτοποίηση δακτυλικών αποτυπωμάτων.  

2.2 Βάσεις Δεδομένων Δακτυλικών Αποτυπωμάτων – Μεθοδολογία Αποτίμησης 

της Απόδοσης Υπαρχόντων Συστημάτων  

2.2.1 Γενικά 

 Ο έλεγχος και η αξιολόγηση των συστημάτων αναγνώρισης και ταυτοποίησης 

δακτυλικών αποτυπωμάτων στο πλαίσιο της έρευνας και ανάπτυξης είναι 

πολλοίαποτελούν σημαντικούςί παράγοντες προκειμένου το υπό εξέταση σύστημα να 

καταστεί χρηστικό και αξιόπιστο στην καθημερινή του χρήση. Σήμερα διεθνώς 

υπάρχουν πολλοί οργανισμοί που ασχολούνται με  τη διαδικασία ελέγχου και 
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αξιολόγησης με πιο σημαντικό το Εθνικό Ινστιτούτο Τύπων και Τεχνολογίας των 

Ηνωμένων Πολιτειών Αμερικής (NIST2). 

2.2.2 Περιοχές ενδιαφέροντος  

 Οι τέσσερεις βασικές περιοχές ενδιαφέροντος κατά τον έλεγχο και 

αξιολόγηση των συστημάτων αυτόματης αναγνώρισης δακτυλικών αποτυπωμάτων 

είναι οι εξής : 

 

1 Ανάπτυξη πειραματικών συνόλων δεδομένων (datasets) 

2 Διεξαγωγή αναφορών απόδοσης 

3 Τεχνολογική ανάπτυξη 

4 Συμμετοχή στη δημιουργία πΠροτύπων 

 

Οι πιο πάνω περιοχές αποτελούν το πλαίσιο έρευνας και ανάπτυξης για 

αξιολόγηση της τεχνολογίας στο χώρο της αναγνώρισης και ταυτοποίησης ατόμων. 

Το πλαίσιο αυτό χρησιμοποιείται ευρέως σε λιμάνια, αεροδρόμια, συνοριακούς 

σταθμούς, σε αστυνομικές εφαρμογές και αλλού. 

 

2.2.2.1 Ανάπτυξη πειραματικών συνόλων δεδομένων (datasets) 

 

 Ο πιο κρίσιμος παράγοντας για την επιτυχή αξιολόγηση των βιομετρικών 

συστημάτων και συγκεκριμένα των συστημάτων αναγνώρισης και ταυτοποίησης 

ατόμων μέσω των δακτυλικών τους αποτυπωμάτων, είναι τα ίδια τα δεδομένα. Αυτό 

ισχύει σε κάθε εφαρμογή προτύπου αναγνώρισης. Ένα βασικό μειονέκτημα της 

έρευνας της ανάπτυξης τεχνικών αναγνώρισης δακτυλικών αποτυπωμάτων αποτελεί 

το πολύ μικρό δείγμα διαθέσιμων δεδομένων . Τα μεγαλύτερα σύνολα δεδομένων 

δακτυλικών αποτυπωμάτων τα έχει ο Κυβερνητικός Οργανισμός των Ηνωμένων 

Πολιτειών Αμερικής, NIST. Τα δεδομένα αυτά προέρχονται από συνεργασίες του 

Ινστιτούτου με το FBI3,DOD4, καθώς και με άλλες ομοσπονδιακές και τοπικές αρχές.  

                                                           
2 NIST – National Institute of Standards and Technology 

3 FBI   – Federal  Bureau of Investigation 
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Υπάρχουν πολλά διαφορετικά σύνολα δεδομένων δακτυλικών αποτυπωμάτων 

– Βάσεις Δεδομένων, τα σημαντικότερα από τα οποία παρουσιάζονται στον Πίνακα 

2.1 με βάση τον τρόπο συλλογής των αποτυπωμάτων, το πλήθος υπαρχόντων 

δεδομένων καθώς και την ποιότητας της πληροφορίας. Αναλυτικότερα: 

 

 

 

 

 

 : 

 

ΟΝΟΜΑ ΤΥΠΟΣ 

ΣΑΡΩΣΗΣ 

ΕΠΙΠΕΔΟ ΟΛΙΣΘΑΙ-

ΝΟΝ 

ΕΛΕΓΧΟΣ ΜΕΓΕΘΟΣ ΠΟΙΟΤΗΤ

Α 

SD 14 (V2) Μελάνι 

/Ζωντανή 

- 10 Ολισθαίνον: 

Ολισθαίνον 

2.700 ζεύγη καρτών Μέτρια 

SD 24 Ζωντανή 

(DFR 90) 

10  Επίπεδος : Επίπεδος 80 δάκτυλα Καλή 

SD 29 Μελάνι 10 10 Ολισθαίνον: 

Ολισθαίνον Επίπεδο: 

Επίπεδο 
Επίπεδο: Ολισθαίνον 

216 ζεύγη καρτών Μέτρια 

INS 

INDEX 

Ζωντανή 

(DFR 90) 

Τρέχον  Επίπεδο :Επίπεδο 620 x103 

αντικείμενα 

3x106 εικόνες 

Λειτουργική 

INS 

Benefits 

96% 

Ζωντανή ,4% 

Επανασάρωσ

η 

10 10 Ολισθαίνον: 

Ολισθαίνον Επίπεδο: 

Επίπεδο 

Επίπεδο: Ολισθαίνον 

640x103 

αντικείμενα 

Λειτουργική 

DOS-BCC Ζωντανή 

(DFR 90) 

Τρέχον  Επίπεδο: Επίπεδο 6x106 αντικείμενα 

240x103 

συνδυασμοί 

Λειτουργική 

INS 

CARD 

Μελάνι 10 10 Επίπεδο: Ολισθαίνον 100x103 κάρτες Λειτουργική 

TX 60% Μελάνι, 

40% 

Ζωντανή 

10 10 Επίπεδο: Ολισθαίνον 1x106 κάρτες Λειτουργική 

IAFIS Μελάνι / 
Ζωντανή 

10 10 Ολισθαίνον: 
Ολισθαίνον  

Επίπεδο : Ολισθαίνον. 

1,2 x106 κάρτες Λειτουργική 

ESD Ζωντανή Τρέχον 10 Επίπεδο : Ολισθαίνον. 3x103 κάρτες Καλή 

US-VISIT 

Jan. 04-

Feb. 04 

Ζωντανή Τρέχον  Επίπεδο.: Επίπεδο. 1,7x106 αντικείμενα 

34x103 συνδυασμοί 

Καλή 

US-VISIT 

Mar. 04-

Jun. 04 

Ζωντανή 10  Επίπεδο: Επίπεδο. 3,7x106 αντικείμενα Καλή 

LA 

County 

90% 
Ζωντανή, 

10% 

Επανασάρωσ
η 

10 10 Ολισθαίνον.: 
Ολισθαίνον. 

Επίπεδο: Ολισθαίνον 

Επίπεδο: Επίπεδο 

1,5x106 αντικείμενα 
100x103 

συνδυασμοί 

Καλή 

AZ 60% Μελάνι, 10 10 Επίπεδο: Ολισθαίνον 179x103 Λειτουργική 

                                                                                                                                                        
4 DOD – Department of Defense   

Μορφοποιημένος πίνακας
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40% 

Ζωντανή 

αντικείμενα 

58x103 συνδυασμοί 

FBI 12K Μελάνι / 
Ζωντανή 

10 10 Επίπεδο: Ολισθαίνον 12x103 αντικείμενα Λειτουργική 

OHIO Μελάνι / 

Ζωντανή 

10 10 Ολισθαίνον: 

Ολισθαίνον Επίπεδο: 

Επίπεδο 

Επίπεδο: Ολισθαίνον 

925 αντικείμενα Πολύ Καλή 

IDENT 

IAFIS 

Ζωντανή 10&Τρέχον 10 Επίπεδο: Επίπεδο 

Επίπεδο: Ολισθαίνον 

3,8x103 αντικείμενα Λειτουργική 

Πίνακας 1-Πηγή Συνόλων Δεδομένων δακτυλικών αποτυπωμάτων από 

συστήματα διαφορετικής δικαιοδοσίας 

Πέρα από την ποσότητα των δεδομένων δακτυλικών αποτυπωμάτων, τα οποία 

ξεπερνούν τα 95 εκατομμύρια δακτυλικά αποτυπώματα, στη συγκεκριμένη 

περίπτωση, είναι πολύ σημαντικό να υπάρχει μία αντίληψη σχετικά με τους  

διαφορετικούς  τύπους και την  ποιότητα των εμπεριεχομένων πληροφοριών  σε κάθε 

διαφορετική βάση δεδομένων.  

Ο κυριότερος ενδεικτικός παράγοντας που αφορά στα δακτυλικά 

αποτυπώματα είναι ο τρόπος της συλλογής τους. Στην περίπτωση αυτή, διακρίνονται 

δύο κύριες κατηγορίες: 

Α. Το αποτύπωμα προέρχεται από σάρωση (scanning) χάρτινων καρτών από 

μελάνι ή απευθείας μέσω κατάλληλης ηλεκτρονικής  συσκευής σάρωσης.  

Β. Το αποτύπωμα προέρχεται μετά  από ολίσθηση του δακτύλου ή είναι ένα 

επίπεδο αποτύπωμα (βλ Σχήμα 2.1).  
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Σχήμα 2.1 (α) Επίπεδο Αποτύπωμα και (β) Ολισθαίνον Αποτύπωμα 

(α) (β) 

Σχήμα 2.1 (α) Επίπεδο Αποτύπωμα και (β) Ολισθαίνον Αποτύπωμα 

2.2.2.2 Μεθοδολογία αποτίμησης συστημάτων αναγνώρισης δακτυλικών 

αποτυπωμάτων 

 Για τα σύνολα δεδομένων των δακτυλικών αποτυπωμάτων που 

περιλαμβάνονται στις αναγνωρισμένες βάσεις δεδομένων του Πίνακα 1, έχει γίνει 

προσεκτική δειγματοληψία  και χρησιμοποιούνται σε πειραματικά συστήματα και 

αλγορίθμους για αναγνώριση και ταύτιση δακτυλικών αποτυπωμάτων. Για να 

αξιολογηθούν τα διάφορα βιομετρικά συστήματα που αναφέραμε πιο πάνω έχουν 

διενεργηθεί μία σειρά από πειράματα. Λόγω της ποικιλομορφίας των συστημάτων 

αυτών, για να καταστεί δυνατή η σύγκριση των αποτελεσμάτων τους θα πρέπει να 

υπάρξει ένα κοινό θεμελιώδες κριτήριο. Αυτό δεν είναι άλλο από τις Βαθμολογίες 

Ομοιότητας που προκύπτουν όταν δύο βιομετρικά πρότυπα δακτυλικών 

αποτυπωμάτων συγκρίνονται μεταξύ τους. Γενικά, όσο μεγαλύτερες είναι οι 

βαθμολογίες ομοιότητας, τόσο πιθανότερο είναι τα δύο αυτά πρότυπα να ανήκουν 

στο ίδιο άτομο.      

 

 

 

Ονοματολογία και ορισμοί  
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Ένας έλεγχος αναγνώρισης και ταύτισης δακτυλικών αποτυπωμάτων τυπικά 

απαρτίζεται από δύο γενικά σύνολα. Το ένα από αυτά καλείται σύνολο εγγραφής και 

απαρτίζεται περιέχει από όλα εκείνα τα αντικείμενα (δακτυλικά αποτυπώματα) που 

εντάσσονται στο συγκεκριμένο  σύστημα. Τα ιδιαίτερα γνωρίσματα εκείνων που 

ανήκουν στο σύνολο εγγραφής είναι γνωστά στη διάρκεια της αναζήτησης. Το 

δεύτερο σύνολο των δακτυλικών αποτυπωμάτων αποτελείται από τους χρήστες του 

συγκεκριμένου συστήματος και καλείται σύνολο γνησιότητας. Τα ιδιαίτερα 

γνωρίσματα του συνόλου γνησιότητας είναι άγνωστα κατά τη διάρκεια της 

αναζήτησης. Καθώς υπολογίζεται η σύγκριση μεταξύ των δακτυλικών 

αποτυπωμάτων μεταξύ των συνόλων εγγραφής και γνησιότητας, το αποτέλεσμα της 

σύγκρισης αυτής αποθηκεύεται σε έναν πίνακα ομοιότητας στον οποίο 

αποτυπώνονται  βαθμολογίες όπου το i-οστό στοιχείο του πίνακα αναφέρεται στην 

ομοιότητα μεταξύ του i-οστού δακτυλικού αποτυπώματος του συνόλου εγγραφής και 

του j-οστού στοιχείου του συνόλου γνησιότητας. Καθώς ο πίνακας ομοιότητας 

συμπληρώνεται με τις βαθμολογίες ομοιότητας, υπολογίζονται τα στατιστικά 

απόδοσης.  

 Οι βαθμολογίες στον πίνακα ομοιότητας χωρίζονται σε δύο κατηγορίες: Μία 

βαθμολογία που υπολογίζεται μεταξύ του δείγματος εγγραφής- γνησιότητας και 

ανήκει στο ίδιο άτομο ,αναφέρεται ως αυθεντική. Αντίθετα μία βαθμολογία μεταξύ 

ενός δείγματος εγγραφής-γνησιότητας που ανήκει σε διαφορετικά άτομα αναφέρεται 

ως μη αυθεντική. Από την ανάλυση και τη σύγκριση της κατανομής των δύο αυτών 

βαθμολογιών (αυθεντικής και μη) πηγάζουν πολλά ενδεικτικά συμπεράσματα σχετικά 

με την αποδοτικότητα ενός συστήματος αναγνώρισης και ταύτισης δακτυλικών 

αποτυπωμάτων. Στο Σχήμα 2.2 παρουσιάζεται μία τυπική  στατιστική κατανομή  

βαθμολογιών από την εφαρμογή του συστήματος SD-29  που αναφέρθηκε στον 

Πίνακα 1.  
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Σχήμα 2.2 Ιστόγραμμα αυθεντικών και μη βαθμολογιών από την εφαρμογή 

συστήματος αναγνώρισης και ταύτισης δακτυλικών αποτυπωμάτων (SD-19). 

 Στο Σχήμα 2.2, η κατανομή της βαθμολογίας αυθεντικών στοιχείων 

παρουσιάζεται ως μία καμπύλη σε   πράσινη απόχρωση η οποία  σχεδόν απλώνεται 

σε ολόκληρο το οριζόντιο εύρος του γραφήματος. Επίσης, στο ίδιο σχήμα, φαίνεται 

ότι η κατανομή των μη αυθεντικών βαθμολογιών (μία πιο φωτεινή καμπύλη)  

καταλαμβάνει σχεδόν όλο το αριστερό τμήμα του γραφήματος. Μία παρατήρηση 

σχετικά με τις μη αυθεντικές βαθμολογίες είναι ότι οι τελευταίες είναι σχετικά και 

συνεχώς χαμηλές, ενώ οι αυθεντικές διαφέρουν ως προς τη διασπορά τους. Το πιο 

ενδιαφέρων τμήμα του γραφήματος εστιάζεται στην περιοχή όπου σχεδόν ολόκληρο 

το τμήμα της κατανομής μη αυθεντικών βαθμολογιών υπερκαλύπτεται από ένα μέρος 

του αριστερού τμήματος της κατανομή των αντίστοιχων αυθεντικών (πράσινη 

απόχρωση). Σε αυτήν ακριβώς την περιοχή αλληλοεπικάλυψης το σύστημα παράγει 

σφάλματα. Στο συγκεκριμένο παράδειγμα υπάρχουν 24 περιπτώσεις όπου οι 

αυθεντικές βαθμολογίες είναι μικρότερες ή ίσες από την βαθμολογία 16 και 

υπερκαλύπτεται από τις μη αυθεντικές. 

 

 

 

  

Μορφοποιήθηκε: Γραμματοσειρά: Times New Roman, 12

στ., Έντονα, Ελληνικά
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Κατηγορίες και Βιομετρικές Εφαρμογές 

 

Οι βιομετρικές εφαρμογές χωρίζονται κυρίως σε δύο κατηγορίες: 

εξακρίβωσης (ή ταύτισης) και αναγνώρισης. Ο όρος εξακρίβωση (ή ταύτιση) 

χρησιμοποιείται για την περιγραφή της διαδικασίας επιβεβαίωσης του εάν ένα ενός 

άτομο ατόμου για το αν είναι αυτό που ισχυρίζεται βάσει του δακτυλικού του 

αποτυπώματος. Είναι δηλαδή μία σύγκριση ένα προς ένα. Ο όρος αναγνώριση 

χρησιμοποιείται για την περιγραφή της διαδικασίας ταιριάσματος του δακτυλικού 

αποτυπώματος ενός αγνώστου ατόμου με τα δακτυλικά αποτυπώματα της 

αντίστοιχης βάση δεδομένων δακτυλικών αποτυπωμάτων με σκοπό να διαπιστωθεί η 

ταυτότητα του ατόμου.  

 

 

 

i) Εξακρίβωση/Ταύτιση  (Έλεγχος ένα προς ένα) : 

 

Ο σκοπός του συστήματος εξακρίβωσης είναι να εκτελεί ταυτόχρονα δύο 

αποστολές. Η πρώτη είναι η ορθή εξακρίβωση της ταυτότητας ενός ατόμου όταν η 

απαίτηση είναι νόμιμη. Το δεύτερο είναι η απόρριψη ατόμων οι οποίοι δεν είναι 

αυτοί που ισχυρίζονται. Δυστυχώς η κάθε μία από αυτές τις αποστολές δεν μπορεί να 

μεγιστοποιήσει ταυτόχρονα την απόδοση και των δύο γιατί είναι αντικρουόμενες.  

 Το στατιστικό της απόδοσης για την εξακρίβωση της ταυτότητας είναι η 

πιθανότητα των σωστών εξακριβώσεων ή αλλιώς «Δείκτης Σωστά Αποδεκτών5 

(ΔΣΑ)». Είναι δηλαδή η πιθανότητα ενός συστήματος να εξακριβώσει την ταυτότητα 

ενός νόμιμου ισχυρισμού. Το στατιστικό απόδοσης για τους μη απορριφθέντα λάθος 

ισχυρισμούς αναφέρεται και ως «Δείκτης Λανθασμένα Αποδεκτών6 (ΔΛΑ)». Είναι 

δηλαδή η πιθανότητα ενός λανθασμένου ισχυρισμού να γίνει δεκτός ως σωστός, π.χ. 

κάποιος “ξεγελάει” το σύστημα και λαμβάνει πρόσβαση σε μία περιοχή που δεν έχει 

εξουσιοδότηση.  

                                                           
5 TAR  - True Accept Rate 

6 FAR - False Accept Rate  

Μορφοποιήθηκε: Γραμματοσειρά: Times New Roman, 12

στ., Όχι Έντονα

Μορφοποιήθηκε: Γραμματοσειρά: Times New Roman, 12

στ., Όχι Έντονα
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 Η ανάλυση του «Τελεστή Χαρακτηριστικών Αποδέκτη7 (ΤΧΑ)» 

χρησιμοποιείται για να μετρήσει τον συντελεστή αντιστάθμισης μεταξύ των δύο 

δεικτών (ΔΣΑ και ΔΛΑ). Σε αυτόν διαγράφεται καταγράφεται  ένα κατώφλι κατά 

μήκος των βαθμολογιών που είδαμε παρουσιάζονται στο Σχήμα 2.2. Σε κάθε βήμα, το 

ποσοστό των αυθεντικών βαθμολογιών κάτω από το κατώφλι καταγράφεται ως 

δείκτης ΔΣΑ ενώ πάνω από το κατώφλι καταγράφεται ο δείκτης ΔΛΑ. Η 

στοιχειοθέτηση των σημείων ΔΣΑ και ΔΛΑ δημιουργεί την καμπύλη ΤΧΑ όπως 

φαίνεται στο Σχήμα 2.3. 

 

 

Σχήμα 2.3 - Χαρακτηριστική καμπύλη Τελεστή Χαρακτηριστικών Αποδέκτη 

(ΤΧΑ). 

 

Το Σχήμα 2.3  αποτελεί ένα διάγραμμα  που παρουσιάζει τις βασικέής 

μετρήσειης της απόδοσης της εξακρίβωσης. Η κατανομή των βαθμολογιών στο 

Σχήμα 2.2 συνεισφέρει στην καμπύλη του Σχήματος 2.3. Σε αυτό το γράφημα 

συγκρίνεται η απόδοση μεταξύ των ακόλουθων τρόπων συλλογής δεδομένων 

δακτυλικών αποτυπωμάτων:  

1. Ολισθαινουσών αποτυπώσεων σε σύγκριση με ολισθαίνουσες 

αποτυπώσεις δακτύλων, 

                                                           
7 ROC -Receiver Operator Characteristic  

Με σχόλια [b5]: Για αυτό ρώτησα φιλόλογο :D 
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2. Επίπεδων αποτυπώσεων σε σύγκριση με επίπεδες αποτυπώσεις 

δακτύλων, 

3. Επίπεδων αποτυπώσεων σε σύγκριση με ολισθαίνουσες αποτυπώσεις 

δακτύλων. 

 

Συγκρίνοντας τα τρία διαγράμματα του Σχήματος 2.3, παρατηρείται 

μεγαλύτερη απόδοση των ολισθαινόντων αποτυπωμάτων σε σχέση με κάθε άλλον 

τρόπο συλλογής δακτυλικών αποτυπωμάτων. Επίσης, οι τρόποι συλλογής 2 και 3, δεν 

παρουσιάζουν ουσιαστική διαφορά ως προς την απόδοσή τους. Σημαντικός 

παράγοντας για την απόδοση της αναγνώρισης αποτελεί ο αριθμός των δειγμάτων 

δακτυλικών αποτυπωμάτων που συλλέγονται από το ίδιο άτομο. Όσο μεγαλύτερο 

είναι το δείγμα τόσο μεγαλύτερη η ευστάθεια του συστήματος.  

 

 

 

ii) Αναγνώριση  (Έλεγχος ένα με πολλά ) : 

 

Η απόδοση αναγνώρισης μετράται καθορίζοντας την ικανότητα ενός συστήματος 

αναγνώρισης δακτυλικών αποτυπωμάτων να αναγνωρίζει με ακρίβεια ένα άτομο 

μέσα από μία μεγάλη βάση δεδομένων, δοθέντος μιας και μόνο άγνωστης εγγραφής. 

Και πάλι χρησιμοποιούνται δύο σύνολα δεδομένων (ένα σύνολο γνησιότητας και ένα 

εγγραφής ) για να ελεγχθεί η απόδοση της αναγνώρισης. Τα δείγματα αναγνώρισης 

παριστούν τα άγνωστα πρότυπα για τα οποία επιδιώκεται η αναγνώριση. Από τη άλλη 

τα σύνολα εγγραφής παριστούν όλα τα εγγεγραμμένα αντικείμενα στο σύστημα. Σε 

αυτήν την διαδικασία ισχύει καθολικά πως τα σύνολα προς αναγνώριση είναι πολύ 

μικρότερα από τα σύνολαο εγγραφής. Για να υπολογιστεί η απόδοση αναγνώρισης, 

κάθε δείγμα προς αναγνώριση πρέπει να έχει ένα δεύτερο πρότυπο σαν ταίρι μέσα 

στο σύνολο εγγραφής. Το σύνολο εγγραφής περιέχει πρότυπα δακτυλικών 

αποτυπωμάτων (καλούνται και φόντα). 

   

 

 

Μορφοποιήθηκε: Γραμματοσειρά: Times New Roman, 12

στ., Όχι Έντονα
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Έλεγχος Δακτυλικών Αποτυπωμάτων Ιινστιτούτου NIST 

 

 Το Ιινστιτούτο NIST έχει διεξάγει ένα μεγάλο αριθμό ελέγχων ταυτοποίησης 

μιας ποικιλίας δακτυλικών αποτυπωμάτων με χρήση των δεδομένων και των μεθόδων 

που περιγράψαμε πιο πάνω. Έτσι καθιερώθηκε μία βασική γραμμή απόδοσης της 

τεχνολογίας   ταυτοποίησης των δακτυλικών αποτυπωμάτων  χρησιμοποιώντας τον 

ανιχνευτή μικρολεπτομέρειας (minutiae detector) και ταιριάσματος (matcher)  

ενσωματωμένο στοσε ένα υλισμικό (hardware) του υπολογιστικού συστήματος του 

Ιινστιτούτου NIST το οποίο καλείται “βωμός” Ελέγχου Εξακρίβωσης. Το σύστημα 

αυτό και οι παραλλαγές του έχουν αντικαταστήσει τα προηγούμενα συστήματα του 

FBI ,IAFIS , DHS US-VISIT και άλλα και έχουν διεξαχθεί εκτενείς έλεγχοι σε 

διάφορα σενάρια. 

 

 

 

2.2.2.3  Συμμετοχή στη δημιουργία προτύπων δακτυλικών αποτυπωμάτων  

 

 Η  δημιουργία προτύπων δακτυλικών αποτυπωμάτων είναι μία σημαντική 

δραστηριότητα στην οποία πρέπει να συμμετέχει ο οργανισμός που μελετά τα εν 

λόγω συστήματα. Υπάρχουν κυρίως δύο βασικές περιοχές ενδιαφέροντος: Η μία είναι 

η καθιέρωση των προτύπων όσων αφορά στην ανταλλαγή και στη 

διαλειτουργικότητα των δεδομένων ώστε να διασφαλίζεται η αξιοποίηση τους από 

διαφορετικά συστήματα. Η άλλη είναι η ανάπτυξη μεθόδων παραγωγής προτύπων για 

ελέγχους και αναφορές αποτελεσμάτων απόδοσης συστημάτων ή/και αλγορίθμων 

αναγνώρισης δακτυλικών αποτυπωμάτων. 

 

 

 

 

Με σχόλια [GM6]: Στο τέλος του Κεφαλαίου μαζί με όλες τις 
άλλες 
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2.3 Βιβλιογραφική ανασκόπηση τεχνικών αναγνώρισης δακτυλικών 

αποτυπωμάτων 

Προς την κατεύθυνση της αυτόματης αναγνώρισης δακτυλικών 

αποτυπωμάτων έχουν αναπτυχθεί και δημοσιευθεί διεθνώς μία πλειάδα τεχνικών 

επεξεργασίας δακτυλικών αποτυπωμάτων. Αυτές επικεντρώνονται σε δύο κυρίως 

επιμέρους τμήματα: το τμήμα της βελτίωσης-ενίσχυσης της αρχικής εικόνας του 

δακτυλικού αποτυπώματος και το τμήμα της ευθυγράμμισης δύο τουλάχιστον 

εικόνων δακτυλικών αποτυπωμάτων. Οι  σημαντικότερες τεχνικές παρουσιάζονται εν 

συντομία στη συνέχεια. 

 

2.3.1 Τεχνικές προς την κατεύθυνση της βελτίωσης της εικόνας 

Υπάρχουν σημαντικά προβλήματα που καθιστούν την αυτόματη αναγνώριση 

δακτυλικών αποτυπωμάτων μία διαδικασία δύσκολη και επίπονη. Τα βασικότερα 

είναι τα εξής :  

1. Η δημιουργία ενός σημαντικού αριθμού πλαστών μικρολεπτομερειών, 

2. Η παράληψη ενός μεγάλου ποσοστού αυθεντικών μικρολεπτομερειών,  

3. Η εμφάνιση  λαθών τόσο στην θέση όσο και στον προσανατολισμό των 

μικρολεπτομερειών. 

Στο Σχήμα 2.4 παρουσιάζονται ενδεικτικά παραδείγματα εικόνων δακτυλικών 

αποτυπωμάτων  πολύ κακής ποιότητας όπου οι κορυφογραμμές είναι ολοκληρωτικά 

κατεστραμμένες. 

Μορφοποιήθηκε: Γραμματοσειρά: Times New Roman, 12

στ., Όχι Πλάγια

Μορφοποιήθηκε: Γραμματοσειρά: (Προεπιλεγμένη) Times

New Roman, 12 στ.

Μορφοποιήθηκε: Επικεφαλίδα 3, Διάστιχο:  1,5 γραμμές

Μορφοποιήθηκε: Εσοχή: Αριστερά:  0 εκ., Διάστιχο:  1,5

γραμμές

Μορφοποιήθηκε: Εσοχή: Αριστερά:  0 εκ., Πρώτη γραμμή: 

0,63 εκ., Διάστιχο:  1,5 γραμμές
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Σχήμα 2.4 -  Χαρακτηριστικές εικόνες με κατεστραμμένες κορυφογραμμές 

 

 

Προς  την κατεύθυνση της επίλυσης των πιο πάνω προβλημάτων, 

πραγματοποιείται προ επεξεργασία της αρχικής εικόνας ώστε να καταστεί έτοιμη για 

το επόμενο στάδιο της διαδικασίας. Η προ επεξεργασία αυτή καλείται  βελτίωση του 

δακτυλικού αποτυπώματος και είναι σύνηθες όσο και απαραίτητο βήμα σε πολλές 

μεθόδους αυτόματης αναγνώρισης δακτυλικών αποτυπωμάτων. Σκοπός αυτής της 

προ επεξεργασίας της εικόνας είναι η βελτίωση της σαφήνειας των δομών 

κορυφογραμμών. Αυτές οι μέθοδοι συνήθως μιμούνται την ανθρώπινη διαδικασία 

κατά την αναγνώριση του αποτυπώματος και αποτελούνται από τα παρακάτω βασικά 

βήματα:  

 

1. Η εικόνα αναλύεται σε τοπικά γειτονικά τμήματα  για να εκτιμηθούν τα 

γνωρίσματα των κορυφογραμμών ( πλάτος, προσανατολισμός, καμπυλότητα, 

θόρυβος, ποιότητα, κ.λ.π.).  

2. Εφαρμόζονται κατάλληλαενός σετ φίλτρα βασιζόμεναο στις τοπικές 

πληροφορίες που προέκυψαν από το παραπάνω βήμα, με στόχο την βελτίωση 

της δομής των κορυφογραμμών με παράλληλη αφαίρεση του θορύβου.  

Οι προσεγγίσεις προς την βελτίωση της ποιότητας της εικόνας του δακτυλικού 

αποτυπώματος χωρίζονται σε δύο κύριες βασικές κατηγορίες. 

1. Τεχνικές βελτίωσης Αυτές που χρησιμοποιούν βασίζονται στα τοπικά 

χαρακτηριστικά της εικόνας., 

Μορφοποιήθηκε: Εσοχή: Αριστερά:  0 εκ., Διάστιχο:  1,5

γραμμές
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2. Τεχνικές βελτίωσης Αυτές που βασίζονται χρησιμοποιούν στα γενικά 

χαρακτηριστικά της εικόνας., 

 

 

3.  

1. Προσέγγιση Βελτίωση με βάση τα τοπικά χαρακτηριστικά της εικόνας 

δακτυλικού αποτυπώματος. 

Οι τεχνικές που χρησιμοποιούν τα τοπικά χαρακτηριστικά βασίζονται στην 

διαίρεση της εικόνας σε μη επικαλυπτόμενα τετραγωνικά παράθυρα μπλοκ και στη 

εξαγωγήεξάγουν τα κατάλληλων χαρακτηριστικώνά από κάθε ένα από αυτά. 

Ειδικότερα, σε αυτή την κατηγορία περιλαμβάνονται επιμέρους προσεγγίσεις. Αυτές 

είναι με βάση την Ττοπική Κατεύθυνσηδιεύθυνση, τα φίλτρα Gabor, την ένταση των 

εικονοστοιχείων, το δυναμικό φάσμα και έναν συνδυασμό των πάρα 

πάνωπροαναφερθέντων. 

• Βασιζόμενα στην Τοπική Διεύθυνση: Αυτή η ομάδα μεθόδων χρησιμοποιεί τις 

πληροφορίες της τοπικής κατεύθυνσης διεύθυνσης που παρέχεται από το πεδίο 

κατεύθυνσης της εικόνας του δακτύλου με σκοπό να υπολογιστούν διάφορα 

τοπικά χαρακτηριστικά σε κάθε μπλοκ παράθυρο της εικόνας. Μία μέθοδος 

παρουσιάστηκε από τον Lim [5] η οποία στηρίζεται στην παρουσίαση μιας 

εκτίμησης της δύναμης του πΠροσανατολισμού, που πηγάζει βασίζεται από 

στην κλίση σε μία grayscale εικόνα με διαφορετικές αποχρώσεις του γκρι 

(grayscale image). Επίσης στην ίδια μελέτη χρησιμοποιείται η συχνότητα 

κορυφογραμμών, το πάχος τους και το πάχος κορυφογραμμής-κοιλάδας. Μία 

άλλη μέθοδος παρουσιάστηκε από τον T.Chen [6] στην οποία υπολογίζεται η 

μέση απόλυτη διαφορά του τοπικού προσανατολισμού στα περιβάλλοντα 

μπλοκπαράθυρα. Ο ίδιος σε μία πιο πρόσφατη μελέτη του [7] βασίζεται σε μία 

χωρική αλληλουχία. Σε αυτήν εκτιμάται η τοπική συνοχή της έντασης της 

κλίσης η οποία επιδρά στην σαφήνεια της κατεύθυνσης διεύθυνσης των 

κορυφογραμμών-κοιλάδων σε κάθε μπλοκπαράθυρο. Τέλος, η μελέτη των H. 

Fronthaler, K. Kollreider, και J. Bigun [8] εστιάζεται στον συσχετισμό μεταξύ 

Μορφοποιήθηκε: Διάστιχο:  1,5 γραμμές,  Χωρίς κουκκίδες

ή αρίθμηση

Μορφοποιήθηκε: Γραμματοσειρά: Times New Roman, 12

στ., Υπογράμμιση

Μορφοποιήθηκε: Διάστιχο:  1,5 γραμμές, Κουκκίδα +

Επίπεδο: 1 + Στοίχιση:  0,5 εκ. + Εσοχή:  1,14 εκ.

Μορφοποιήθηκε: Γραμματοσειρά: Times New Roman, 12

στ., Ελληνικά
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γραμμικής και παραβολικής συμμετρίας στο δακτυλικό αποτύπωμα. 

Συγκεκριμένα, ο προσανατολισμός της εικόνας του δακτυλικού αποτυπώματος 

αποσυντίθεται σε δύο επιμέρους απεικονίσεις, επιτρέποντας να εξαχθούν 

συμπεράσματα για την ποιότητα της. Από τη μία μεριά, η συνεκτική ροή των 

κορυφογραμμών έχει γραμμική συμμετρία και μοντελοποιείται από 

συμμετρικά χαρακτηριστικά της τάξης 0. Από την άλλη πλευρά, σημεία με 

υψηλή καμπυλότητα, όπως μικρολεπτομέρειες, επιδεικνύουν παραβολική 

συμμετρία και μοντελοποιούνται με συμμετρικά χαρακτηριστικά της τάξης 1. 

• Βασιζόμενα σε φίλτρα Gabor:  Τα φίλτρα Gabor είναι τράπεζα φίλτρων που 

μπορούν να απεικονίσουν τοπικές συχνότητες. Μία ενδεικτική μελέτη 

παρουσιάστηκε από τον Shen [9] και χρησιμοποιεί τα χαρακτηριστικά των 

φίλτρων Gabor. Σε αυτήν, κάθε μπλοκ φιλτράρεται με χρήση φίλτρων Gabor, 

σε m διαφορετικές διευθύνσεις. Αν σε ένα μπλοκ παρουσιάζεται υψηλή 

ποιότητα, μία ή περισσότερες αποκρίσεις των φίλτρων παρουσιάζουν 

υψηλότερες τιμές σε σχέση με άλλες. Αντίστοιχες είναι και οι αποκρίσεις σε 

παράθυρα χαμηλής ποιότητας ή σε τμήματα  φόντου. 

• Βασιζόμενα στην ένταση των εικονοστοιχείων: Αυτή η προσέγγιση 

περιγράφεται και παρουσιάζεται από τον N. Ratha [10]. Σε αυτήν, κάθε 

παράθυρο ταξινομείτε σε «κατευθυντήριο» και «μη κατευθυντήριο» ως εξής: 

Υπολογίζεται το άθροισμα των διαφορών έντασης σε n διαφορετικές 

διευθύνσεις, μεταξύ ενός εικονοστοιχείου και J εικονοστοιχείων τα οποία 

επιλέγονται πάνω σε ένα γραμμικό τμήμα προς μία διεύθυνσης d. Για κάθε 

διαφορετική διεύθυνση d, υπολογίζεται η τιμή του ιστογράμματος των 

διαφορών, σε κάθε εικονοστοιχείο του παραθύρου. Αν μόνο ένα από τα n 

ιστογράμματα έχει μέγιστη τιμή μεγαλύτερη από ένα συγκεκριμένο κατώφλι, 

το παράθυρο χαρακτηρίζεται ως «κατευθυντήριο». Διαφορετικά ως «μη 

κατευθυντήριο». 

• Βασιζόμενα στο δυναμικό φάσμα: Ο Lim [11] στηρίχθηκε σε αυτήν την 

προσέγγιση, με βάση την οποία εξάγεται ένα ημιτονοειδές κύμα σήμα προς την 

κατεύθυνση της τοπικής διεύθυνσης κορυφογραμμών ενώ έπειτα στη συνέχεια 

Μορφοποιήθηκε: Γραμματοσειρά: (Προεπιλεγμένη) Times

New Roman, 12 στ., Υπογράμμιση

Μορφοποιήθηκε: Γραμματοσειρά: (Προεπιλεγμένη) Times

New Roman, 12 στ., Πλάγια

Με σχόλια [GM7]: Τι είναι αυτό? 

Μορφοποιήθηκε: Γραμματοσειρά: (Προεπιλεγμένη) Times

New Roman, 12 στ., Υπογράμμιση

Μορφοποιήθηκε: Διάστιχο:  1,5 γραμμές, Κουκκίδα +

Επίπεδο: 1 + Στοίχιση:  0,5 εκ. + Εσοχή:  1,14 εκ.
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υπολογίζεται ο Διακριτός Μετασχηματισμός Fourier. Μπλοκ Παράθυρα με 

χαμηλή ποιότητα δεν δίνουν μια προφανής επικρατούσα συχνότητα. 

• Βασιζόμενα σε συνδυασμό των παραπάνω προσεγγίσεων: Ο Hong[12] στην 

μελέτη του, μοντελοποίησε τις κορυφογραμμές και τις κοιλάδες σε ένα 

ημιτονοειδές κύμα σήμα προς την κατεύθυνση των τοπικών κορυφογραμμών, 

υπολογίζοντας παράλληλα το πλάτος, την συχνότητα και την διασπορά του 

ημιτονίουσήματος. Με βάση αυτά τα χαρακτηριστικά, ταξινόμησε κάθε μπλοκ 

παράθυρο σε «ανακτήσιμο» και «μη ανακτήσιμο». 

 

 

2.  Προσέγγιση με βάση τα γενικά χαρακτηριστικά της εικόνας. 

Οι μέθοδοι που βασίζονται στα γενικά χαρακτηριστικά του αποτυπώματος, 

αναλύουν την εικόνα με έναν ολοκρατικό τρόποσυνολικά και παρουσιάζουν τις 

γενικές εκτιμήσεις της ποιότητας βασιζόμενες στα χαρακτηριστικά που εξήχθησαν. 

Όπως και στις τοπικές προσεγγίσεις, και εδώ υπάρχουν επιμέρους 

κατηγορίεςπροσεγγίσεις. όπως Αυτή του πεδίου κατεύθυνσης και του δυναμικού 

φάσματος. 

• Βασιζόμενα στο πεδίο κατεύθυνσης: Η μέθοδος παρουσιάστηκε και πάλι από 

τον Lim [1]. Σε αυτή χρησιμοποιούνται δύο χαρακτηριστικά για να αναλυθεί η 

γενική δομή του δακτυλικού αποτυπώματος. Και τα δύο με τη σειρά τους 

χρησιμοποιούν πληροφορίες από τις τοπικές κατευθύνσεις που πηγάζουν από 

τα πεδία κατεύθυνσης σε κάθε μη επικαλυπτόμενο μπλοκ παράθυρο της 

εικόνας. Το πρώτο χαρακτηριστικό ελέγχει την συνέχεια του πεδίου 

κατεύθυνσης. Απότομες αλλαγές της αυτής μεταξύ γειτονικών 

μπλοκπαραθύρων,  συσσωρεύονται και αποτυπώνονται με μία γενική 

βαθμολογία. Το δεύτερο χαρακτηριστικό ελέγχει την ομοιομορφία του πεδίου 

συχνότητας. Αυτό πραγματοποιείται υπολογίζοντας την απόκλιση του λόγου 

πάχους κορυφογραμμής-με-κοιλάδα και εν συνεχεία πάλι τα αποτελέσματα 

αποτυπώνονται σε μία γενική βαθμολογία. 

Μορφοποιήθηκε: Γραμματοσειρά: (Προεπιλεγμένη) Times

New Roman, 12 στ., Υπογράμμιση

Μορφοποιήθηκε: Εσοχή: Πρώτη γραμμή:  0 εκ., Διάστιχο: 

1,5 γραμμές

Μορφοποιήθηκε: Γραμματοσειρά: Times New Roman, 12

στ., Υπογράμμιση

Μορφοποιήθηκε: Διάστιχο:  1,5 γραμμές, Κουκκίδα +

Επίπεδο: 1 + Στοίχιση:  0,5 εκ. + Εσοχή:  1,14 εκ.
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• Βασιζόμενα στην φασματική δύναμη: Στην μελέτη του Y. Chen [13] αναλύεται 

η γενική δομή του αποτυπώματος υπολογίζοντας τον δισδιάστατο Διακριτό 

Μετασχηματισμό Fourier. Σε ένα δακτυλικό αποτύπωμα, η συχνότητα των 

κορυφογραμμών κυμαίνεται σε συγκεκριμένο εύρος τιμών. Η περιοχή του 

φάσματος που μας ενδιαφέρει, ορίζεται ως μία δακτυλιοειδής περιοχή, με 

ακτινική αλληλουχία μεταξύ των ελάχιστων και μέγιστων τιμών. Καθώς η 

ποιότητα της εικόνας του δακτυλικού αποτυπώματος αυξάνεται, η ενέργεια θα 

είναι περισσότερο συγκεντρωμένη στην περιοχή ενδιαφέροντος. Ειδικότερα, 

εικόνες υψηλής ποιότητας θα έχουν ενέργεια συγκεντρωμένη σε μερικές ζώνες 

ενώ με χαμηλή ποιότητα η κατανομή των τιμών θα είναι περισσότερο διάχυτη. 

 

Σε αντίθεση με τις παραδοσιακές προσεγγίσεις του προβλήματος που είδαμε πιο 

πάνωπροαναφέρθηκαν, το 2000 προτάθηκε μία καινοτόμος μέθοδος προς την 

κατεύθυνση της βελτίωσης της εικόνας του αποτυπώματος από τους Andrés Almansa 

και Tony Lindeberg [14]. Σε αυτήν αρχικά αναπτύσσεται μία τεχνική προς την 

πραγματοποίηση μιας «Ομαλοποιημένης Μορφής»8. Αυτό πραγματοποιείται με μία 

προσαρμογή της μορφής των τελεστών βαθμονόμησης- χώρου σε μία γραμμική 

βαθμονόμηση-χώρου. Στην περίπτωση όπου οι εικόνες είναι μη ισοτροπικές (όπως 

και στη περίπτωση των δακτυλικών αποτυπωμάτων) χρησιμοποιείται μία 

προσαρμογή σε «Ομοπαραλληλική Γκαουσιανή»9 βαθμονόμηση χώρου.  

Τέλος μία αξιόλογη μελέτη και πάλι έξω από τα παραδοσιακά πλαίσια, 

εκπονήθηκε από τους Lin Hong, Yifei Wan, και Anil Jain [15]. Το σΣχήμα 2.5 

απεικονίζει το διάγραμμα του αλγορίθμου τους . 

Σχήμα 6 - Μπλοκ διάγραμμα του αλγορίθμου των Lin Hong, Yifei Wan, και Anil 

Jain 

 

                                                           
8 Ο ακριβής αγγλικός όρος είναι shape adapted smoothing 

9 Ο ακριβής αγγλικός όρος είναι Affine Gaussian scale space. 

Μορφοποιήθηκε: Γραμματοσειρά: Times New Roman, 12

στ., Όχι Πλάγια, Υπογράμμιση

Μορφοποιήθηκε: Γραμματοσειρά: Times New Roman, 12

στ., Υπογράμμιση

Μορφοποιήθηκε: Εσοχή: Αριστερά:  0 εκ., Πρώτη γραμμή: 

1,27 εκ., Διάστιχο:  1,5 γραμμές
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Σχήμα 2.5 - Μπλοκ διάγραμμα του αλγορίθμου βελτίωσης της εικόνας 

δακτυλικών αποτυπωμάτων  

 

Σύμφωνα με τον αλγόριθμο του Σχήματος 2.5, αρχικά η εικόνα εισόδου 

κανονικοποιείται ώστε να έχει χαρακτηριστικό μέσο όρο έντασης και διασποράς 

εικονοστοιχείων. Έπειτα εκτιμάται η προσανατολισμένη εικόνα από την 

κανονικοποιημένη και εν συνεχεία υπολογίζεται η εικόνα με βάση τη συχνότητα. 

Τέλος τμηματοποιείται σε μη επικαλυπτόμενα παράθυρα και σε κάθε ένα από αυτά 

εφαρμόζονται  φίλτρα Gabor.  

 

 

2.3.2 Τεχνικές προς την κατεύθυνση της ευθυγράμμισης εικόνας 

Το πρόβλημα της ευθυγράμμισης της εικόνας του δακτυλικού αποτυπώματος 

παραμένει ένα από τα πιο δισεπίλυτα  προβλήματα προς την κατεύθυνση της 

αυτόματης αναγνώρισης τους. Στην πλειοψηφία των τεχνικών που έχουν προταθεί 

στη βιβλιογραφία, κυριαρχούν τρεις διαφορετικές προσεγγίσεις. Η ευθυγράμμιση με 

χρήση του «πΠεδίου Ππροσανατολισμού» του αποτυπώματος, με χρήση των 

μικρολεπτομερειών του αποτυπώματος και τέλος ενός συνδυασμού των δύο 

παραπάνω προσεγγίσεων. 

Μορφοποιήθηκε: Εσοχή: Αριστερά:  0 εκ., Διάστιχο:  1,5

γραμμές

Μορφοποιήθηκε: Εσοχή: Αριστερά:  0 εκ., Διάστιχο:  1,5

γραμμές
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2.3.2.1 Αναγνώριση του δακτυλικού αποτυπώματος με χρήση του πεδίου 

προσανατολισμού του 

Με τον όρο «Πεδίο Προσανατολισμού» εννοούμε την απεικόνιση ροής της 

δομής των κορυφογραμμών και των κοιλάδων, ή με άλλα λόγια την 

κατευθυντικότητα τους. Γενικά η εύρεση του «Πεδίου Προσανατολισμού» μπορεί να 

προσεγγιστεί ποικιλοτρόπως όπως με βάση τις κλίσεις, τις τράπεζες φίλτρων, τις 

δυνάμεις υψηλών συχνοτήτων σε τρισδιάστατες (3-D) εικόνες, τις φασματικές 

εκτιμήσεις για δισδιάστατες (2-D) εικόνες καθώς και άλλες. Μεταξύ των πιο πάνω 

προσεγγίσεων οι κλίσεις και οι τράπεζες φίλτρων χρησιμοποιούνται συχνότερα 

γι’αυτό και θα επικεντρωθούμε σε αυτές. 

Οι κλίσεις είναι προσανατολισμοί στην κλίμακα των εικονοστοιχείων. 

Αρχικά, με χρήση καρτεσιανών συντεταγμένων υπολογίζεται το διάνυσμα των 

κλίσεων, το οποίο δίνει τους θεμελιώδεις προσανατολισμούς μιας εικόνας. Με χρήση 

τριγωνομετρικών εξισώσεων προκύπτει η έκφραση των διανυσμάτων τετραγωνικής 

κλίσης και έπειτα υπολογίζονται οι μέσες τετραγωνικές κλίσεις σε κάποια γειτονιά 

εικονοστοιχείων. Οι τελευταίες χρησιμοποιούνται για τον υπολογισμό της μέσης 

κλίσης κατεύθυνσης από την οποία προέρχονται και τα στοιχεία του «Πεδίου 

Προσανατολισμού». Κύριο χαρακτηριστικό του, σε αντίθεση με το διάνυσμα των 

κλίσεων, είναι πως τα γειτονικά του στοιχεία διατηρούν μία παραλληλία. Την πιο 

πάνω προσέγγιση χρησιμοποιούν οι Lifeng Liu, Tianzi Jiang, Jianwei Yang, and 

Chaozhe Zhu [16] στον αλγόριθμο τους. Στο σχήμα 2.6 φαίνονται ξεκάθαρα τα όσα 

προαναφέρθηκαν. 
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Σχήμα 7 - (α) Πεδίο κλίσεων , (b) Πεδίο προσανατολισμού 

 

Σχήμα 2.6 - (α) Πεδίο κλίσεων , (b) Πεδίο προσανατολισμού 

 

 

 

 

 

 

 

Οι Τράπεζες Φίλτρων10 (ΤΦ) πρωτοπαρουσιάστηκαν από τους Bamberger και 

Smith [17] ενώ μετέπειτα τελειοποιήθηκαν από τον Park [18]. Κατά Σύμφωνα με την 

μέθοδο αυτή, διαιρείται η δισδιάστατη εικόνα σε οκτώ ζώνες (βλ σχήμα 2.7). Οι ΤΦ 

αποτελούνται από ένα βαθυπερατό φίλτρο (Η0) ,έναν δειγματολήπτη (Q), μία μήτρα 

ρομβοειδούς μετατροπής (R), έναν διαμορφωτή (e-jω1π) και μία μήτρα postsampling 

(Β), όπως φαίνεται στο Σσχήμα 2.8. Στο πρώτο επίπεδο η αρχική εικόνα 

διαμορφώνεται, φιλτράρεται και δειγματοληπτείται με αποτέλεσμα να χωριστεί σε 

δύο επιμέρους εικόνες, όπως φαίνεται στο Σσχήμα 2.9(a). Στο δεύτερο επίπεδο, η 

κάθε μία από τις εικόνες διαιρείται περαιτέρω σε τέσσερεις εικόνες με χρήση μιας 

διαδικασίας παρόμοιας με το πρώτο επίπεδο (βλ Σσχήμα 2.9(b)). Στο τρίτο και 

τελευταίο επίπεδο απαιτούνται μήτρες ρομβοειδούς μετατροπής για να 

μετασχηματιστούν τα παραλληλόμορφα τμήματα σε ρομβοειδή. Οι μήτρες 

Postsampling εισάγονται στις ΤΦ ώστε να αφαιρεθεί το φαινόμενο 

                                                           
10 Εφεξής θα ο όρος θα αναφέρεται ως ΤΦ. 
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ασταθούς(scrambling) συχνότητας την οποία προκάλεσε ο διαμορφωτής. Μετά το 

τρίτο επίπεδο παράγεται μία οκταζωνική έξοδος όπως φαίνεται και στο Σσχήμα 

2.9(c).   

 

 

 

 

 

 

Σχήμα 8 – Χάρτης ζωνών (a) Αρχικής εικόνας (b) Εξόδου οκτώ ζωνών  

 

Σχήμα 2.7– Χάρτης ζωνών (a) Αρχικής εικόνας (b) Εξόδου οκτώ ζωνών  

 

 

 

 

 

 

 

Με σχόλια [GM8]: Ποια η διαφορά ανάμεσα στα δύο)? 
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Σχήμα 9 – Δομή οκταζωνικής ΤΦ χωρισμένη σε τρία επίπεδα 

 

Σχήμα 2.8– Δομή οκταζωνικής ΤΦ χωρισμένη σε τρία επίπεδα 

 

 

 

 



44 

 

 

 

Σχήμα 2.9 - (a) Πρώτο στάδιο (b) Δεύτερο στάδιο (c) Τρίτο στάδιο της 

οκταζωνικής ΤΦ 
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Συγκριτικά η μέθοδος με βάση την τράπεζα φίλτρων είναι  πιο ανεκτική στην 

παρουσίαε θορύβουθόρυβο αλλά λιγότερο ακριβής λόγω του περιορισμένου αριθμού 

των φίλτρων του διατίθενται. Επιπλέον, είναι υπολογιστικά δαπανηρή γιατί θα πρέπει 

η κάθε έξοδος του φίλτρου να συγκριθεί εκ νέου. Αντίθετα, οι μέθοδοι που 

βασίζονται στις κλίσεις μπορούν να δώσουν συνεχείς τιμές, αλλά δεν είναι ανεκτικές 

στην ύπαρξη θορύβου.  

 

 

2.3.2.2 Η αναγνώριση των αποτυπωμάτων με εντοπισμό των μικρολεπτομερειών  

του. 

Σε ένα δακτυλικό αποτύπωμα, όπως αναφέρθηκε, μπορούν να παρατηρηθούν 

τοπικές αυλακώδεις ασυνέχειες γνωστές και ως μικρολεπτομέρειες. Υπάρχουν δύο 

χαρακτηριστικοί τύποι μικρολεπτομερειών, οι διακλαδώσεις και τα τελειώματα (βλ 

σχήμα 2.10). 

 

Σχήμα 2.10 - Τελειώματα  και διακλαδώσεις 

 

 

 

Ένας ενδιαφέρον αλγόριθμος προς την κατεύθυνση της αναγνώρισης με 

εντοπισμό των μικρολεπτομερειών προτάθηκε από την Virginia Espinosa-Duro [19]. 

Η μέθοδος συνίσταται στον εντοπισμό των τελευταίων, πάνω στο δακτυλικό 
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αποτύπωμα. Ικανή συνθήκη για την εφαρμογή των τεχνικών αυτών είναι η εξαγωγή 

περίπου 40 -100 μικρολεπτομερειών.  

Για να εξαχθούν τα χαρακτηριστικά των μικρολεπτομερειών απαιτείται ο 

εντοπισμός των κορυφογραμμών τερματισμού και κορυφογραμμών διακλάδωσης (βλ 

Σσχήμα 2.11) 

Σχήμα 12 

 

Σχήμα 2.11 - Θέση (x,y) και γωνία (θ) των μικρολεπτομερειών 

 

 

 

Τα δύο αυτά είδη μικρολεπτομέρειας περιγράφονται από τη θέση τους (x , y 

συντεταγμένες) και από τον προσανατολισμό τους (γωνία θ). Ο εντοπισμός κάθε 

μικρολεπτομέρειας σε αυτόν τον αλγόριθμο χρησιμοποιεί ένα απλό πρότυπο 

αναγνώρισης. Χωρίς απώλεια της γενικότητας, τεκμαίρεται ότι αν ένα εικονοστοιχείο 

βρίσκεται σε μία ισχνή-λεπτή κορυφογραμμή (με οκτώ γειτονικά εικονοστοιχεία) 

τότε λαμβάνει την τιμή 1, διαφορετικά την τιμή 0. Αν υποτεθεί ότι ένα εικονοστοιχείο 

πάνω σε μία ισχνή κορυφογραμμή δηλώνεται ως (x,y) και Ν0 έως Ν7 δηλώνονται τα 

γειτονικά του εικονοστοιχεία, τότε ισχύουν ει πως τα εξής:            

Τελείωμα: 
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Διακλάδωση: 

 

 

    

 Η τελική δομή των κορυφογραμμών θα χρησιμοποιηθεί για την εξαγωγή του 

Χάρτη μικρολεπτομερειών ο οποίος χαρακτηρίζει και το δακτυλικό αποτύπωμα. Αυτός 

ο χάρτης θα σχηματίσει ένα πρότυπο που θα περιλαμβάνει μία λίστα με 

μικρολεπτομέρειες και μία λίστα με τον αριθμό των κορυφογραμμών μεταξύ των 

ζευγαριών μικρολεπτομέρειας. Στην συνέχεια, αυτό το πρότυπο θα αποθηκευτεί στο 

σύστημα. Τα πειραματικά αποτελέσματα αυτής της μεθόδου έδειξαν ότι το σύστημα 

αυτό αναγνώρισε τις περισσότερες μικρολεπτομέρειες που υπάρχουν στην αρχική 

εικόνα αλλά ο αριθμός αυτός εξαρτάται σε μεγάλο βαθμό από το σύστημα λήψης της 

εικόνας.  

 

2.3.2.3 Η αναγνώριση αποτυπωμάτων με συνδυασμένη χρήση πεδίου 

προσανατολισμού και μικρολεπτομερειών 

Ένας αλγόριθμος προς αυτήν την προσέγγιση προτάθηκε από τους Asker M. 

Bazen και Sabih H. Gerez [20]. Σε αυτή τη μέθοδο γίνεται προσπάθεια εφαρμογής 

της αναγνώρισης δακτυλικών αποτυπωμάτων σε μεγαλύτερες βάσεις δεδομένων με 

έναν συνδυασμό της χρήσης του πεδίου προσανατολισμού και των 

μικρολεπτομερειών. Το πρώτο βήμα για την αναγνώριση των δακτυλικών 

αποτυπωμάτων με βάση την τεχνική αυτή  είναι συχνά η συνεχής ταξινόμηση των 

δακτυλικών αποτυπωμάτων [21] ,[22]. Με την συνεχή ταξινόμηση μειώνεται το 

διαμέρισμα της βάσης δεδομένων στην οποία θα γίνει η αναζήτηση για ταίρι. Για να 

είναι εφικτό το τελευταίο θα πρέπει να χρησιμοποιηθεί μία ταξινόμηση υψηλής 

απόδοσης και σε αυτό θα βοηθήσει ο ακριβής προσδιορισμός του «Πεδίου 

Προσανατολισμού» και των μικρολεπτομερειών.  

Με σχόλια [GM9]: Τι εννοείς? 



48 

 

Όπως έχουμε ήδη αναφέρει, το δακτυλικό αποτύπωμα χαρακτηρίζεται από 

κορυφογραμμές και κοιλάδες. Οι κορυφογραμμές συνήθως εμφανίζονται με μαύρο 

χρώμα και οι κοιλάδες με άσπρο μέσα σε μία grayscale εικόνα αποχρώσεων του γκρι. 

Το πεδίο αυτό προκύπτει άμεσα από ένα πρόσθετο πεδίο, αυτό των κλίσεων. 

Συγκεκριμένα, οι τελευταίες είναι προσανατολισμοί στην κλίμακα των 

εικονοστοιχείων της εικόνας, οι οποίες τέμνονται κάθετα από τα στοιχεία του πεδίου 

προσανατολισμού. Από τα πιο πάνω φαίνεται καθαρά ότι είναι εφικτό  να 

προσδιοριστεί το πεδίο προσανατολισμού εφαρμόζοντας έναν τελεστή μέσου όρου 

στις κλίσεις, περιλαμβάνοντας εικονοστοιχεία σε ένα γειτονικό τμήμα της εικόνας.  

Επιπλέον, οι μικρολεπτομέρειες παρέχουν πληροφορίες της δομής των 

κορυφογραμμών-κοιλάδων όπως τελειώματα-κορυφογραμμών και διακλαδώσεις. Η 

πιοΣτο Σχήμα 2.12 παρουσιάζονται χαρακτηριστικά αποτελέσματα από την 

εφαρμογή των προσεγγίσεων προσανατολισμού και μικρολεπτομερειών κάτω εικόνα 

είναι χαρακτηριστική με βάση τα όσατων όσων προαναφέρθηκαν.  

 

 

 

 

 

 

 

Σχήμα 2.12 - (a) Αρχικό αποτύπωμα (b) Πεδίο προσανατολισμού (c) 

Μικρολεπτομέρειες 

Το βασικό πρόβλημα που πραγματεύεται αυτός ο αλγόριθμος είναι το πώς 

μπορούν να εξαχθούν οι μικρολεπτομέρειες από το Ππεδίο πΠροσανατολισμού. Οι 

μικρολεπτομέρειες είναι σημεία πάνω στο δακτυλικό αποτύπωμα όπου το πεδίο 

προσανατολισμού παρουσιάζει ασυνέχειες. Στα Σσχήματα 2.13 και 2.14 φαίνονται 
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παρουσιάζονται εικόνες από μικρολεπτομέρειες και ταο αντίστοιχαο πεδίαο 

προσανατολισμού τις κάθε μίαςμίας εικόνας. 

Σχήμα 14 - Μικρολεπτομέρειες πάνω στο δακτυλικό αποτύπωμα 

 

Σχήμα 2.13 - Μικρολεπτομέρειες πάνω στο δακτυλικό αποτύπωμα 

 

 

 

Σχήμα 15 - Αντίστοιχο πεδίο προσανατολισμού των μικρολεπτομερειών του 

σχήματος 14 

 

Σχήμα 2.14 - Αντίστοιχο πεδίο προσανατολισμού των μικρολεπτομερειών του 

Σχήματος 2.13 
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Από το πεδίο προσανατολισμού μπορούν να εντοπιστούν εύκολα οι 

μικρολεπτομέρειες χρησιμοποιώντας ακρίβεια ενός και μόνο εικονοστοιχείου. 

Ακολουθώντας ένα αριστερόστροφο περίγραμμα γύρω από την μικρολεπτομέρεια 

στο πεδίο προσανατολισμού και προσθέτοντας την διαφορά μεταξύ των γωνιών που 

ακολουθούν προκύπτει μία αθροιστική μεταβολή στον προσανατολισμό κατά π (ή –

π). Εντούτοις, αν εφαρμοστεί σε περιοχή που δεν περιλαμβάνεται μικρολεπτομέρεια, 

η αθροιστική μεταβολή του προσανατολισμού θα είναι κοντά στο μηδέν. Τα 

αποτελέσματα του αλγορίθμου είναι  εντυπωσιακά αφού σε ορισμένες περιπτώσεις ο 

μέσος όρος των λαθεμένων μικρολεπτομερειών κυμαίνεται από 0,5 έως 15,4.  

Τέλος, έχει εκπονηθεί μία σημαντική μελέτη από τους Jie Zhou και τον Jinwei Gu  

[23]. Σύμφωνα με αυτήν, για την παρουσίαση του πεδίου προσανατολισμού 

συνίσταται ένα συνδυαστικό μοντέλο. Αυτό επιτυγχάνεται με την εξέταση της 

ομαλότητας του πεδίου εκτός από μερικά ιδιότυπα σημεία (singular points). Για την 

εξέταση αυτή,  χρησιμοποιείται ένα πολυωνυμικό μοντέλο ώστε ναπου περιγράαφειί  

το πεδίο προσανατολισμού και ένα σημειακό μοντέλο για την βελτίωση της ακρίβειας 

κάθε τοπικού ιδιότυπο σημείου (μικρολεπτομέρειας) . 

 

 

 

 

 

 

 

 

 

 

Με σχόλια [GM10]: Μήπως υπάρχουν τίποτε ποσοστά 
επιτυχίας? 95%? 

Με σχόλια [b11]: Έχω και κάποια πλεονεκτήματα και 
μειονεκτήματα των τριών προσεγγίσεων να τα βάλω?  
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Κεφάλαιο 3 - Μεθοδολογία αναγνώρισης δακτυλικών αποτυπωμάτων 

 

3.1 Εισαγωγή  

Στο Κεφάλαιο αυτό πραγματοποιείται  εκτενής ανάλυση και παρουσίαση του 

λογισμικού που αναπτύχθηκε με σκοπό την αυτόματη αναγνώριση και ταυτοποίηση 

δακτυλικών αποτυπωμάτων με χρήση μεθόδων ψηφιακής επεξεργασίας εικόνας. Οι 

τεχνικές που αναπτύχθηκαν και εφαρμόστηκαν στα πλαίσια της διπλωματικής 

βασίστηκαν κυρίως στον  αλγόριθμο που προτάθηκε  από τους Lifeng Liu, Tianzi 

Jiang, Jianwei Yang, και Chaozhe Zhu το 2006 [1] ενώ πραγματοποιήθηκαν 

κατάλληλες τροποποιήσεις. Επιπλέον, για την παρουσίαση των αποτελεσμάτων και 

την πραγματοποίηση μετρήσεων των δακτυλικών αποτυπωμάτων σχεδιάστηκε και 

αναπτύχθηκε κατάλληλη διεπαφή με χρήση της Borland C++ Builder με την οποία 

επικοινωνεί το λογισμικό αυτόματης αναγνώρισης και ταύτισης δακτυλικών 

αποτυπωμάτων. Τέλος,  ο πηγαίος κώδικας του λογισμικού παρατίθεται στο 

Παράρτημα Α της παρούσας διπλωματικής εργασίας. 

 

3.2 Μεθοδολογία 

3.2.1 Συμβολισμοί 

Μία εικόνα, I, δακτυλικού αποτυπώματος διαφορετικών αποχρώσεων του 

γκρι, ορίζεται ως ένας M x N πίνακας, όπου Ι(i,j) αντιστοιχεί στην ένταση του 

εικονοστοιχείου στην i-οστή σειρά και j-οστή στήλη. Αναλυτικότερα, αν μία εικόνα 
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χρησιμοποιεί για την αναπαράσταση των εντάσεων των εικονοστοιχείων 8-bit 

δεδομένων, τότε μπορούν να αναπαρασταθούν 28 διαφορετικοί συνδυασμοί 

αποχρώσεων του γκρι. Η τιμή μηδέν θα παριστά το μαύρο χρώμα, η τιμή 255 το 

άσπρο χρώμα και όλες οι υπόλοιπες ενδιάμεσες τιμές αποχρώσεις του γκρι (βλ Σχήμα 

3.1). Στο Σχήμα 3.2 απεικονίζεται μία τυπική εικόνα στις αποχρώσεις του γκρι κάτω 

από την οποία βρίσκεται ο πίνακας των εντάσεων που αντιστοιχεί σε αυτήν την 

εικόνα. Στην  παρούσα  διπλωματική έχει γίνει η παραδοχή ότι όλες οι εικόνες έχουν 

σαρωθεί με ανάλυση 504 x 480 εικονοστοιχεία (pixels), η οποία είναι και η 

επικρατούσα ανάλυση σε πολλά σύγχρονα συστήματα αυτόματης αναγνώρισης 

δακτυλικών αποτυπωμάτων(π.χ. του FBI).  

 

 

 

Σχήμα 3.1 Φάσμα του γκρι σε 8-bit εικόνα Με σχόλια [GM12]: Να βάλεις παντού Σχήμα 1, 2, 3, …..Μάλιστα 
θα πρότεινα να βάλεις δύο νούμερα σε κάθε σχήμα, ένα για το 
κεφάλαιο και ένα για το τρέχων σχήμα, π.χ. 3.1, 3.2, κλπ 
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Σχήμα 3.2 (a) Τυπική 8-bit εικόνα στις αποχρώσεις του γκρι (b) Πίνακας  

εντάσεων των εικονοστοιχείων για τη συγκεκριμένη εικόνα. 

3.2.2 Μπλοκ διάγραμμα του αλγορίθμου 

Στο Σχήμα 3.3  δίνεται το βασικό διάγραμμα του αλγορίθμου που 

χρησιμοποιήθηκε κατά την ανάπτυξη του λογισμικού αναγνώρισης και ταύτισης 

δακτυλικών αποτυπωμάτων. 
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Εικόνα 

Αναφοράς

Τρέχουσα 

Εικόνα

Βελτίωση-

Ενίσχυση

Βελτίωση-

Ενίσχυση

Ευθυγράμμιση

Απόφαση-Έξοδος  

Σχήμα 3.3 Block διάγραμμα του αλγορίθμου αυτόματης αναγνώρισης και 

ταύτισης δακτυλικών αποτυπωμάτων. 

 

3.2.3 Αναλυτική παρουσίαση βημάτων  

 Σύμφωνα με το διάγραμμα του Σχήματος 3.3,  ο αλγόριθμος απαρτίζεται από 

δύο βασικά βήματα. Το πρώτο βήμα αποτελεί τη βελτίωση της ποιότητας των υπό 

σύγκριση εικόνων των δακτυλικών αποτυπωμάτων οι οποίες εισάγονται στο 

σύστημα.  Το δεύτερο βήμα  είναι η αυτόματη ευθυγράμμιση των  βελτιωμένων 

εικόνων. 

3.2.3.1 Βελτίωση της εικόνας ενός δακτυλικού αποτυπώματος 

 Προς την κατεύθυνση της ακριβέστερης εκτίμησης του Πεδίου 

Προσανατολισμού της εικόνας του δακτυλικού αποτυπώματος, ως το βασικό 

χαρακτηριστικό σύγκρισης των δακτυλικών αποτυπωμάτων, χρησιμοποιήθηκε ένας 

αλγόριθμος με σκοπό τη βελτίωση της αντίθεση11 της [2]. Η τεχνική αυτή ονομάζεται 

κανονικοποίηση και αναλύεται στη συνέχεια. 

 Έστω ότι το I(i,j) υποδηλώνει την τιμή της έντασης της εικόνας του 

δακτυλικού αποτυπώματος για διαφορετικές αποχρώσεις του γκρι. Επαναλαμβάνεται 

                                                           
11 Ο ακριβής αγγλικός όρος είναι contrast. 
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πως η τιμή 0 υποδηλώνει το μαύρο χρώμα ενώ η τιμή 255 το άσπρο. Οι υπόλοιπες 

ενδιάμεσες τιμές υποδηλώνουν τις διαφορετικές αποχρώσεις του γκρι. Επιπρόσθετα 

με M και VAR υποδηλώνονται οι αποτιμήσεις του μέσου όρου και της διασποράς 

αντίστοιχα και τέλος ως G(i,j) ορίζεται η κανονικοποιημένη τιμή της απόχρωσης του 

γκρι στο εικονοστοιχείο (i,j). Η κανονικοποιημένη εικόνα προκύπτει από την 

παρακάτω εξίσωση: 

 

 

 

 Οι όροι του μέσου και της διασποράς που χρησιμοποιήθηκαν πιο πάνω 

ορίζονται με βάση τις ακόλουθες εξισώσεις: 

 

 

 

και  

 

 

αντίστοιχα. 

 Στην Εξίσωση 1, ο όρος M0 και VAR0 είναι η επιθυμητή τιμή μέσου όρου και 

διασποράς αντίστοιχα, βάση της οποίας επιδιώκεται να γίνει η κανονικοποίηση (μία 

ενδεικτική τιμή είναι το 100). Θα πρέπει να γίνει σαφές πως η κανονικοποίηση ως 

τρόπος βελτίωσης της εικόνας είναι μία διαδικασία που την επηρεάζει σε επίπεδο 

εικονοστοιχείων. Σε καμία περίπτωση δεν μεταβάλλει τη σαφήνεια της δομής των 

κορυφογραμμών και των κοιλάδων. Συνεπώς, ο βασικός  σκοπός της βελτίωσης είναι 

Με σχόλια [GM13]: ΤΟ Μ(Ι) να γίνει Μ. 

Με σχόλια [GM14]: Να γίνει VAR και Μ 

Με σχόλια [GM15]: Για το Μ? 



59 

 

να μειώσει τις αποκλίσεις στις τιμές των εικονοστοιχείων κατά μήκος μιας 

κορυφογραμμής ή κοιλάδας. Στο Σχήμα 3.4 παρουσιάζεται ένα τυπικό αποτέλεσμα 

μετά την εφαρμογή του αλγορίθμου της βελτίωσης.  

 

 

Σχήμα 3.4 (α) Αρχική εικόνα δακτυλικού αποτυπώματος. (β) Βελτιωμένη εικόνα 

 

3.2.3.2 Αυτόματη Ευθυγράμμιση των εικόνων 

 Η ευθυγράμμιση των εικόνων είναι ίσως η σημαντικότερη και πιο αναγκαία 

διαδικασία προς την κατεύθυνση της αυτόματης αναγνώρισης των δακτυλικών 

αποτυπωμάτων. Όπως αναφέρθηκε στο Κεφάλαιο 2, υπάρχουν δεκάδες συστήματα 

λήψεις δακτυλικών αποτυπωμάτων. Κάθε ένα από αυτά χρησιμοποιεί τα δικά του 

χαρακτηριστικά ως προς την ανάλυση των εικόνων και το σύστημα συντεταγμένων. 

Είναι λοιπόν επιτακτική η ανάγκη εφαρμογής ενός κοινού συστήματος αναφοράς σε 

εικόνες που προέρχονται από διαφορετικά συστήματα λήψης. Προκειμένου  να 

πραγματοποιηθεί η σύγκριση δύο ή περισσοτέρων δακτυλικών αποτυπωμάτων, είναι 

αναγκαία η ευθυγράμμισή τους με βάση ένα κοινό σύστημα συντεταγμένων. Στο 

Σχήμα 3.5 (a) και (b) παρουσιάζονται  δύο διαφορετικές λήψεις του ίδιου δακτυλικού 

αποτυπώματος ενός ατόμου. Στις δύο αυτές λήψεις πραγματοποιείται τεχνικά 

υπέρθεση  προκειμένου να γίνει η σύγκρισή τους οπτικά (Σχήμα 3.5 (c)). Είναι 
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προφανές πως η  αναγνώριση των δύο αυτών αποτυπωμάτων, άρα και η σύγκρισή 

τους, προϋποθέτει απαραίτητα την ευθυγράμμισή τους.  

 

Σχήμα 3.5 (a) Πρώτη λήψη δακτυλικού αποτυπώματος (b) Δεύτερη λήψη του 

ίδιου αποτυπώματος (c) Οι δύο λήψεις μαζί 

  

Στο επόμενο σχήμα, Σχήμα 3.6 παρουσιάζεται το μπλοκ διάγραμμα του 

αλγορίθμου που χρησιμοποιήθηκε για την αυτόματη ευθυγράμμιση των δύο εικόνων 

δακτυλικών αποτυπωμάτων που εισάγονται στο σύστημα προς αναγνώριση.  
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Εικόνα Αναφοράς

Μετασχηματισμός

Πίνακας 

Προσανατολισμού

Τρέχουσα Εικόνα

Κριτήριο 

Ομοιότητας

Εικόνα 

Προσανατολισμού

Εικόνα 

Προσανατολισμού

Πίνακας 

Προσανατολισμού

Απόφαση

Αποτέλεσμα
 

Σχήμα 3.6 Μπλοκ διάγραμμα του αλγορίθμου αυτόματης ευθυγράμμισης των 

εικόνων δακτυλικών αποτυπωμάτων 

 

 

Ακολουθεί η αναλυτική παρουσίαση των επιμέρους βημάτων του πιο πάνω 

διαγράμματος.  
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Πίνακας Προσανατολισμού: Στο Κεφάλαιο 2 ορίστηκε το πεδίο 

προσανατολισμού ως μία απεικόνιση της δομής των κορυφογραμμών και των 

κοιλάδων σε ένα δακτυλικό αποτύπωμα ή με άλλα λόγια της κατευθυντικότητας τους. 

Σε μαθηματικό επίπεδο αυτή η απεικόνιση μεταφράζεται ως ένας πίνακας, τα 

στοιχεία του οποίου δηλώνουν την γωνία της κατεύθυνση μιας γειτονιάς 

εικονοστοιχείων. Δοθέντος μιας κανονικοποιημένης εικόνας G, τα βασικά βήματα για 

τον υπολογισμό του πίνακα προσανατολισμού είναι τα εξής [2]: 

1. Διαίρεση της εικόνας G, σε μικρότερα τμήματα,  με μέγεθος w x w 

εικονοστοιχεία12. 

2.  Υπολογισμός των κλίσεων  και  για κάθε 

εικονοστοιχείο (i,j).  

3. Εκτίμηση του τοπικού προσανατολισμού σε κάθε τμήμα με κέντρο 

κάθε εικονοστοιχείο (i,j). 

Α. Υπολογισμός των κλίσεων  και  :  

Μαθηματικά, η κλίση μιας συνάρτησης δύο μεταβλητών13, σε κάθε 

εικονοστοιχείο, είναι ένα δισδιάστατο διάνυσμα με συνιστώσες τις παραγώγους προς 

την οριζόντια και κατακόρυφη κατεύθυνση. Σε κάθε εικονοστοιχείο, το διάνυσμα 

κλίσης παριστάνει την κατεύθυνση προς την μέγιστη πιθανή αύξηση έντασης της 

γειτονιάς του. Είναι γνωστό πως σε μία δεδομένη συνάρτηση, η παράγωγος της 

δίνεται από την πιο κάτω εξίσωση: 

 

 

 

                                                           
12 Προεπιλεγμένο μέγεθος είναι 15 x 15 εικονοστοιχεία 

13 Στις εικόνες μία από τις μεταβλητές είναι η ένταση του κάθε εικονοστοιχείου. 
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Η πιο πάνω προσέγγιση είναι αποδεκτή δεδομένου ότι αναφέρεται σε 

διακριτές και όχι συνεχής τιμές. Οπότε το πρόβλημα καταλήγει σε απλές 

προσθαφαιρέσεις εντάσεων των γειτονικών εικονοστοιχείων. 

Για τον υπολογισμό των κλίσεων  και  χρησιμοποιήθηκε ο 

τελεστής Sobel [3]. Μαθηματικά, ο τελεστής Sobel είναι ένας πίνακας 3 x 3, ο οποίος 

εφαρμόζεται σε κάθε εικονοστοιχείο της εικόνας ώστε να υπολογιστούν οι 

προσεγγίσεις των παραγώγων, μία προς την κατακόρυφη και μία προς την οριζόντια 

διεύθυνση. Οι κλίσεις υπολογίζονται με βάση τις παρακάτω εξισώσεις : 

 

 

 

 

όπου με I ορίζεται η πηγαία εικόνα, με Gx και Gy οι δύο εικόνες, των οποίων κάθε 

στοιχείο περιέχει την οριζόντια και κατακόρυφη παράγωγο. Σαρώνοντας κάθε 

εικονοστοιχείο της εικόνα, εφαρμόζεται ο τελεστής Sobel με βάση τις παρακάτω 

σχέσεις: 
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όπου Ι(i,j) είναι η ένταση του εικονοστοιχείου της εικόνας Ι στην θέση (i,j). 

 

Ποιοτικά ο τελεστής Sobel μετασχηματίζει την αρχική εικόνα σε μία νέα στην 

οποία τονίζονται οι ακμές. (βλ Σχήμα 3.7). 

 

 

Σχήμα 3.7 (a) Αρχική εικόνα (b) Εικόνα ακμών με χρήση του τελεστή Sobel, 

 

 

 

Β. Υπολογισμός του πίνακα γωνιών των προσανατολισμών: 

Στο προηγούμενο βήμα αναλύθηκε ο τρόπος με τον οποίο υπολογίζεται ο 

πίνακας με τις κλίσεις σε κάθε εικονοστοιχείου μιας εικόνας με χρήση του τελεστή 

Sobel. Ο πίνακας των κλίσεων αποτελεί τη βάση για τον υπολογισμό του τοπικού 

προσανατολισμού κάθε τμήματος της εικόνας επικεντρωμένο σε ένα εικονοστοιχείο 

(i,j) και τελικά στην εξαγωγή του πίνακα με τις γωνίες σε ακτίνια αυτών των 

προσανατολισμών [2].  
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Η εκτίμηση του προσανατολισμού κάθε τμήματος εικόνας δίνεται με βάση τις 

ακόλουθες εξισώσεις: 

 

 

 

 

 

 

όπου,  w, όπως έχει προαναφερθεί, είναι το μέγεθος του τμήματος της αρχικής 

εικόνας και (u,v) είναι η τρέχουσα θέση του εικονοστοιχείου μέσα σε κάθε τέτοιο 

τμήμα. Με χρήση των εξισώσεων 5 και 6 για τις μερικές παραγώγους 

προκύπτουν οι τελικές τιμές των πιο πάνω μεταβλητών : 

 

 

 

 

 

 Τέλος, η γωνία του προσανατολισμού κάθε εικονοστοιχείου υπολογίζεται με 

βάση την Εξίσωση 11: 
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óπου tan-1 είναι η συνεφαπτομένη με στοιχεία τους προσανατολισμούς 

  και π η μαθηματική σταθερά 3.14159. 

Αξίζει να σημειωθεί ότι ο όρος (i,j) υποδηλώνει τη σάρωση καθενός 

εικονοστοιχείου της εικόνας του δακτυλικού αποτυπώματος14. Στην παραπάνω 

εξίσωση θα πρέπει να δοθεί προσοχή στην περίπτωση που ο όρος  είναι ίσος με 

μηδέν, μιας και δεν μπορεί να δώσει αποτέλεσμα για την γωνία . Η περίπτωση 

αυτή εμφανίζεται συνήθως εκεί που ένα τμήμα εικονοστοιχείων δεν εμφανίζει 

προσανατολισμό, δηλαδή σε περιοχές εικονοστοιχείων που παρουσιάζουν ίδιες 

εντάσεις, όπως π.χ.  το άσπρο φόντο του Σχήματος 3.7(a), που θεωρείται ως φόντος 

της εικόνας (background). Είναι λογικό λοιπόν στις περιπτώσεις που δεν υπάρχει 

πληροφορία αποτυπώματος, άρα δεν υπάρχει και κατεύθυνση, η πιο πάνω εξίσωση να 

μην έχει νόημα. Καθώς  ο πίνακας προσανατολισμού θα πρέπει να έχει τιμές για όλα 

τα στοιχεία του, στις περιπτώσεις που εικονοστοιχεία αντιστοιχούν σε περιοχές που 

δεν υπάρχει πληροφορία, οι γωνίες  παίρνουν  συνήθως μία μεγάλη τιμή15. 

Χρησιμοποιώντας τον πίνακα γωνιών, στη συνέχεια μπορούμε να απεικονίσουμε τις 

ευθείες των προσανατολισμών σε κάθε μη επικαλυπτόμενο τμήμα της εικόνας. Αφού 

είναι γνωστή η θέση κάθε εικονοστοιχείου και η γωνία προς την οποία κατευθύνεται 

ο προσανατολισμός του, υπάρχουν τα ικανά και αναγκαία στοιχεία ώστε να 

καταγραφούν τα ευθύγραμμα τμήματα πάνω στην εικόνα του δακτυλικού 

αποτυπώματος (βλ Σχήμα 3.8 (b)). 

                                                           
14 δηλαδή το εύρος τιμών για μία εικόνα 504 x 480 είναι από την θέση (0,0) έως (503,479). 

                15  Για παράδειγμα μπορεί να δωθεί η τιμή  = 1.000.000. 

Με σχόλια [GM16]: Μάλλον εννοείς ότι η εξίσωση δεν έχει 
νόημα αφού δεν υπάρχει κατεύθυνση και προσανατολισμός. 
Ξαναγράψτο!! 
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Σχήμα 3. 8 (a) Αρχική εικόνα (b) Εικόνα με πίνακα προσανατολισμού16 

Παρατηρώντας την εικόνα του πίνακα προσανατολισμού στο προηγούμενο 

σχήμα, είναι φανερό ότι σε συγκεκριμένα τμήματα της αρχικής εικόνας, οι 

αντίστοιχες γωνίες προσανατολισμού έχουν υπολογιστεί λανθασμένα. Αυτό μπορεί 

να οφείλεται κυρίως στην παρουσία θορύβου. Για το λόγο αυτό, είναι απαραίτητη η 

εφαρμογή ενός φίλτρου για την εξάλειψη του θορύβου στον πίνακα 

προσανατολισμού. Καθώς σε τοπικό επίπεδο οι προσανατολισμοί διαφέρουν 

ελάχιστα, μπορεί να χρησιμοποιηθεί ένα βαθυπερατό φίλτρο προκειμένου να 

διορθωθούν  τοπικοί προσανατολισμοί συγκεκριμένων κορυφογραμμών [2]. Το 

βαθυπερατό φίλτρο εφαρμόζεται με την προϋπόθεση ότι αρχικά μετασχηματίζεται ο 

πίνακας προσανατολισμών σε ένα συνεχές διανυσματικό πεδίο. Αυτό 

πραγματοποιείται με τις παρακάτω εξισώσεις: 

 

 

 

                                                           
16 Θα πρέπει να γίνει αντιληπτό πως στη συγκεκριμένη εικόνα απεικονίζονται μόνο τα ευθύγραμμα 

τμήματα του κεντρικού εικονοστοιχείου σε κάθε μπλοκ 15 x 15 εικονοστοιχεία. Γενικά η διαδικασία 

περιγράφει τον υπολογισμό ενός τέτοιου ευθύγραμμου τμήματος για κάθε ένα εικονοστοιχείο αλλά 

για λόγους απεικόνισης εμφανίζονται μόνο τα κεντρικά. 
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όπου τα  και  είναι οι x και y συνιστώσες του διανυσματικού πεδίου 

αντίστοιχα και  είναι η γωνία του προσανατολισμού κάθε εικονοστοιχείου που 

υπολογίστηκε πιο πάνω. Στη συνέχεια, στο διάνυσμα που προκύπτει εφαρμόζεται το 

βαθυπερατό φίλτρο σύμφωνα με τις παρακάτω εξισώσεις: 

 

 

 

 

 

όπου W είναι το δισδιάστατο βαθυπερατό φίλτρο και wφ το μέγεθος του φίλτρου17. 

Συγκεκριμένα, στον αλγόριθμο χρησιμοποιήθηκε ένα απλό φίλτρο μέσου όρου. 

Σαρώνοντας κάθε εικονοστοιχείο και με κέντρο αυτό, εφαρμόζεται ένα «παράθυρο» 

μεγέθους wφ x wφ. Μέσα σε αυτό υπολογίζεται ο μέσος όρος των εντάσεων και η τιμή 

που προκύπτει αντικαθιστά το κεντρικό εικονοστοιχείο. Σημειώνεται πως η 

παραπάνω διαδικασία εφαρμόζεται σε επίπεδο τμημάτων.  

 

 

 

                                                           
17 Το προεπιλεγμένο μέγεθος είναι 4 x 4 (wφ x wφ). 

Με σχόλια [GM17]: Βαλε εξισωση για την ολότητα του 
αλγορίθμου 
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όπου Ι(u,v) είναι  η ένταση του τρέχοντος εικονοστοιχείο μέσα στο τμήμα wφ x wφ  

και Ν είναι το συνολικός αριθμός εικονοστοιχείων στο πιο πάνω τμήμα. Για τις τιμές 

του Ν ισχύει η σχέση  και αυτό γιατί μπορεί να υπάρχουν στοιχεία που δεν 

έχουν προσανατολισμό, οπότε αυτά δεν θα ληφθούν υπόψη κατά την εφαρμογή του 

φίλτρου. 

Τελικά, τα στοιχεία του πίνακα προσανατολισμού, γωνίες προσανατολισμού, 

μετά και την εφαρμογή του φίλτρου προκύπτουν από την ακόλουθη σχέση: 

 

 

Στο Σχήμα 3.8 δίνεται το αποτέλεσμα της εικόνας του πίνακα 

προσανατολισμού μετά και την εφαρμογή του βαθυπερατού φίλτρου.  Με κόκκινο 

χρώμα αποτυπώνονται οι προσανατολισμοί πριν από το φίλτρο και με άσπρο οι 

προσανατολισμοί μετά από την εφαρμογή του. Είναι φανερή η βελτίωση των 

αποτελεσμάτων με την εφαρμογή του συγκεκριμένου φίλτρου. 

 

Σχήμα 3. 9 Απεικόνιση του πίνακα προσανατολισμών πριν και μετά από την 

εφαρμογή του φίλτρου 
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Στην παρούσα φάση έχει ολοκληρωθεί η ανάλυση του πρώτου βήματος του 

αλγορίθμου της ευθυγράμμισης, δηλαδή της δημιουργίας του πίνακα 

προσανατολισμού μιας εικόνας δακτυλικού αποτυπώματος. 

 

Εικόνα Προσανατολισμού: Η Εικόνα Προσανατολισμού αποτελεί την 

απεικόνιση του πίνακα προσανατολισμού. Η εικόνα αυτή μπορεί να προκύψει εύκολα 

αν απλά διακριτικοποιηθούν οι τιμές του πίνακα προσανατολισμού οι οποίες είναι 

πραγματικοί αριθμοί. Η γραμμική διακριτικοποίηση θα γίνει στις τιμές από 0 έως 255 

που είναι το φάσμα τιμών των αποχρώσεων του γκρι.  

Στο Σχήμα 3.10 φαίνεται η γραφική παράσταση της γραμμικής 

διακριτικοποίησης. Θεωρητικά οι ακραίες τιμές του πίνακα προσανατολισμού είναι 

Θ’
min = -  rad και Θ’

max = +  rad. Για να επιτευχθεί η διακριτικοποίηση πρέπει να 

προβληθούν όλες οι τιμές του διαστήματος (Θ’
min , Θ’

max) στο διάστημα (0,255). 

Εφαρμόζουμε την παρακάτω εξίσωση σε όλες τις τιμές του πίνακα προσανατολισμού 

: 

 

 

 

όπου θindex(i,j) είναι η τρέχουσα τιμή της γωνίας προσανατολισμού και Ιdiscr(i,j) είναι 

η διακριτικοποιημένη τιμή που υποδηλώνει τη νέα ένταση του εικονοστοιχείου. 

Πρακτικά, το αποτέλεσμα της παραπάνω διαδικασίας είναι η μετατροπή όλων των 

πραγματικών αριθμών του πίνακα προσανατολισμού στο διάστημα τιμών που να 

μπορούν να απεικονιστούν σαν μία εικόνα. Στο Σχήμα 3.11(b) παρουσιάζεται μία 

χαρακτηριστική εικόνα του προσανατολισμού του δακτυλικού αποτυπώματος. Αυτή 

είναι μοναδική για κάθε δακτυλικό αποτύπωμα αφού απεικονίζει τον 

προσανατολισμό των κορυφογραμμών και κοιλάδων του αποτυπώματος που είναι 

απολύτως μοναδικά στοιχεία κάθε δακτύλου. 
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Σχήμα 3.10 Παράσταση γραμμικής διακριτικοποίησης 

 

 

Σχήμα 3.11 (a) Πίνακας προσανατολισμού (b) Εικόνα Προσανατολισμού με βάση 

την Εξίσωση 19 

 

Στο παρών αλγόριθμο επιλέχθηκε η τιμή Τδιακρ= 255 για τη διακριτικοποίηση. 

Αυτό σημαίνει πως θα προκύπτουν 255 διαφορετικές τιμές για να αναπαρασταθούν 

τα στοιχεία του πίνακα προσανατολισμού. Θα πρέπει να γίνει αντιληπτό πως η τιμή 

αυτή δεν έχει επιλεχθεί αυθαίρετα. Αντίθετα, επηρεάζει άμεσα το τελικό αποτέλεσμα. 

Αν είχε επιλεγεί μία μικρότερη τιμή από το 255, για παράδειγμα το 100, αυτό που θα 

άλλαζε άμεσα είναι το διάστημα προβολής των τιμών του πίνακα προσανατολισμού, 

άρα και η τελική Εικόνα Προσανατολισμού. Μεγάλες τιμές προσφέρουν περισσότερη 

ακρίβεια στη διακριτικοποίηση των μέσων τιμών προσανατολισμού και επομένως πιο 
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ευαίσθητη εκτίμηση του πεδίου προσανατολισμού. Στην περίπτωση αυτή όμως το 

σύστημα είναι περισσότερα ευαίσθητο σε μικρές αλλαγές του τελευταίου και άρα 

στην ποιότητα της εικόνας. Αυτό σε τελική ανάλυση θα προκαλέσει περισσότερες 

λαθεμένες ευθυγραμμίσεις. Από την άλλη μικρότερες τιμές (<100) κατά την 

διακριτικοποίηση προσφέρουν λιγότερες λαθεμένες ευθυγραμμίσεις δακτυλικών 

αποτυπωμάτων αλλά και μικρότερη ακρίβεια κατά την ευθυγράμμιση τους. Είναι 

λοιπόν μία τιμή ορόσημο μεταξύ της αποδοτικότητας και την ακρίβειας του 

συστήματος. Ενδεικτικά  αποτελέσματα διαφορετικών τιμών της διακριτοποίησης σε 

επίπεδο ευθυγράμμισης παρουσιάζονται στο Κεφάλαιο 4. 

Μία διαφορετική προσέγγιση προς την κατεύθυνση της διακριτικοποίησης 

του πίνακα προσανατολισμού είναι η εξής. Στο Σχήμα 3.12 πραγματοποιείται μία 

μεγέθυνση ενός τμήματος του Σχήματος 3.11. Σε αυτό μπορεί να διαπιστωθεί πως αν 

και φαινομενικά τα περισσότερα ευθύγραμμα τμήματα είναι παράλληλα οι 

αντίστοιχες τιμές στην εικόνα διαφέρουν σημαντικά. Συγκεκριμένα, υπάρχει μία 

περιοχή «μεταίχμιο» όπου ο φόντος της εικόνας προσανατολισμού  (τυπικά λευκός 

φόντος) μεταβάλλεται απότομα  (εμφάνιση μαύρων περιοχών) ενώ αντίστοιχα η 

συγκεκριμένη περιοχή στην εικόνα 3.12(α) δεν εμφανίζει  διαφορά. Έτσι ενώ θα 

έπρεπε θα απεικονίζονται μικρές και ομαλές διαβαθμίσεις του γκρι σε αυτήν την 

περιοχή, αντίθετα παρατηρούνται απότομες και μεγάλες αλλαγές. Αυτό είναι 

απολύτως λογικό αφού από τις τιμές –Θi και Θi προκύπτουν παράλληλα ευθύγραμμα 

τμήματα, αλλά κατά τη διακριτικοποίηση λαμβάνουν αντιδιαμετρικές τιμές στην 

κλίμακα (0,255). Στο παράδειγμα του Σχήματος 3.12, τιμές των προσανατολισμών 

είναι π/2 και – π/2, οι οποίες διακριτικοποιούνται στις 0 και 255 αντίστοιχα18.  

Για να αποφευχθεί αυτό το φαινομενικά λαθεμένο αποτέλεσμα, 

πραγματοποιείται μία αλλαγή στα όρια της διακριτικοποίησης. Αναλυτικότερα, το 

διάστημα (Θ’
min , Θ’

max) μετατρέπεται σε από Θ’
min = -  rad και Θ’

max = +  rad σε 

Θ’
min = -0 rad και Θ’

max = +  rad. Η εξίσωση της διακριτικοποίησης μεταβάλλεται ως 

εξής: 

 

                                                           
18 Γι’αυτό το λόγο δημιουργείται η απότομη εναλλαγή του μαύρο με το άσπρο. 

Με σχόλια [GM18]: Σωστή παρατήρηση! Αλλά, υπάρχει και 
ποσοτικός υπολογισμός για να επιβεβαιωθούν τα όσα γράφουμε? 
Ίσως στα αποτελέσματα ένας πίνακας με διαφορετικές τιμές π.χ. 
170 και 90? Μπορεί να δείξουμε τι γίνεται με την ευθυγράμμιση 
(ποσοτικά)? 
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όπου σε σχέση με την εξίσωση (19) μεταβάλλεται  και λαμβάνεται η 

απόλυτη τιμή του όρου  

 

Σχήμα 3.12 Μεγέθυνση τμήματος του Σχήματος 3.11 

Η αντίστοιχη παράσταση της γραμμικής διακριτικοποίησης δίνεται στο Σχήμα 3.13. 

 

Σχήμα 3.13 Νέα Παράσταση Γραμμικής Διακριτικοποίησης 

Με σχόλια [GM19]: Να στοιχιστεί με το κείμενο 
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Το αποτέλεσμα της πιο πάνω διακριτικοποίησης παρουσιάζεται στο Σχήμα 3.14, όπου 

εμφανίζεται μία περισσότερο ομαλή εικόνα προσανατολισμού. 

 

Σχήμα 3.14 (a) Πίνακας προσανατολισμού (b) Εικόνα Προσανατολισμού με βάση 

την Εξίσωση 17 

 

Τέλος θα πρέπει να επισημανθεί ότι κατά την πιο πάνω διαδικασία δεν 

λήφθηκαν υπόψη οι τιμές του φόντους της εικόνας. Επομένως, στις περιπτώσεις που 

η γωνία Θi περιέχει τιμή εκτός πληροφορίας (π.χ. Θi=1.000.000), κατά τη 

διακριτικοποίηση δίνεται κάποια αντίστοιχη χαρακτηριστική τιμή19 στη θέση αυτή. 

Είναι δηλαδή μία τιμή εκτός ορίων διακριτικοποίησης που υποδηλώνει και πάλι την 

έλλειψη πληροφορίας. Για λόγους απεικόνισης και μόνο της εικόνας 

προσανατολισμού, η τιμή αυτή αντιστοιχεί στο άσπρο χρώμα χωρίς αυτό να σημαίνει 

ότι και ο πίνακας με τις εντάσεις της εικόνας προσανατολισμού έχει την τιμή 255 

(άσπρο). 

 

 

                                                           
19 Στην παρούσα εργασία η τιμή αυτή είναι το -1. 
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Κριτήρια Ομοιότητας: Στην παρούσα φάση της διαδικασίας έχουν εξαχθεί 

οι δύο εικόνες προσανατολισμού για κάθε ένα από τα δακτυλικά αποτυπώματα, αυτό 

του τρέχοντος και αυτό του αποτυπώματος αναφοράς. Στη συνέχεια ,  οι δύο εικόνες 

προσανατολισμού θα πρέπει να ευθυγραμμιστούν προκειμένου να γίνει η σύγκρισή 

τους. Η ευθυγράμμιση μπορεί να θεωρηθεί ως η βελτιστοποίηση ενός κριτηρίου 

ομοιότητας. Στον παρόντα αλγόριθμο υλοποιήθηκαν και χρησιμοποιήθηκαν δύο 

κριτήρια ομοιότητας: το κριτήριο του Συντελεστή Αμοιβαίας Πληροφορίας20 και το 

κριτήριο του Συντελεστή Συσχέτισης21. Γενικά, τα κριτήρια ομοιότητας θα πρέπει 

να παρουσιάζουν δύο κυρίως βασικές ιδιότητες:  

1. Να έχουν όσο το δυνατόν λιγότερα τοπικά ακρότατα, 

2. Να μην είναι ευαίσθητα σε διαφορές στην αντίθεση και στην 

φωτεινότητα των δύο συνόλων. 

Η πρώτη απαίτηση μειώνει τις πιθανότητες να παγιδευτεί η λύση σε περιοχή 

τοπικού μεγίστου και έτσι να καταστεί η ευθυγράμμιση μη επιτυχείς. Η δεύτερη 

απαίτηση εξασφαλίζει ότι ενδεχόμενες διαφορές στην φωτεινότητα ή/και την 

αντίθεση μεταξύ των συνόλων δεδομένων δεν επηρεάζουν τη διαδικασία της 

ευθυγράμμισης. Και τα δύο κριτήρια επιλέχθηκαν με βάση την εκπλήρωση των πιο 

πάνω απαιτήσεων. 

Α. Κριτήριο Συντελεστή Αμοιβαίας Πληροφορίας 

• Θεωρητική Προσέγγιση 

Το κριτήριο του Συντελεστή Αμοιβαίας Πληροφορίας χρησιμοποιείται κυρίως 

όταν τα σύνολα δεδομένων προέρχονται από διαφορετικά υπολογιστικά 

απεικονιστικά συστήματα και στηρίζεται στην Εντροπία [1]. Η Εντροπία είναι ένα 

στατιστικό μέγεθος το οποίο συνοψίζει την τυχαιότητα κάποιας μεταβλητής. Για μία 

διακριτή μεταβλητή Χ, η Εντροπία ορίζεται ως εξής: 

 

                                                           
20 Στην αγγλική βιβλιογραφία αναφέρεται ως Mutual Information. 

21 Στην αγγλική βιβλιογραφία αναφέρεται ως Correlation Coefficient. 
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όπου Ωx είναι το διάστημα δειγματισμού και xi είναι ένα μέλος αυτού του 

διαστήματος. Επιπλέον ο όρος P(X=xi) είναι η πιθανότητα η μεταβλητή Χ να πάρει 

την τιμή xi. Από την παραπάνω εξίσωση φαίνεται πως όσο πιο τυχαία είναι μία 

μεταβλητή, τόσο περισσότερη Εντροπία θα έχει.  

Ένας επιπλέον όρος που θα πρέπει να οριστεί για τον υπολογισμό της 

Αμοιβαίας Πληροφορίας είναι η από «Κοινού Εντροπία22». Εκφράζει  την τυχαιότητα 

δύο μεταβλητών Y και Χ και ορίζεται από την ακόλουθη σχέση: 

(22) 

όπου Ωx και Ωy είναι και πάλι τα διαστήματα δειγματοληψίας, xi και yi είναι μέλη των 

αντίστοιχων δειγμάτων και P(X =xi, Y =yi) η πιθανότητα να πάρει η μεταβλητή Χ την 

τιμή xi και η Υ την yi.  

Τελικά η Αμοιβαία Πληροφορία ορίζεται με τη βοήθεια των παραπάνω 

εξισώσεων ως εξής : 

 

όπου Η(Χ) και Η(Υ) είναι η Εντροπίες των μεταβλητών Χ και Υ αντίστοιχα, ενώ η 

Η(Χ,Υ) είναι η κοινή τους Εντροπία. 

Από τη θεωρητική ανάλυση του Συντελεστή Αμοιβαίας Πληροφορίας, 

συμπεραίνεται ότι αποτελεί ένα μέγεθος που εκφράζει την στατιστική εξάρτηση δύο 

τυχαίων μεταβλητών Χ και Υ.  

• Αναγωγή στην περίπτωση των δακτυλικών αποτυπωμάτων 

Στη συνέχεια ανάγεται το πιο πάνω θεωρητικό υπόβαθρο για το Κριτήριο του 

Συντελεστή Αμοιβαίας Πληροφορίας, στην περίπτωση των δακτυλικών 

αποτυπωμάτων. Ο Συντελεστής Αμοιβαίας Πληροφορίας δύο εικόνων, οι οποίες 

                                                           
22 Στην αγγλική βιβλιογραφία αναφέρεται ως Joint Entropy. 
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μπορούν να οριστούν ως σύνολα δεδομένων, I1 και Ι2, ορίζεται από την παρακάτω 

σχέση : 

 

όπου Gmax και Gmin είναι η μέγιστη και ελάχιστη τιμή των επιπέδων γκρίζου 

των δύο συνόλων δεδομένων, αντίστοιχα23. Tο   , το 

 . 

Ο όρος  δεν είναι τίποτα άλλο από το από κοινού ιστόγραμμα των 

δύο συνόλων δεδομένων. Είναι γνωστό πως το ιστόγραμμα μίας εικόνας είναι ένα 

στατιστικό γράφημα της συχνότητας των τιμών των επιπέδων του γκρίζου (βλ Σχήμα 

3.15). Αυτό προκύπτει, σαρώνοντας κάθε εικονοστοιχείο του δακτυλικού 

αποτυπώματος και παράλληλα αυξάνοντας κατά μία μονάδα την τιμή της αντίστοιχης 

θέσης που δηλώνει την ένταση του στο γράφημα του ιστογράμματος. Τελικά, 

προκύπτει ένας πίνακας 1x256 με στοιχεία τους αριθμούς εμφάνισης των εντάσεων 

στις αποχρώσεις του γκρίζου. Είναι λογικό πως αν προσθέσουμε όλα τα στοιχεία του 

πίνακα ιστογράμματος θα προκύπτει ο συνολικός αριθμός εικονοστοιχείων μιας 

εικόνας.  

 

 

Σχήμα 3.15 Ιστόγραμμα δακτυλικού αποτυπώματος 

                                                           
23 Συνήθως οι τιμές είναι Gmin=0 και Gmax=255. 
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Το διπλό ή από κοινού ιστόγραμμα είναι ένας πίνακας 256x256 ο οποίος 

προκύπτει ως εξής. Σαρώνοντας ταυτόχρονα τα εικονοστοιχεία και των δύο εικόνων 

και αυξάνοντας κατά μία μονάδα την τιμή του πίνακα στη θέση που προκύπτει από 

τις τρέχουσες εντάσεις των εικονοστοιχείων (βλ Σχήμα 3.16). Για παράδειγμα, αν 

στην θέση (30,45) των δύο εικόνων οι εντάσεις των εικονοστοιχείων είναι 45 και 255 

αντίστοιχα, αυξάνεται κατά μία μονάδα η τιμή του πίνακα διπλού ιστογράμματος στη 

θέση (45,255).  

Μία σημαντική παρατήρηση που προκύπτει από την παραπάνω διαδικασία 

είναι πως αν υπολογιστεί το από κοινού ιστόγραμμα της ίδιας εικόνας θα προκύψει 

ένας διαγώνιος πίνακας με τιμές διαγωνίου τα στοιχεία του απλού ιστογράμματος. 

 

 

Σχήμα 3.16 Διπλό ή από κοινού ιστόγραμμα 



79 

 

 

Σχήμα 3.17 Πίνακας του από κοινού ιστογράμματος 

Αφού υπολογιστεί ο πίνακας του διπλού ιστογράμματος των δακτυλικών 

αποτυπωμάτων (βλ. Σχήμα 3.17), διαιρούνται όλα τα στοιχεία του με τον συνολικό 

αριθμό των εικονοστοιχείων24. Έτσι προκύπτει ένας πίνακας με τις πιθανότητες 

εμφάνισης του κάθε συνδυασμού εντάσεων στις δύο εικόνες. Αυτός ο πίνακας είναι ο 

όρος  . Αν προστεθούν όλα τα στοιχεία του εν λόγο πίνακα, το αποτέλεσμα 

θα είναι η μονάδα.  

Οι όροι  και  είναι 

πρακτικά, πίνακες μεγέθους 1 x 256 με στοιχεία τα αθροίσματα κατά σειρά και κατά 

στήλη των τιμών του πίνακα από κοινού ιστογράμματος. Τα πιο πάνω συμπεράσματα 

παρουσιάζονται στο Σχήμα 3.18. 

 

                

Σχήμα 3.18 Παρουσίαση παραδείγματος των όρων p1,2(k1,k2) , p1(k1) και p2(k2) 

                                                           
24 Στην περίπτωση του συγγράμματος το σύνολο των ειονοστοιχείων είναι 504 x 480 = 241.920 
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Σύμφωνα με τα παραπάνω, μπορούν να εκφραστούν αναλυτικότερα οι σχέσεις 

με του όρους p1 , p2 και p1,2 : 

 

 

 

 

    

 

   

                           

 

οπότε τελικά ο συντελεστής Αμοιβαίας Πληροφορίας προκύπτει από την παρακάτω 

σχέση : 

 

 

Τελικά, γίνεται χρήση μίας κανονικοποιημένης μορφής του συντελεστή 

Αμοιβαίας Πληροφορίας στο διάστημα (0,1) ώστε να υπάρχει καλύτερη εκτίμηση 

των τιμών κατά τη διενέργεια πειραματικών αποτελεσμάτων, όπως θα φανεί στο 

Κεφάλαιο 4. Η μορφή αυτή δίνεται από την πιο κάτω σχέση : 
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Το συγκεκριμένο κριτήριο ομοιότητας μπορεί να χρησιμοποιηθεί για την 

ευθυγράμμιση δύο συνόλων δεδομένων ανεξάρτητα από το αν τα επίπεδα του 

γκρίζου συνδέονται με γραμμική ή μη γραμμική σχέση. Τέλος, και στην εφαρμογή 

του συγκεκριμένου κριτηρίου ομοιότητας δεν ελήφθησαν υπόψη  οι τιμές των 

εικονοστοιχείων που αντιστοιχούν σε  μη χρήσιμη πληροφορία (π.χ. φόντος εικόνων).  

 

Β. Συντελεστής Συσχέτισης 

• Θεωρητική Προσέγγιση  

Στη στατιστική και στη θεωρία πιθανοτήτων, ο Συντελεστής Συσχέτισης, 

υποδηλώνει τη δύναμη και την κατεύθυνση της γραμμικής εξάρτησης μεταξύ δύο 

τυχαίων μεταβλητών [1].  

Ο Συντελεστής Συσχέτισης, ρXY, δύο τυχαίων μεταβλητών, Χ και Υ, δίνεται 

από την παρακάτω σχέση: 

 

 

όπου ρXY, είναι ο Συντελεστής Συσχέτισης των τυχαίων μεταβλητών Χ και Υ, σΧ , σΥ, 

πρότυπες αποκλίσεις των Χ και Υ, αντίστοιχα. Επίσης, Ε, είναι ο τελεστής 

αναμενώμενης τιμής, ως cov ορίζεται η μέση συνδιακύμανση. Τέλος, ισχύει ότι το μΧ 

= Ε(Χ) και σΧ
2 =  Ε(Χ2) – Ε2(Χ), κατά αντιστοιχία και για την μεταβλητή Υ. Οπότε η 

σχέση μπορεί πλέον να γραφεί ως εξής: 
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Η τιμή του Συντελεστή Συσχέτισης, ρXY, κυμαίνεται μεταξύ -1 και 1. Αν δεν 

υπάρχει καμία συσχέτιση μεταξύ των τυχαίων μεταβλητών X και Y, το ρΧΥ= 0, ενώ 

αν υπάρχει τέλειο ταίριασμα παίρνει τιμή, ρΧΥ= 1. Τέλος, αν υπάρχει μία τέλεια 

αντίστροφη σχέση μεταξύ των μεταβλητών όπου το ένα σύνολο μεταβλητών 

αυξάνεται ενώ το άλλο μειώνεται αντίστοιχα, η τιμή του ρΧΥ= -1. 

 

• Αναγωγή στην περίπτωση των δακτυλικών αποτυπωμάτων. 

Εν συνεχεία, ανάγεται η παραπάνω θεωρητική προσέγγιση, στην περίπτωση 

των δακτυλικών αποτυπωμάτων. Έστω ότι έχουμε δύο εικόνες αποτυπωμάτων, οι 

οποίες μπορούν να οριστούν και ως σύνολα δεδομένων, Ι1 και Ι2. Ο Συντελεστής 

Συσχέτισης, CC(I1,I2), ορίζεται από την ακόλουθη σχέση: 

 

όπου  και  είναι οι μέσες τιμές των επιπέδων του γκρίζου των δύο συνόλων 

δεδομένων υπολογισμένες στα σημεία (i,j). Ο Συντελεστής Συσχέτισης 

χαρακτηρίζεται από τις εξής ιδιότητες: 

 

•  

• CC(a1I1+ b1, a2I2+ b2) = CC(I1,I2) , όπου a1, a2, b1, b2  . 

•  , αν και μόνο αν τα δύο σύνολα δεδομένων είναι εντελώς 

ασυσχέτιστα μεταξύ τους. 

•  αν και μόνο αν ισχύει Ι1(i,j) = a Ι1(i,j) +b για κάθε (i,j) και a,b 

. 
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Από τις παραπάνω ιδιότητες προκύπτει το συμπέρασμα πως αν μεταβληθεί γραμμικά 

η φωτεινότητα μεταξύ των δύο συνόλων δεδομένων δεν θα υπάρξει επίδραση στην 

τιμή του συντελεστή συσχέτισης. Επομένως, η απόλυτη τιμή του συντελεστή 

συσχέτισης μπορεί να χρησιμοποιηθεί ως κριτήριο ομοιότητας για την ευθυγράμμιση 

δύο συνόλων δεδομένων των οποίων τα επίπεδα γκρίζου διαφέρουν κατά έναν 

πολλαπλασιαστικό ή/και προσθετικό παράγοντα. 

 Αναλυτικότερα, στον παρών αλγόριθμο, έγιναν τα εξής βήματα για την 

εξαγωγή του συντελεστή συσχέτισης δύο εικόνων δακτυλικών αποτυπωμάτων. 

Υπενθυμίζεται πως μέχρι τώρα έχουν εξαχθεί οι δύο εικόνες προσανατολισμού μετά 

από την διαδικασία της διακριτικοποίησης του κάθε πίνακα γωνιών 

προσανατολισμού. Σαρώνοντας ταυτόχρονα κάθε εικονοστοιχείο των εικόνων 

προσανατολισμού εκτός από αυτά που η τιμή τους υποδηλώνει φόντο25, 

υπολογίζονται οι εξής μεταβλητές: 

• ΙΧ και ΙΥ, ως τα αθροίσματα των εντάσεων κάθε εικονοστοιχείου στην εικόνα 

αναφοράς και στην τρέχουσα αντίστοιχα, 

• Ιxx και ΙYY, ως τα αθροίσματα τετραγώνου της κάθε έντασης εικονοστοιχείου 

για τις δύο εικόνες χωριστά, 

• ΙΧΥ ως το άθροισμα γινομένων των αντίστοιχων εντάσεων εικονοστοιχείων σε 

κάθε θέση.  

Για παράδειγμα αν στην θέση (45,60), η μία εικόνα έχει ένταση εικονοστοιχείου 

100, ενώ η άλλη στην ίδια θέση έχει 150, το γινόμενο τους , 15.000, θα προστεθεί 

στο τρέχουν άθροισμα. Αυτό επαναλαμβάνεται για κάθε θέση στις δύο εικόνες, 

δηλαδή από την (0,0) έως την (503,479). 

Αφού πλέον έχουν προκύψει από τη σάρωση οι παραπάνω μεταβλητές μπορεί να 

εξαχθεί ο συντελεστής συσχέτισης ως εξής: 

 

                                                           
25 Εκτός από εκείνα που έχουν τιμή έντασης -1, δηλαδή έλλειψη δεδομένων. 
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όπου Ν είναι ο συνολικός αριθμός των εικονοστοιχείων που έλαβαν μέρος στη 

σάρωση, δηλαδή όλα τα εικονοστοιχεία εκτός από αυτά που έχουν ένταση -1. 

 

Τέλος πρέπει να επισημανθεί πως και τα δύο προτεινόμενα κριτήρια δίνουν 

τιμές στο διάστημα (0,1) χωρίς όμως να σημαίνει πως υπάρχει εξαρχής αντιστοιχία 

στις τιμές των δύο συντελεστών. Για να συγκρίνουμε δύο τιμές του συντελεστή 

Αμοιβαίας Πληροφορίας και του συντελεστή Συσχέτισης θα πρέπει πρώτα να υπάρξει 

μία επεξεργασία των πειραματικών δεδομένων ώστε να εξαχθεί μία κοινή βάση με 

την οποία θα μπορούν να αντιστοιχηθούν οι τιμές τους. 

 

Απόφαση: Στο προηγούμενο βήμα έγινε προσπάθεια να εξαχθεί ένας 

συντελεστής που να δείχνει κατά πόσο συσχετίζονται (μοιάζουν) ή όχι δύο σύνολα 

δεδομένων όπως είναι οι εικόνες δακτυλικών αποτυπωμάτων. Με τη βοήθεια αυτού 

του συντελεστή θα αναλυθεί παρακάτω ο τρόπος με τον οποίο πραγματοποιείται η 

αυτόματη ευθυγράμμιση των εικόνων προσανατολισμού του τρέχοντος 

αποτυπώματος με αυτό του αποτυπώματος αναφοράς. Το ζητούμενο είναι να 

μπορέσει κανείς να μετασχηματίσει την εικόνα του τρέχοντος αποτυπώματος σε 

σχέση με την εικόνα του αποτυπώματος αναφοράς, ώστε η τιμή του συντελεστή 

ομοιότητα να μεγιστοποιείται. Αυτή η χειροκίνητη διαδικασία μετασχηματισμού 

ενός αποτυπώματος σε σχέση με ένα άλλο, με γνώμονα τη μεγιστοποίηση του 

συντελεστή ομοιότητας τους, πραγματοποιείται αυτόματα με την μέθοδο Powell [4]. 

Α. Μετασχηματισμός Πίνακα Προσανατολισμού: 

Με τον όρο μετασχηματισμός μιας εικόνας εννοείται η μεταβολή μιας εικόνας 

από την αρχική της κατάσταση. Αυτή μπορεί να είναι προς την κατεύθυνση του x 

άξονα, του άξονα y, κατά γωνία θ ως προς τον κάθετο άξονα στο επίπεδο της εικόνας, 

ή ακόμα μία μεγέθυνση ή συρρίκνωση της. Στις εικόνες δακτυλικών αποτυπωμάτων 

έχουν νόημα μόνο γραμμικοί μετασχηματισμοί, μιας και ένας μη-γραμμικός 

μετασχηματισμός θα μπορούσε να αλλάξει τον προσανατολισμό των κορυφογραμμών 

και των κοιλάδων, αλλοιώνοντας έτσι το ίδιο το δακτυλικό αποτύπωμα.  
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Στον παρόντα αλγόριθμο, αναπτύχθηκαν και χρησιμοποιήθηκαν τρεις 

διαφορετικοί γραμμικοί μετασχηματισμοί. Και οι τρεις αυτοί μετασχηματισμοί 

διατηρούν την παραλληλία των γραμμών του δακτυλικού αποτυπώματος και 

αναλύονται παρακάτω: 

1. Συμπαγής μετασχηματισμός26 ( Δx, Δy, Δθ ) [5]: 

Αν υποτεθεί πως η παραμόρφωση των εικόνων των δακτυλικών 

αποτυπωμάτων δεν είναι πολύ μεγάλη, μπορεί να χρησιμοποιηθεί ο συμπαγής 

μετασχηματισμός. Κύρια χαρακτηριστικά του είναι η ταχύτητα και η χρήση 

ελάχιστων υπολογιστικών απαιτήσεων κατά την εφαρμογή του. Στην ουσία αυτό που 

πραγματοποιείται σε αυτήν την περίπτωση είναι μία μετακίνηση κατά Δx και Δy και 

μία περιστροφή κατά Δθ του πίνακα προσανατολισμού της εικόνας.  

Στη γεωμετρία και στη γραμμική άλγεβρα, ο όρος περιστροφή είναι ένας 

μετασχηματισμός στο επίπεδο ή στο χώρο, που περιγράφει την κίνηση ενός άκαμπτου 

σώματος γύρο από ένα σταθερό σημείο. Είναι σημαντικό να καταλάβει κανείς το 

πλαίσιο αναφοράς όταν γίνεται συζήτηση για την περιστροφή. Από την μία πλευρά 

γίνεται λόγος για την περιστροφή ενός διανύσματος, διατηρώντας τους άξονες 

σταθερούς. Από την άλλη μπορεί να περιστραφούν οι συντεταγμένες διατηρώντας 

παράλληλα το διάνυσμα σταθερό. 

Στην πρώτη περίπτωση, πραγματοποιείται αριστερόστροφη περιστροφή μιας 

συντεταγμένης ή ενός ανύσματος γύρω από μία αφετηρία, όπου η (x, y) 

περιστρέφεται κατά θ και αναζητούνται οι συντεταγμένες (x’, y’) μετά την 

περιστροφή: 

 

 

Στην δεύτερη περίπτωση, πραγματοποιείται περιστροφή του επιπέδου ή των 

αξόνων γύρω από μία αφετηρία, ενώ οι συντεταγμένες στο νέο επίπεδο θα 

                                                           
26 Στην αγγλική βιβλιογραφία αναφέρεται ως Rigid 
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περιστραφούν δεξιόστροφα στις νέες τιμές. Στην περίπτωση αυτή, αν οι 

συντεταγμένες του παλιού επιπέδου είναι (x, y) και οι συντεταγμένες του ίδιου 

ανύσματος στο νέο επίπεδο είναι  (x’, y’) τότε : 

 

 Στη συγκεκριμένη εφαρμογή,  χρησιμοποιήθηκε η δεύτερη προσέγγιση του συμπαγή 

μετασχηματισμού. Αναλυτικότερα, αντί να μετασχηματίζεται κάθε συντεταγμένη των 

εικονοστοιχείων σε μία νέα θέση, υπολογίζεται ποια ένταση της αρχικής εικόνας θα 

πρέπει να εκχωρηθεί σε κάθε θέση της μετασχηματισμένης (βλ Σχήμα 3.19).  

 

Σχήμα 3.19 (a) Αριστερόστροφη προσέγγιση (1η)   (b)δεξιόστροφη Προσέγγιση 

(2η) 

 

Αν προσθέσουμε και την μετατόπιση κατά Δx και Δy, ο τύπος 

μετασχηματίζεται ως εξής: 

  (39) 
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Στις παραπάνω εξισώσεις δεν αναφέρεται το σταθερό σημείο ως προς το 

οποίο γίνεται η περιστροφή. Στις εικόνες δακτυλικών αποτυπωμάτων, το σημείο αυτό 

είναι το κέντρο του δακτυλικού αποτυπώματος (το κέντρο της εικόνας). Άρα, τελικώς 

η εξίσωση του συμπαγή μετασχηματισμού είναι η ακόλουθη: 

 

 

 

όπου (xk, yk) είναι το σημείο γύρο από το οποίο πραγματοποιείται η περιστροφή27. 

Από την πιο πάνω διαδικασία προκύπτει ένα σημαντικό πρόβλημα. Έστω ότι 

αναζητείται η ένταση που θα πρέπει να πάρει το εικονοστοιχείο στη θέση (30, 50). Αν 

εφαρμόσουμε την Εξίσωση 39, κατά Δx =10, Δy= 20 , Δθ=5 μοίρες, δηλαδή με 

μετασχηματισμό (10,20,5), το σημείο από το οποίο πάρει την ένταση θα είναι το (x’, 

y’) = (-29,4363, 62,9508). Το ερώτημα είναι από ποια συντεταγμένη θα εισαχθεί η 

ένταση στο εικονοστοιχείου της θέσης (30,50), από την (29,62) ή την (30,63); Η 

επίλυση του παραπάνω πραγματοποιείται με χρήση της μεθόδου  της διγραμμικής 

παρεμβολής28 [6]. 

Μέθοδος Διγραμμικής Παρεμβολής 

 Η διγραμμική παρεμβολή είναι μία μέθοδος με βάση την οποία μπορούν να 

παρεμβληθούν συναρτήσεις δύο μεταβλητών πάνω σε ένα κανονικό πλέγμα (π.χ. ένα 

Ευκλείδειο επίπεδο). Η βασική ιδέα είναι να πραγματοποιηθεί μία γραμμική 

παρεμβολή πρώτα προς μία κατεύθυνση και μετά προς μία άλλη. Έστω  μια άγνωστη 

συνάρτηση, f, για την οποία ζητείται να βρεθεί η τιμή της σε κάποιο σημείο P = (x, 

y). Ισχύει η υπόθεση ότι είναι γνωστές οι τιμές της f σε τέσσερα σημεία Q11= (x1, y1), 

Q12= (x1, y2), Q21= (x2, y1), Q22= (x2, y2) (βλ Σχήμα 3.20). Εφαρμόζοντας γραμμική 

παρεμβολή προς τον άξονα του x ισχύει: 

                                                           
27 Στον αλγόριθμο ισχύει (xk, yk) = (width/2, height/2) όπου width= 504/2 και height = 480/2  

28 Στην αγγλική βιβλιογραφία αναφέρεται ως bilinear interpolation. 
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Ακολούθως με παρεμβολή προς τον άξονα y: 

 

Τα πιο πάνω θα δώσουν την επιθυμητή εκτίμηση για την f(x, y) : 

 

Αν γίνει επιλογή του συστήματος συντεταγμένων με βάση το οποίο τα τέσσερα 

σημεία στα οποία είναι γνωστή η f, είναι τα (0, 0), (0, 1), (1, 0), (1, 1), η εξίσωση 

απλοποιείται στην κάτωθι: 

 

 ή με την μορφή πινάκων  
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Σχήμα 3.20 Γραφική απεικόνιση της μεθόδου διγραμμικής παρεμβολής. 

 Συγκεκριμένα, στην περίπτωση των δακτυλικών αποτυπωμάτων, η διαδικασία 

είναι η ακόλουθη. Σαρώνοντας κάθε θέση της εικόνας εκχωρείται μία νέα τιμή 

έντασης, η οποία είναι αποτέλεσμα της διγραμμικής παρεμβολής μιας 

περιστρεμμένης συντεταγμένης. Για παράδειγμα έστω ότι περιστρέφεται μία εικόνα 

δακτυλικού αποτυπώματος κατά 35ο χωρίς οριζόντια και κατακόρυφη μετατόπιση, 

δηλαδή με βάση τον μετασχηματισμό (Δx, Δy, Δθ) = (0, 0, 35)(βλ Σχήμα 3.21). Στην 

θέση (260,300) θα πρέπει να εκχωρηθεί ένταση που είναι αποτέλεσμα της 

διγραμμικής παρεμβολής του (x, y) = (363,4150 , 159,7802), όπως προέκυψε από την 

Εξίσωση 39, δηλαδή ένας συνδυασμός των εντάσεων στις θέσεις (363,159), 

(364,159), (363,160), (364,160). Αν υποτεθεί ότι ισχύουν: 

 

 

 

 

 

 

Η τιμή κάθε εικονοστοιχείου της περιστραμμένης εικόνας προκύπτει από την πιο 

κάτω σχέση: 
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όπου Ι(i,j) η νέα τιμή κάθε περιστρεμμένου εικονοστοιχείου.  

 

Σχήμα 3.21 Παράδειγμα διγραμμικής παρεμβολής στα δακτυλικά αποτυπώματα 

Στο Σχήμα 3.22 απεικονίζεται ένα περιστρεμμένο δακτυλικό αποτύπωμα αρχικά 

χωρίς τη χρήση της διγραμμικής παρεμβολής και έπειτα με χρήση αυτής. Η διαφορά 

στην ποιότητα της εικόνας είναι εμφανής. 

 

Σχήμα 3.22 (a) Περιστροφή κατά 20 μοίρες χωρίς διγραμμική παρεμβολή (b) 

Περιστροφή κατά 20 μοίρες με διγραμμική παρεμβολή 
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2. Μετασχηματισμός Ομοιότητας29 (Δx, Δy, Δθ, r) [7]: 

Ο μετασχηματισμός Ομοιότητας είναι μία επέκταση του συμπαγούς 

μετασχηματισμού. Όπως και στην προηγούμενη περίπτωση μετασχηματισμού,  

υπάρχει περιστροφή, οριζόντια, κατακόρυφη μετατόπιση αλλά επιπλέον και ένας 

πολλαπλασιαστικός παράγοντας. Ο τελευταίος προσάπτεται στα στοιχεία του πίνακα 

περιστροφής: 

 

 

Στο Σχήμα 3.23 παρουσιάζονται μετασχηματισμένες εικόνες για διαφορετικές 

τιμές του r. Αυτό που παρατηρείται είναι ότι με τον μετασχηματισμό ομοιότητας, 

σμικρύνεται ή μεγεθύνεται η εικόνα του δακτυλικού αποτυπώματος. Έτσι στην 

περίπτωση που εισαχθούν στο σύστημα εικόνες με διαφορετική κλίμακα, ο 

αλγόριθμος θα μπορέσει να τις μετασχηματίσει ώστε να συμπέσουν. Τέλος, και σε 

αυτήν την περίπτωση, ισχύει η διατήρηση της παραλληλίας των γραμμών μετά την 

εφαρμογή του μετασχηματισμού (βλ Σχήμα 3.24). 

                                                           
29 Στην αγγλική βιβλιογραφία αναφέρεται ως similitude transformation 
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Σχήμα 3.23 Παραδείγματα Μετασχηματισμού Ομοιότητας για διάφορα r =1 , 

r=1,5 , r=0,5 , r=2, χωρίς περιστροφή ή/και κάθετη-οριζόντια μετατόπιση 

 

 

Σχήμα 3.24 (a) Εικόνα με δύο παράλληλες ευθείες (b) Στην μετασχηματισμένη 

εικόνα οι ευθείες διατηρούν την παραλληλία τους που είναι χαρακτηριστικό του 

μετασχηματισμού ομοιότητας. 
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3. Ομοπαραλληλικός μετασχηματισμός30 (θ, Sx, Sy, hx, hy, b0, b1) [8]: 

Στην κλασική γεωμετρία, ο ομοπαραλληλικός μετασχηματισμός μεταξύ δύο 

διανυσματικών χώρων, αποτελεί έναν γραμμικό μετασχηματισμό ο οποίος 

χρησιμοποιεί την ακόλουθη βασική σχέση : 

 

Στις εικόνες δακτυλικών αποτυπωμάτων ο ομοπαραλληλικός 

μετασχηματισμός εφαρμόζεται με βάση την παρακάτω σχέση : 

 

Λύνοντας την εξίσωση (47) ως προς την , ισχύει: 

 

όπου ο όρος  είναι η ορίζουσα του πίνακα 

. 

Μία αναλυτικότερη προσέγγιση του ομοπαραλληλικού μετασχημαστισμού, 

μπορεί να δοθεί, αν αναλυθεί σε επιμέρους γραμμικούς μετασχηματισμούς. Αυτή 

είναι οι εξής :
        

• Ταυτότητας   

• Περιστροφής  

• Αλλαγή Κλίμακας  

• Διάτμησης  

                                                           
30 Στην αγγλική βιβλιογραφία αναφέρεται ως affine transformation 
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Ταυτότητα Περιστροφή Αλλαγή Κλίμακας  Διάτμηση 

Σχήμα 3.25 Ανάλυση του ομοπαραλλήλικού μετασχηματισμού σε 

επιμέρους γραμμικούς μετασχηματισμούς. 

 

Οπότε πλέον η νέα προσέγγιση του μετασχηματισμού περιγράφεται 

πολλαπλασιάζοντας τους παραπάνω όρους : 

 

 

Τέλος ο αντίστροφος ομοπαραλληλικός μετασχηματισμός περιγράφεται από την 

παρακάτω σχέση αν απλά λυθεί η Εξίσωση 52 ως προς  : 

 

 

 

 

Τελειώνοντας την παρουσίαση και ανάλυση των τριών μεθόδων 

μετασχηματισμού,  συνεχίζεται η αναζήτηση των κατάλληλων παραμέτρων και της 
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συνάρτησης που πρέπει να εισαχθεί στην μέθοδο Powell [4] ώστε να μεγιστοποιηθεί 

ο συντελεστής ομοιότητας (Αμοιβαίας Πληροφορίας ή Συσχέτισης) μεταξύ των δύο 

εικόνων δακτυλικών αποτυπωμάτων. 

 

Β. Μέθοδος Powell [4]. 

• Θεωρητική προσέγγιση  

Ο Powell [4] είναι ο πρώτος που ανακάλυψε μία μέθοδο η οποία παράγει ένα 

σύνολο Ν αμοιβαία «μη παρεμβαλλόμενων» κατευθύνσεων για την ελαχιστοποίηση 

μιας δευτεροβάθμιας συνάρτησης. Η μέθοδος αποτελείται από τα παρακάτω βήματα: 

1. Αρχικοποίηση του συνόλου κατευθύνσεων ui σε ένα διάνυσμα βάσης: 

ui = ei  I = 1,…,N. 

2. Επανάληψη των παρακάτω βημάτων μέχρι ότου η συνάρτηση να 

σταματήσει να μειώνεται: 

• Αποθήκευση της αρχικής θέσης, έστω P0. 

• Για i = 1,…,N , μετακίνηση του Pi-1 προς την ελάχιστη 

κατεύθυνση ui και αποθήκευση του σημείου, έστω Pi. 

• Για i = 1,…,N-1 , ανάθεση . 

• Ανάθεση . 

• Μετακίνηση του PN προς την ελάχιστη κατεύθυνση κατά uN 

και ανάθεση του σημείου στην P0. 

Το 1964, ο Powell απέδειξε πως για μία δευτεροβάθμια εξίσωση με Κ 

επαναλήψεις της παραπάνω βασικής διαδικασίας παράγεται ένα σύνολο 

κατευθύνσεων ui, του οποίου τα K τελευταία μέλη είναι «μη παρεμβαλλόμενα». Για 

αυτό το λόγο, Ν επαναλήψεις της πιο πάνω βασικής διαδικασίας, σε συνολικά 

Ν×(Ν+1) ελαχιστοποιήσεις κατά γραμμή, είναι ακριβώς όσες απαιτούνται για να 

ελαχιστοποιήσουν μία δευτεροβάθμια εξίσωση. 
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Με απλά λόγια αυτό που κάνει πολύ καλά η μέθοδος του Powell είναι, πως 

δεδομένου μιας συνάρτησης, για παράδειγμα της x2+y2= 0 (βλ Σχήμα 3.26(a)), 

επιστρέφεται η τιμή του ελαχίστου της καθώς και το σημείο (x,y) στο οποίο 

παρουσιάζεται αυτό, με λίγες μόνο επαναλήψεις. Αυτό που χρειάζεται σαν είσοδος η 

Powell είναι: 

 

• ένα αρχικό σημείο έναρξης της ελαχιστοποίησης, για παράδειγμα το 

P(10,20), 

•  τον συνολικό αριθμό των μεταβλητών Ν, το οποίο είναι Ν=2 στη 

συγκεκριμένη συνάρτηση,  

• έναν πίνακα xi[N x N], που είναι συνήθως μοναδιαίος. Για την x2+y2= 0,  

το  ή . Είναι ο πίνακας που δηλώνει προς ποια 

κατεύθυνση θα ξεκινήσει η ελαχιστοποίηση, δηλαδή προς την κατεύθυνση 

της μεταβλητής x και μετά y ή αρχικά προς y και μετά προς x. 

• Την ακρίβεια στην προσέγγιση του ελαχίστου ,  

• Τη συνάρτηση που επιδιώκεται να ελαχιστοποιηθεί π.χ. x2+y2= 0. 

Το αποτέλεσμα της πιο πάνω διαδικασίας είναι η επιστροφή του ελαχίστου της 

συνάρτησης, δηλαδή η τιμή fmin =0.0, το σημείο που παρουσιάζεται το ελάχιστο αυτό 

, P(0,0) καθώς και ο αριθμός των επαναλήψεων της διαδικασίας μέχρι να φτάσει σε 

αυτό το αποτέλεσμα, Κ. 
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Σχήμα 3.26 (a) Η συνάρτηση x2+y2 =0 (b) Μία συνάρτηση με τοπικά ακρότατα 

Αξίζει να σημειωθεί ότι σε περίπτωση που η συνάρτηση έχει τοπικά ακρότατα 

όπως φαίνεται στο σχήμα 3.26(b), παίζει ρόλο το σημείο από το οποίο θα ξεκινήσει η 

μέθοδος την ελαχιστοποίηση. Στο παράδειγμα αυτό, θα πέσει σε τοπικό ελάχιστο, 

άρα θα εγκλωβιστεί σε λάθος τιμή.  

 

 

• Αναγωγή στην περίπτωση των δακτυλικών αποτυπωμάτων. 

Για να χρησιμοποιηθεί η μέθοδος του Powell, στην περίπτωση της αυτόματης 

ευθυγράμμισης των δακτυλικών αποτυπωμάτων, θα πρέπει πρώτα να βρεθούν οι 

κατάλληλες είσοδοι και η συνάρτηση που θα αποτελέσουν τα ορίσματα της. Μέχρι 

στιγμής αυτό που έχει γίνει σαφές είναι ότι η Powell επιστρέφει το ελάχιστο μιας 

συνάρτησης. Το πρόβλημα στα δακτυλικά αποτυπώματα είναι η βελτιστοποίηση του 

κριτήριου ομοιότητας που επιλέγεται ως προς τους παραμέτρους ενός εκ των τριών 

γεωμετρικών μετασχηματισμών που προαναφέρθηκαν.  

Σε αντίθεση με τις κοινές μαθηματικές δευτεροβάθμιες εξισώσεις στις οποίες 

οι άγνωστες μεταβλητές είναι συνήθως πραγματικοί αριθμοί, στην περίπτωση της 

αυτόματης ευθυγράμμισης των δακτυλικών αποτυπωμάτων, η άγνωστη μεταβλητή 

είναι ένα το διάνυσμα παραμέτρων ενός γεωμετρικού μετασχηματισμού της μίας 

εικόνας με τέτοιο τρόπο που να συμπίπτει όσο το δυνατόν καλύτερα με την άλλη 

ώστε να αυξάνεται ο συντελεστής ομοιότητας τους. Η αύξηση του συντελεστή όπως 

έχει ήδη αναφερθεί υποδηλώνει το καλύτερο ταίριασμα της μιας εικόνας με την άλλη.  
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Στη συνέχεια, όπως και στο παράδειγμα της συνάρτησης x2+y2= 0, θα 

περιγραφούν οι είσοδοι και τα ορίσματα της Powell. Υπενθυμίζεται πως το 

ζητούμενο είναι να εισαχθούν δύο εικόνες προσανατολισμού δακτυλικών 

αποτυπωμάτων στην Powell και αυτή να τις ευθυγραμμίσει με γνώμονα την 

μεγιστοποίηση του συντελεστή ομοιότητας τους. Άρα δεδομένου πως ήδη υπάρχουν 

οι εικόνες προσανατολισμού όπως περιγράφηκαν πιο πάνω ορίζονται τα στοιχεία που 

απαιτεί η Powell [4] ως εξής: 

1. Το αρχικό σημείο από το οποίο θα ξεκινήσει η μεγιστοποίηση, θα είναι ένας 

πίνακας μετασχηματισμού P(N), όπου Ν είναι ο αριθμός των μεταβλητών και με 

στοιχεία τέτοια ώστε να αφήνουν τον πίνακα προσανατολισμού του τρέχοντος 

δακτυλικού αποτυπώματος ανέπαφο, δηλαδή χωρίς να το μετασχηματίζουν 

αρχικά καθόλου. Παρακάτω φαίνονται τα αρχικά σημεία ανάλογα με τον 

μετασχηματισμό που χρησιμοποιείται κάθε φορά:   

 

• Αυστηρός μετασχηματισμός P(N) = P(Δx, Δy, Δθ) = (0,0,0) 

• Μετασχηματισμός ομοιότητας P(N) = P(Δx, Δy, Δθ,  r) = (0,0,0,1) 

• Ομοπαραλληλικός μετασχηματισμός P(N) = P(θ,Sx,Sy,hx,hy,b0, b1) = 

(0,1,1,0,0,0,0) 

2. Ο συνολικός αριθμός των μεταβλητών είναι ανάλογα με τον μετασχηματισμό 

που χρησιμοποιείται : 

• Αυστηρός μετασχηματισμός : Ν = 3. 

• Μετασχηματισμός ομοιότητας: Ν = 4. 

• Ομοπαραλληλικός μετασχηματισμός: Ν = 7. 

 

3. Ο μοναδιαίος πίνακας xi[N x N], που ιεραρχεί τις κατευθύνσεις μεγιστοποίησης: 
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• Αυστηρός μετασχηματισμός:  

• Μετασχηματισμός ομοιότητας:  

• Ομοπαραλληλικός μετασχηματισμός: 

 

Για παράδειγμα, στην περίπτωση του συμπαγή μετασχηματισμού πρώτα θα 

ξεκινήσει η μεγιστοποίηση προς την κατεύθυνση x, έπειτα στην y και τέλος 

στη διεύθυνση της γωνίας θ.  

 

4. Τέλος το σημαντικότερο όρισμα της Powell είναι φυσικά η συνάρτηση f που 

θέλουμε να μεγιστοποιήσουμε. Η συνάρτηση αυτή θα έχει ως είσοδο έναν 

πίνακα μετασχηματισμού. Με βάση αυτόν τον πίνακα, θα μετασχηματίζεται ο 

πίνακας προσανατολισμού της τρέχουσας εικόνας. Έπειτα θα διακριτικοποιείται 

όπως αναφέρθηκε πιο πάνω, ώστε να προκύψει η εικόνα προσανατολισμού. Εν 

συνεχεία, θα προκύπτει ο συντελεστής ομοιότητας τον δύο εικόνων. Η αρνητική 

τιμή αυτού του συντελεστή θα ανατροφοδοτεί την Powell ώστε να συνεχίσει η 

μεγιστοποίηση του. Η επιστροφή της αρνητικής τιμής της συνάρτησης στην 

Powell δεν είναι τυχαία. Επιλέχθηκε έτσι καθώς η Powell είναι μέθοδος 

εντοπισμού του ελαχίστου μιας συνάρτησης. Στην περίπτωση των 

αποτυπωμάτων, απαιτείται η μεγιστοποίηση των συντελεστή ομοιότητας, άρα 

πρέπει να επιστρέφεται στην Powell η αρνητική τιμή της συνάρτησης. Τα 

παραπάνω απεικονίζονται στο Σχήμα 3.27 υπό μορφή σχεδιαγράμματος. 
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είσοδος

Αυστηρός 

Μετασχηματισμός

Μετασχηματισμός 

Ομοιότητας

Ομοπαραλληλικός 

Μετασχηματισμός

Μετασχηματισμέν

η εικόνα 

προσανατολισμού

Συντελεστής 

Αμοιβαίας 

Πληροφορίας

Συντελεστής 

Συσχέτισης

Αρνητικός 

Συντελεστής 

Ομοιότητας

Έξοδος

Πίνακας 

μετασχηματισμού

P(Ν)

 

Σχήμα 3.27 Διάγραμμα απεικόνισης της συνάρτηση f που θα χρησιμοποιηθεί 

στην μέθοδο Powell 
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Κεφάλαιο 4 – Παρουσίαση ποιοτικών και ποσοτικών αποτελεσμάτων 

4.1 Εισαγωγή 

Στο παρόν Κεφάλαιο  πραγματοποιείται αναλυτική παρουσίαση και 

σχολιασμός των αποτελεσμάτων που προέκυψαν με την εφαρμογή της προτεινόμενης 

μεθοδολογίας και  αλγορίθμων σε εικόνες δακτυλικών αποτυπωμάτων. Αρχικά, 

πραγματοποιείται μία μελέτη σχετικά με την επιλογή του πιο κατάλληλου 

μετασχηματισμού  από τους τρεις μετασχηματισμούς που προτάθηκαν στο Κεφάλαιο 

3 (Συμπαγής, Ομοιότητας, Ομοπαραλληλικός). Η επιλογή αυτή θα στηριχθεί αρχικά 

σε ποιοτικά αποτελέσματα και στη συνέχεια σε ποσοτικά αποτελέσματα με βάση το 

μικρότερο λάθος ευθυγράμμισης από την εφαρμογή κάθε μετασχηματισμού  σε 

εικόνες δακτυλικών αποτυπωμάτων που μετασχηματίζονται με χρήση γνωστών 

παραμέτρων. Μετά την επιλογή του καταλληλότερου μετασχηματισμού, 

πραγματοποιούνται συγκρίσεις σε πραγματικά δεδομένα, δηλαδή σε εικόνες 

δακτυλικών αποτυπωμάτων που προέρχονται από το ίδιο δάκτυλο σε διαφορετικές 

λήψεις και από ζεύγη διαφορετικών δακτύλων. Οι συγκρίσεις γίνονται με χρήση των 

δύο κριτηρίων ομοιότητας, του συντελεστή Αμοιβαίας Πληροφορίας και του 

συντελεστή Συσχέτισης. Τέλος, συμπεριλαμβάνονται συμπεράσματα από την επίδοση 

της εφαρμογής των προαναφερθέντων κριτηρίων σε πραγματικά δεδομένα μέσω της 

μελέτης των ποιοτικών και των ποσοτικών αποτελεσμάτων .  

4.2 Δεδομένα δακτυλικών αποτυπωμάτων 

Το σύνολο δειγματοληψίας που χρησιμοποιήθηκε, αποτελείται από εικόνες 

διαστάσεων 480 x 504 εικονοστοιχείων, τριών διαφορετικών ατόμων, με τρία 

διαφορετικά δάκτυλα για κάθε ένα άτομο και 8 διαφορετικές λήψεις για κάθε 

δάκτυλο. Το σύνολο αυτό χωρίστηκε σε δύο υποσύνολα. Το ένα περιέχει ζεύγη ίδιων 

δακτυλικών αποτυπωμάτων, δηλαδή ζεύγη από εικόνες που ανήκουν στο ίδιο 

αποτύπωμα, έστω Σύνολο Α. Οπότε θα υπάρχουν 63 τέτοια ζεύγη. Το δεύτερο 

σύνολο αποτελείται από ζεύγη διαφορετικών αποτυπωμάτων, δηλαδή από 

αποτυπώματα που ανήκουν σε διαφορετικά δάκτυλα του ίδιου ή ακόμα και άλλου 

ατόμου, έστω Σύνολο Β. Και σε αυτήν την περίπτωση λήφθηκαν 63 διαφορετικά 

ζεύγη.  Με σχόλια [GM20]: Αυτό πρέπει να μπει πριν από τα 
αποτελέσματα ως Ενότητα Δεδομένα Δακτυλικών Αποτυπωμάτων 
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4.3 Κριτήρια ποιοτικών αποτελεσμάτων  

Στην ενότητα αυτή παρουσιάζονται  τα κριτήρια που επιλέχθηκαν για την 

εξαγωγή των ποιοτικών αποτελεσμάτων. Σε αυτά περιλαμβάνονται τα κριτήρια της 

Σκακιέρας, της Σύγκρισης Διαφορών και της Διαφάνειας. Τα κριτήρια αυτά 

εφαρμόζονται στην εικόνα αναφοράς και στην τρέχουσα ευθυγραμμισμένη εικόνα. 

4.3.1 Κριτήριο της Σκακιέρας. 

Το κριτήριο της Σκακιέρας βασίζεται στην απεικόνιση των δύο δακτυλικών 

αποτυπωμάτων της εικόνας αναφοράς και της μετασχηματισμένης εικόνας  σε μία 

εικόνα με βάση το μοτίβο που παρουσιάζει η σκακιέρα, δηλαδή της εναλλαγή 

μαύρων και λευκών τετραγώνων (βλ Σχήμα 4.1). Με βάση το κριτήριο αυτό η κάθε 

εικόνα χωρίζεται σε τετράγωνα τμήματα. Στη συνέχεια, επιλέγεται και απεικονίζεται 

κάθε φορά ένα τετραγωνικό τμήμα της μίας ακολουθούμενο με ένα της άλλης (βλ 

Σχήμα 4.2). Έτσι προκύπτει μία νέα εικόνα η οποία είναι αποτέλεσμα του 

αποτυπώματος αναφοράς και του τρέχοντος ευθυγραμμισμένου. Είναι λογικό ότι όσο 

καλύτερα ευθυγραμμισμένες είναι αυτές οι δύο εικόνες, τόσο λιγότερο θα 

παρατηρούνται οι εναλλαγές μεταξύ των τετραγωνικών τμημάτων(βλ Σχήμα 4.3). 

 

 

Σχήμα 4.1 Μοτίβο που χρησιμοποιείται στις σκακιέρες. 
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Σχήμα 4.2 (a) Πρώτη εικόνα (b) Δεύτερη εικόνα (c) Σχηματισμός σκακιέρας. 

 

  

(a) (b) 

Σχήμα 4.3 Κριτήριο Σκακιέρας (a ) σε καλά ευθυγραμμισμένες εικόνες (b) σε 

όχι καλά ευθυγραμμισμένες εικόνες.  
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Έστω ότι Ι1 και Ι2 είναι δύο σύνολα δεδομένων εικόνας. Η μία είναι η εικόνα 

αναφοράς και η άλλη η ευθυγραμμισμένη εικόνα τρέχοντος αποτυπώματος. Έστω Ι 

είναι η καινούρια εικόνα. Επιλέγεται ένα παράθυρο w x w εικονοστοιχείων31. Σε κάθε 

μία θέση της τελικής εικόνας τοποθετείται η ένταση των εικονοστοιχείων του ενός ή 

του άλλου δακτυλικού αποτυπώματος ως εξής. Διαιρείται η τρέχουσα θέση με τη 

διάσταση του παραθύρου, w. Αν Π είναι το πηλίκο και Y είναι το υπόλοιπο της 

πράξης, διακρίνονται οι περιπτώσεις:  

• Μονή γραμμή: Αν το πηλίκο είναι μονός αριθμός,  ισχύει Ι = Ι1, 

διαφορετικά    Ι = Ι2. 

• Ζυγή γραμμή: Αν το πηλίκο είναι μονός αριθμός, ισχύει Ι = Ι2, 

διαφορετικά       Ι = Ι1. 

Συνεπώς, αποφαίνεται αν η τρέχουσα θέση βρίσκεται μέσα στο «μαύρο» ή  

«λευκό» τμήμα και έτσι στη νέα εικόνα τοποθετείται η ένταση εικονοστοιχείου του 

ενός ή του άλλου αποτυπώματος. 

4.3.2 Κριτήριο Σύγκρισης Διαφορών 

Αφού έχει γίνει η ευθυγράμμιση των εικόνων δακτυλικών αποτυπωμάτων, 

σαρώνονται και οι δύο εικόνες και προκύπτει μία νέα με εντάσεις που προκύπτουν 

από την παρακάτω σχέση: 

 

όπου Ι1, Ι2, Ι, είναι η εικόνες αναφοράς, τρέχουσα ευθυγραμμισμένη και νέα, 

αντίστοιχα. Τα Ν1 και Ν2 είναι γραμμές και οι στήλες της εικόνας, αντίστοιχα. 

Συνεπώς, βάσει της παραπάνω εξίσωσης (1), η κάθε ένταση της καινούριας εικόνας 

είναι αποτέλεσμα της απόλυτης τιμής των διαφορών των εντάσεων των εικόνων που 

εισάγονται στο σύστημα. Χαρακτηριστικό παράδειγμα του κριτηρίου Σύγκρισης 

Διαφορών παρουσιάζεται στο Σχήμα 4.4. Στην περίπτωση που η ευθυγράμμιση είναι 

                                                           
31 Στο παρόντα αλγόριθμο το παράθυρο w x w = 21 x 21 εικονοστοιχεία.  
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επιτυχής, αναμένεται η νέα εικόνα που προκύπτει να είναι σχεδόν μία μαύρη εικόνα, 

δηλαδή εικόνα με μηδενικά εντάσεις εικονοστοιχείων. 

 

 

  

(a) (b) 

Σχήμα 4.4 Εικόνα Σύγκρισης Διαφορών σε (a) επιτυχής ευθυγράμμιση (b) 

αποτυχία ευθυγράμμισης. 

 

4.3.3 Κριτήριο διαφάνειας32 

Στο  κριτήριο Διαφάνειας οι δύο εικόνες, αναφοράς και ευθυγραμμισμένης 

τρέχουσας, εφαρμόζονται η μία πάνω στην άλλη με διαφορετική ένταση σύμφωνα με 

την πιο κάτω σχέση: 

 

 

                                                           
32 Στην αγγλική βιβλιογραφία αναφέρεται ως transparency. 

Με σχόλια [GM21]: Τι καλά βρε βασίλη? Εγώ θα περίμενα να 
είναι σχεδόν 0 ? Τι γίνεται? 
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όπου Ι1, Ι2, Ι, είναι η εικόνες αναφοράς, τρέχουσα και νέα αντίστοιχα. Τα Ν1 και Ν2 

είναι οι γραμμές και στήλες της εικόνας, αντίστοιχα, ενώ το k είναι ο συντελεστής 

βαρύτητας που εφαρμόζεται στις δύο εικόνες ώστε όσο αυξάνεται η ένταση της μιας 

τόσο να μειώνεται η ένταση της άλλης. Με τον τρόπο αυτό, δημιουργείται η αίσθηση 

της διαφάνειας της μιας εικόνας στην άλλη, όπως φαίνεται στο Σχήμα 4.5. Είναι 

λογικό πως αν δύο δακτυλικά αποτυπώματα είναι καλά ευθυγραμμισμένα δεν θα 

παρατηρείται καμία αλλαγή στην νέα εικόνα που προκύπτει.    

 

Σχήμα 4.5 Εικόνα Διαφάνειας 

 

4.4 Κριτήρια ποσοτικών αποτελεσμάτων 

Σε αντίθεση με τα ποιοτικά αποτελέσματα της ενότητας 4.3 που έχουν να 

κάνουν με σύγκριση εικόνων, εδώ συγκρίνονται ποσοτικά στοιχεία που προέρχονται 

από την ευθυγράμμιση δύο εικόνων δακτυλικών αποτυπωμάτων. Για την ανάλυση 

και την ποσοτική αξιολόγηση των μετασχηματισμών, χρησιμοποιείται το Κριτήριο 

της Απόκλισης ενώ για τα πραγματικά δεδομένα χρησιμοποιείται το κριτήριο της 

Μέσης Απόστασης Ακμών.   

 

4.4.1 Κριτήριο Απόκλισης 

Το κριτήριο αυτό χρησιμοποιείται στην περίπτωση επιλογής του 

καταλληλότερου εκ των τριών μετασχηματισμών σε σύγκριση. Συγκεκριμένα, γίνεται 
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επιλογή μιας και μόνο τυχαίας εικόνας δακτυλικού αποτυπώματος ως εικόνας 

αναφοράς. Η τρέχουσα εικόνα προκύπτει από το μετασχηματισμό της εικόνας 

αναφοράς κατά ένα γνωστό μετασχηματισμό, ήτοι  (Δx, Δy, Δθ). Με τον τρόπο αυτό 

θα  διαπιστωθεί ποιος εκ των τριών μετασχηματισμών «επιστρέφει» την τρέχουσα 

εικόνα στην αρχική της θέση. Με χρήση της σχέσης: 

 

όπου το Α είναι η απόκλιση της τρέχουσας τιμής Ιτρέχον από την ιδεατή τιμή Ιideal. Ένα 

παράδειγμα παρουσιάζεται παρακάτω.  

Στον Πίνακα 2 φαίνονται, ο μετασχηματισμός μιας εικόνας κατά Δx = 3,  Δy 

= 0 και Δθ  = 0 και τα αποτελέσματα που έδωσαν οι τρεις μετασχηματισμοί.  

 

Ιδεατά Συμπαγής 

Δx Δy Δθ Δx Δy Δθ 

3 0 0 -2,61420 -0,36618 -0,03414 

 

Ομοιότητας 

Δx Δy Δθ 

-3,00271 0,00081 -0,00023 

Ομοπαραλληλικός 

Δx Δy Δθ 

-3,00068 0,00197 0,22335 

Πίνακας 2 Αποτελέσματα με βάση γνωστό μετασχηματισμό 

 

Ακολούθως αν γίνει χρήση της Εξίσωσης 3 στα στοιχεία του  Πίνακα 2 

προκύπτει ο Πίνακας 3: 
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Ιδεατά Συμπαγής 

Δx Δy Δθ ΑΔx ΑΔy ΑΔθ 

3 0 0 0,38580 0,36618 0,03414 

               Ομοιότητας 

ΑΔx ΑΔy ΑΔθ 

-0,00271 -0,00081 -0,00023 

Ομοπαραλληλικός 

ΑΔy ΑΔθ ΑΔx 

0,00068 0,00197 0,22335 

Πίνακας 3 Πίνακας αποκλίσεων από την ιδεατή τιμή για κάθε μετασχηματισμό 

Ενδεικτικά φαίνεται στο εν λόγω παράδειγμα ότι ο μετασχηματισμός ομοιότητας 

προσεγγίζει καλύτερα την ιδεατή μεταβολή. 

4.4.2 Κριτήριο Μέσης Απόστασης Ακμών 

 Για την ποσοτική σύγκριση των αποτελεσμάτων με χρήση των δύο 

επιλεχθέντων κριτηρίων ομοιότητας, (Αμοιβαίας Πληροφορίας ή Συσχέτισης) 

χρησιμοποιείται ένα ανεξάρτητο κριτήριο. Η χρήση του κριτηρίου είναι απαραίτητη 

γιατί μία ενδεχόμενη σύγκριση απευθείας στις τιμές των συντελεστών ομοιότητας δεν 

θα ήταν αντικειμενική.  

Το κριτήριο είναι ως εξής: 

Α) Βρίσκουμε τις ακμές των εικόνων αναφοράς ΕΑ και της 

μετασχηματισμένης εικόνας ΕΒ με εφαρμογή ενός τελεστή, π.χ κατά Sobel. 

Β) Βρίσκουμε το Χάρτη Αποστάσεων από τις ακμές στην εικόνα αναφοράς, 

DM. 

Γ) Υπολογισμός της μέσης τιμής του Χάρτη Αποστάσεων για όλα τα σημεία 

(x,y) που ανήκουν στις ακμές της μετασχηματισμένης εικόνας. 

                                   ( )
( ) ( ), : , 0

1
,

Bx y E x y

DM x y
N 

     (4)                                                 
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όπου Ν είναι το πλήθος μη μηδενικών τιμών των εικόνων της ΕΒ. O μέσος όρος των 

τιμών του παραπάνω κριτηρίου υπολογίζεται με χρήση του συντελεστή Αμοιβαίας 

Πληροφορίας και με χρήση του συντελεστή Συσχέτισης. Ο μικρότερος εκ των δύο 

μέσων τιμών καταδεικνύει και τον καταλληλότερο συντελεστή ομοιότητας.    

4.5 Ποιοτικά αποτελέσματα  

Με βάση τα κριτήρια που παρουσιάστηκαν στην Ενότητα 4.3, ακολουθεί η 

παρουσίαση των ποιοτικών αποτελεσμάτων καθώς και ο σχολιασμός τους. 

4.5.1 Ποιοτικά αποτελέσματα στην περίπτωση εικόνων γνωστού 

μετασχηματισμού 

Η εικόνα αναφοράς στην περίπτωση αυτή μετασχηματίζεται κατά Δx = 5, Δy 

= 3, Δθ = 3 (βλ Σχήμα 4.6), οπότε προκεύπτει η τρέχουσα εικόνα με χρήση του 

Συντελεστή Συσχέτισης στο διάστημα διακριτικοποίησης 0 – π/2 και με βάση το 

κριτήριο της Σύγκρισης Διαφορών. Διακρίνουμε τις παρακάτω περιπτώσεις: 

1. Κριτήριο Σύγκρισης Διαφόρων στον Συμπαγή μετασχηματισμό  

 

Σχήμα 4.6 Κριτήριο Σύγκρισης Διαφόρων με χρήση Συμπαγή μετασχηματισμό 
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2. Κριτήριο Σύγκρισης Διαφόρων στον μετασχηματισμό Ομοιότητας 

 

Σχήμα 4.7 Κριτήριο Σύγκρισης Διαφόρων με χρήση μετασχηματισμό 

Ομοιότητας 

 

3. Κριτήριο Σύγκρισης Διαφόρων στον Ομοπαραλληλικό μετασχηματισμό  

 

Σχήμα 4.8 Κριτήριο Σύγκρισης Διαφόρων με χρήση Ομοπαραλληλικό 

μετασχηματισμό 
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Από τις παραπάνω εικόνες παρατηρείται πως γενικά και οι τρεις 

μετασχηματισμοί  δίνουν ικανοποιητικά αποτελέσματα. Άρα ο ποιοτικός τρόπος για 

την επιλογή του κατάλληλου μετασχηματισμού δεν δίνει κάποιο καθαρό αποτέλεσμα, 

σε αντίθεση με τα ποσοτικά αποτελέσματα που θα ακολουθήσουν. 

4.5.2 Ποιοτικά αποτελέσματα στην περίπτωση πραγματικών δεδομένων 

Στην περίπτωση πραγματικών δεδομένων, επιλέγεται ένα δακτυλικό 

αποτύπωμα ενός ατόμου, ως εικόνα αναφοράς. Έπειτα, η εικόνα αναφοράς 

συγκρίνεται διαδοχικά με διαφορετικές λήψεις του ίδιου, με αποτυπώματα άλλων 

δακτύλων του ίδιου ατόμου και τέλος με αποτυπώματα διαφορετικών ατόμων. Στα 

πραγματικά δεδομένα, χρησιμοποιείται ο ομοπαραλληλικός μετασχηματισμός και με 

τα δύο κριτήρια ομοιότητας. Ακολουθούν τα ποιοτικά αποτελέσματα κατά 

περίπτωση: 

1. Σύγκριση αποτυπώματος αναφοράς με διαφορετική λήψη του ίδιου 

αποτυπώματος.  

  

(α) (b) 

Σχήμα 4.9 (a) Κριτήριο Σκακιέρας (b) Κριτήριο Διαφάνειας στο ίδιο δάκτυλο με 

διαφορετικές λήψεις με χρήση συντελεστή Αμοιβαίας Πληροφορίας   
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(α) (b) 

Σχήμα 4.10 (a) Κριτήριο Σκακιέρας (b) Κριτήριο Διαφάνειας στο ίδιο δάκτυλο 

με διαφορετικές λήψεις με χρήση συντελεστή Συσχέτισης   

2. Σύγκριση αποτυπώματος αναφοράς με αποτύπωμα διαφορετικού δακτύλου του 

ίδιου ατόμου 

  

(α) (b) 

Σχήμα 4.11 (a) Κριτήριο Σκακιέρας (b) Κριτήριο Διαφάνειας σε αποτυπώματα 

με διαφορετικές λήψεις με χρήση συντελεστή Αμοιβαίας Πληροφορίας   
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(α) (b) 

Σχήμα 4.12 (a) Κριτήριο Σκακιέρας (b) Κριτήριο Διαφάνειας σε αποτυπώματα 

με διαφορετικές λήψεις με χρήση συντελεστή Συσχέτισης 

3. Σύγκριση αποτυπώματος αναφοράς με αποτύπωμα διαφορετικού ατόμου 

  

(α) (b) 

Σχήμα 4.13 (a) Κριτήριο Σκακιέρας (b) Κριτήριο Διαφάνειας σε αποτυπώματα 

διαφορετικών ατόμων με χρήση συντελεστή Αμοιβαίας Πληροφορίας   
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(α) (b) 

Σχήμα 4.14 (a) Κριτήριο Σκακιέρας (b) Κριτήριο Διαφάνειας σε αποτυπώματα 

διαφορετικών ατόμων με χρήση συντελεστή Συσχέτισης 

 

Σε όλες τις πιο πάνω περιπτώσεις διαφαίνεται καθαρά πως τα ποιοτικά 

αποτελέσματα είναι απολύτως λογικά. Στην περίπτωση του ίδιου δακτυλικού 

αποτυπώματος, με διαφορετικές λήψεις, τόσο με βάση το κριτήριο της Αμοιβαίας 

Πληροφορίας, όσο και του Συντελεστή Συσχέτισης, η ευθυγράμμιση έχει επιτευχθεί 

σε ικανοποιητικό βαθμό. Στον αντίποδα, στις περιπτώσεις όπου συγκρίθηκαν 

διαφορετικά δακτυλικά αποτυπώματα, οι εικόνες του κριτηρίου Σκακιέρας και 

Διαφάνειας είναι χαρακτηριστικές. Από τα ποιοτικά αποτελέσματα παρατηρείται πως 

γενικά και οι δύο συντελεστές ομοιότητας ευθυγραμμίζουν καλά τις δύο εικόνες 

δακτυλικών αποτυπωμάτων. Οπότε για να διαπιστωθούν ενδεχόμενες διαφορές που 

ενδέχεται να υπάρξουν ως προς την απόδοση τους θα γίνει έλεγχος των ποσοτικών 

αποτελεσμάτων. 
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4.6 Ποσοτικά αποτελέσματα 

Η ανάλυση των ποσοτικών αποτελεσμάτων θεωρείται αναγκαία προκειμένου 

να: α) διαπιστωθεί ποιος από τους μετασχηματισμούς είναι καταλληλότερος κατά τη 

σύγκριση δεδομένων γνωστών μετασχηματισμών και β) να διαπιστωθεί ποιο κριτήριο 

ομοιότητας δίνει καλύτερα αποτελέσματα κατά τη σύγκριση πραγματικών δεδομένων 

δακτυλικών αποτυπωμάτων. 

4.6.1 Ποσοτικά αποτελέσματα για την επιλογή καταλληλότερου 

μετασχηματισμού 

Από την περίπτωση των ποιοτικών αποτελεσμάτων που παρουσιάστηκε στην 

παράγραφο 4.5.1, δεν ήταν εμφανές κάποιο χαρακτηριστικό συμπέρασμα για την 

επιλογή του καταλληλότερου μετασχηματισμού. Με βάση τη θεωρητική προσέγγιση 

της παραγράφου 4.4.1, ακολουθείται η παρακάτω διαδικασία για την εξαγωγή των 

αποτελεσμάτων. 

Αρχικά επιλέγεται ένα τυχαίο δακτυλικό αποτύπωμα ως εικόνα αναφοράς. 

Αυτή η εικόνα μετασχηματίζεται κατά γνωστό (Δx,Δy,Δθ) με διάφορους τρόπους. 

Στον πίνακα 4.3 φαίνονται τα αποτελέσματα μετά την εφαρμογή του αλγορίθμου για 

διάφορους μετασχηματισμούς με χρήση του συντελεστή Αμοιβαίας Πληροφορίας. 
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Γνωστός 

Μετασχηματισμός 
Συμπαγής Μετασχηματισμός 

1 0 0 -0,60576 -0,41306 -0,04419 

2 0 0 -1,69344 -0,57262 -0,11039 

3 0 0 -2,61420 -0,36618 -0,03414 

4 0 0 -3,95039 -0,77508 -0,07120 

5 0 0 -4,89559 -0,38943 -0,03774 

6 0 0 -5,91310 -0,58809 -0,06479 

7 0 0 -6,89838 -0,58174 -0,03694 

8 0 0 -7,75830 -0,43135 -0,08761 

9 0 0 -8,98406 -0,93649 -0,02275 

10 0 0 -9,71295 -0,55037 -0,10382 

0 1 0 0,00000 0,00000 0,00000 

0 2 0 0,19987 1,60020 -0,00138 

0 3 0 0,36578 2,59427 -0,04268 

0 4 0 0,26758 3,55633 -0,02697 

0 5 0 0,00000 4,23732 0,00000 

0 6 0 0,00000 5,23758 0,00000 

0 7 0 0,00000 6,61331 0,00000 

0 8 0 0,00000 7,70516 0,00000 

0 9 0 0,00000 8,44094 0,00000 

0 10 0 0,24860 9,48404 -0,09573 

0 0 1 -0,15480 0,06624 -1,00065 

0 0 2 0,14447 -0,24125 -2,00346 

0 0 3 0,18353 -0,23034 -2,98542 

0 0 4 0,21039 -0,27168 -3,97247 

0 0 5 0,20057 -0,24884 -4,97966 

5 3 3 -4,94914 2,49708 -3,02548 

10 3 3 -9,98409 2,19559 -2,99578 

Πίνακας 4 Ποσοτικά αποτελέσματα με χρήση του Συμπαγούς μετασχηματισμού 
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Γνωστός 

Μετασχηματισμός 

Μετασχηματισμός Ομοιότητας 

1 0 0 -1,00511 -0,00192 0,03836 

2 0 0 -2,00557 -0,01723 0,14159 

3 0 0 -2,27223 -0,00096 -0,08888 

4 0 0 -3,99786 -0,56993 0,80394 

5 0 0 -4,99936 0,00206 0,32181 

6 0 0 -5,99704 -0,79417 0,35490 

7 0 0 -6,99854 -0,47340 0,81418 

8 0 0 -7,99871 -0,92995 0,73589 

9 0 0 -9,00212 -0,49296 0,35511 

10 0 0 -10,00191 -0,03653 -1,41721 

0 1 0 -0,00066 0,16226 0,17472 

0 2 0 -0,00043 2,00022 -0,19021 

0 3 0 -0,00055 2,99916 -0,19906 

0 4 0 -0,00086 3,99960 -0,58739 

0 5 0 -0,00202 5,00028 -0,59040 

0 6 0 -0,00473 5,18763 -0,41557 

0 7 0 -0,00333 6,99934 -0,15443 

0 8 0 0,00287 7,99941 0,25039 

0 9 0 0,00127 9,00010 0,03068 

0 10 0 -0,00549 10,00008 -0,19895 

0 0 1 0,00384 -0,14535 0,96904 

0 0 2 0,00089 -0,11240 1,96484 

0 0 3 -0,01531 -0,09820 2,99251 

0 0 4 -0,07280 -0,03073 3,99210 

0 0 5 -0,00956 -0,00368 4,97833 

5 3 3 -5,19059 2,61662 3,58636 

10 3 3 -10,21508 2,31684 3,79984 

Πίνακας 5 Ποσοτικά αποτελέσματα με χρήση του μετασχηματισμού Ομοιότητας 
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Γνωστός 

Μετασχηματισμός 

Ομοπαραλληλικός 

Μετασχηματισμός 

1 0 0 -1,00511 -0,00192 0,03836 

2 0 0 -2,00557 -0,01723 0,14159 

3 0 0 -2,27223 -0,00096 -0,08888 

4 0 0 -3,99786 -0,56993 0,80394 

5 0 0 -4,99936 0,00206 0,32181 

6 0 0 -5,99704 -0,79417 0,35490 

7 0 0 -6,99854 -0,47340 0,81418 

8 0 0 -7,99871 -0,92995 0,73589 

9 0 0 -9,00212 -0,49296 0,35511 

10 0 0 -10,00191 -0,03653 -1,41721 

0 1 0 -0,00066 0,16226 0,17472 

0 2 0 -0,00043 2,00022 -0,19021 

0 3 0 -0,00055 2,99916 -0,19906 

0 4 0 -0,00086 3,99960 -0,58739 

0 5 0 -0,00202 5,00028 -0,59040 

0 6 0 -0,00473 5,18763 -0,41557 

0 7 0 -0,00333 6,99934 -0,15443 

0 8 0 0,00287 7,99941 0,25039 

0 9 0 0,00127 9,00010 0,03068 

0 10 0 -0,00549 10,00008 -0,19895 

0 0 1 0,00384 -0,14535 0,96904 

0 0 2 0,00089 -0,11240 1,96484 

0 0 3 -0,01531 -0,09820 2,99251 

0 0 4 -0,07280 -0,03073 3,99210 

0 0 5 -0,00956 -0,00368 4,97833 

5 3 3 -5,19059 2,61662 3,58636 

10 3 3 -10,21508 2,31684 3,79984 

Πίνακας 6 Ποσοτικά αποτελέσματα με χρήση του ομοπαραλληλικού 

μετασχηματισμού 
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Στη συνέχεια εφαρμόζεται η Εξίσωση 3 για να υπολογιστεί η απόκλιση κάθε 

μιας από τις τιμές των Πινάκων 4, 5, 6, σε σχέση με την αντίστοιχη ιδεατή τιμή. Όσο 

μικρότερη η απόκλιση, τόσο καλύτερη  η ευθυγράμμιση του δακτυλικού 

αποτυπώματος. Τα αποτελέσματα παρουσιάζονται συγκεντρωτικά στον παρακάτω 

πίνακα. 

Συμπαγής  Ομοιότητας  Ομοπαραλληλικός 

Αx Ay Aθ Αx Ay Aθ Αx Ay Aθ 

0,39424 0,41306 0,04419 0,40716 0,47454 0,05802 0,00511 0,00192 0,03836 

0,30656 0,57262 0,11039 0,00208 0,00042 0,00021 0,00557 0,01723 0,14159 

0,38580 0,36618 0,03414 0,00271 0,00081 0,00023 0,72777 0,00096 0,08888 

0,04961 0,77508 0,07120 0,00028 0,00001 0,00106 0,00214 0,56993 0,80394 

0,10441 0,38943 0,03774 0,00092 0,00005 0,00092 0,00064 0,00206 0,32181 

0,08690 0,58809 0,06479 0,00039 0,00016 0,00033 0,00296 0,79417 0,35490 

0,10162 0,58174 0,03694 0,00016 0,00016 0,00111 0,00146 0,47340 0,81418 

0,24170 0,43135 0,08761 0,27544 0,77694 0,05795 0,00129 0,92995 0,73589 

0,01594 0,93649 0,02275 0,00005 0,00237 0,00017 0,00212 0,49296 0,35511 

0,28705 0,55037 0,10382 0,00154 0,00097 0,00016 0,00191 0,03653 1,41721 

0,00000 1,00000 0,00000 0,76425 0,61789 0,01020 0,00066 0,83774 0,17472 

0,19987 0,39980 0,00138 0,41199 0,47471 0,00469 0,00043 0,00022 0,19021 

0,36578 0,40573 0,04268 0,00020 0,00013 0,00012 0,00055 0,00084 0,19906 

0,26758 0,44367 0,02697 0,00073 0,00174 0,00032 0,00086 0,00040 0,58739 

0,00000 0,76268 0,00000 0,34876 0,76305 0,08060 0,00202 0,00028 0,59040 

0,00000 0,76242 0,00000 0,38249 0,76243 0,04195 0,00473 0,81237 0,41557 

0,00000 0,38669 0,00000 0,00058 0,00024 0,00031 0,00333 0,00066 0,15443 

0,00000 0,29484 0,00000 0,00009 0,79772 0,00013 0,00287 0,00059 0,25039 

0,00000 0,55906 0,00000 0,00236 0,00331 0,00000 0,00127 0,00010 0,03068 

0,24860 0,51596 0,09573 0,00074 0,00132 0,00004 0,00549 0,00008 0,19895 

0,15480 0,06624 0,00065 0,00154 0,13645 0,03277 0,00384 0,14535 0,03096 

0,14447 0,24125 0,00346 0,04732 0,11327 0,00301 0,00089 0,11240 0,03516 

0,18353 0,23034 0,01458 0,01735 0,06439 0,02719 0,01531 0,09820 0,00749 

0,21039 0,27168 0,02753 0,02814 0,06952 0,05580 0,07280 0,03073 0,00790 

0,20057 0,24884 0,02034 0,00414 0,09791 0,04952 0,00956 0,00368 0,02167 

0,05086 0,50292 0,02548 0,13721 0,34935 0,03614 0,19059 0,38338 0,58636 

0,01591 0,80441 0,00422 0,18602 0,59254 0,01151 0,21508 0,68316 0,79984 

Πίνακας 7 Αποκλίσεις από τις ιδεατές τιμές κατά την εφαρμογή του τριών 

μετασχηματισμών 

Με σχόλια [GM22]: Γιατί bold? 

Με σχόλια [GM23]: Μήπως να βάλουμε και τις ιδεατές 
αποκλίσεις για σύγκριση 
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Εν συνεχεία, παρουσιάζονται οι γραφικές παραστάσεις για τις αποκλίσεις σε 

κάθε μία διεύθυνση (Δx, Δy, Δθ). 

 

Σχήμα 4.15 Γραφική παράσταση αποκλίσεων κατά Δx μετατοπίσεις. 

 

 

Σχήμα 4.16 Γραφική παράσταση αποκλίσεων κατά Δy μετατοπίσεις. 
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Σχήμα 4.17 Γραφική παράσταση αποκλίσεων κατά Δθ περιστροφές 

Παρατηρώντας τους παραπάνω πίνακες των αποκλίσεων και τις γραφικές 

παραστάσεις που πηγάζουν από αυτούς στις περιοχές ενδιαφέροντος, διαπιστώνουμε 

πως ο ομοπαραλληλικός μετασχηματισμός είναι ο καταλληλότερος για την 

ευθυγράμμιση των δακτυλικών αποτυπωμάτων μιας και δίνει καλύτερες προσεγγίσεις 

στις τιμές των γνωστών ιδεατών μετασχηματισμών. Συνεπώς, ο συγκεκριμένος 

μετασχηματισμός θα χρησιμοποιηθεί κατά την εφαρμογή της μεθοδολογίας στη 

συνέχεια  στα πραγματικά δεδομένα.  

Τέλος το σημείο αυτό εξετάζεται η επιλογή της τιμής διακριτικοποίησης 

(Τδιακρ) που αναφέρθηκε στο Κεφάλαιο 3. Σε αυτό υιοθετήθηκε η τιμή Τδιακρ = 255 ως 

η βέλτιστη. Για την απόδειξη της ορθότητας του ισχυρισμού επιλέχθηκαν δύο τυχαία 

δακτυλικά αποτυπώματα. Αυτά συγκρίθηκαν με χρήση του ομοπαραλληλικού 

μετασχηματισμού για διάφορες τιμές διακριτικοποίησης και κατεγράφησαν οι τιμές 

του συντελεστή Συσχέτισης. Στο Σχήμα 4.18 φαίνεται το γράφημα των τιμών που 

προέκυψαν. 

Με σχόλια [GM24]: Γιατί? Affine θα πρέπει!!!!!!! 

Με σχόλια [GM25]: Θα προτιμούσα και πάλι το Mutual, όπως 
και στα προηγούμενα. Αλλά δεν με πειράζει πολύ!! 
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Σχήμα 4.18 Γράφημα. Άξονας Χ : Τιμές διακριτικοποίσης Άξονας Y: Τιμές 

Συσχέτισης 

Από το παραπάνω γράφημα προκύπτει το συμπέρασμα πως ορθώς επιλέχθηκε η τιμή 

255 καθώς αντιστοιχεί  στη βέλτιστη τιμή του συντελεστή συσχέτισης. Για να γίνει 

μία πιο εμπεριστατωμένη προσέγγιση, θα πρέπει να συγκριθούν δεκάδες ζεύξη ίδιων 

ή διαφορετικών αποτυπωμάτων καθώς και να πραγματοποιηθούν μετρήσεις με βάση 

το κριτήριο της απόκλισης σε ένα τυχαίο αποτύπωμα μετασχηματισμένο κατά γνωστό 

μετασχηματισμό. Αυτή η διαδικασία βέβαια ξεφεύγει από τα πλαίσια της παρούσας 

διπλωματικής εργασίας και δεδομένου πως οι αποκλίσεις είναι μικρές, συμπεραίνεται 

πως η τιμή Tδιακρ-= 255 είναι μία ασφαλής τιμή για την εξαγωγή σωστών 

αποτελεσμάτων. 

 

4.6.2 Ποσοτικά αποτελέσματα σε πραγματικά δεδομένα.  

 Το σύνολο δειγματοληψίας αποτελείται από εικόνες με διαστάσεις 480 x 504 

εικονοστοιχεία. Αυτό διαρθρώνεται ως εξής : 

•  Τρία διαφορετικά άτομα 

• Τρία δάκτυλα ανά άτομο 

• Οκτώ διαφορετικές λήψεις κάθε δάκτυλο 
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Άρα συνολικά το σύνολο δειγματοληψίας αποτελείται από 72 εικόνες δακτυλικών 

αποτυπωμάτων. Στη συνέχεια το σύνολο αυτό χωρίζεται σε δύο υποσύνολα. Το ένα, 

έστω σύνολο Α, αποτελείται από 63 ζεύγη ίδιων δακτυλικών αποτυπωμάτων, ενώ το 

άλλο, έστω σύνολο Β, από 63 ζεύγη διαφορετικών δακτυλικών αποτυπωμάτων. Η 

διαδικασία για την εξαγωγή των αποτελεσμάτων είναι η εξής. Μέσω της διεπαφής 

που αναπτύχθηκε στα πλαίσια της διπλωματικής εργασίας, αρχικά συγκρίθηκαν τα 63 

ζεύγη του συνόλου Α. Οι συγκρίσεις πραγματοποιήθηκαν και με τους δύο 

συντελεστές ομοιότητας, δηλαδή Αμοιβαίας Πληροφορίας και Συσχέτισης. Για κάθε 

ένα ζεύγος δακτυλικών αποτυπωμάτων καταγράφηκε η τιμή των συντελεστών 

ομοιότητας καθώς και το κριτήριο μέση απόστασης ακμών - ΜΟΜ (εξίσωση (4)) που 

αναλύθηκε στην παράγραφο  4.4.2.  

Ενδεικτικά, στο Πίνακα 8 παρουσιάζεται ένα μέρος των αποτελεσμάτων για το 

Σύνολο Α. Σε αυτόν απεικονίζονται τα αποτελέσματα της σύγκρισης των ζευγών ενός 

ατόμου και στα τρία του δάκτυλα. Επίσης διακρίνονται οι στήλες με τις τιμές του 

συντελεστή Αμοιβαίας Πληροφορίας (ΜΙ), του συντελεστή Συσχέτισης (CC) και του 

κριτηρίου ΜΟΜ. Τα δάκτυλα αποτυπώματα αναφοράς είναι τα «Δάκτυλο 1_1», 

«Δάκτυλο 2_1» και «Δάκτυλο 3_1».  
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Άτομο 1     

Δάκτυλο 1_1 ΜΙ CC MOM-MI MOM-CC 

1_2 0,38303 0,95944 1,70484 1,39509 

1_3 0,36300 0,95251 2,84368 2,07566 

1_4 0,33633 0,96011 1,83221 1,73437 

1_5 0,35695 0,95972 4,53412 3,33372 

1_6 0,36653 0,96848 2,05136 2,06315 

1_7 0,35979 0,95765 2,29457 2,64548 

1_8 0,34918 0,95477 1,44670 1,63794 

Δάκτυλο 2_1 ΜΙ CC MOM-MI MOM-CC 

2_2 0,37716 0,94562 1,86956 1,79691 

2_3 0,40380 0,94753 1,49373 1,14209 

2_4 0,38770 0,94056 1,72132 1,54871 

2_5 0,40173 0,95830 1,56684 1,37310 

2_6 0,39063 0,94184 1,57763 1,69776 

2_7 0,35467 0,94550 1,87535 2,00945 

2_8 0,37948 0,96289 1,91983 1,92888 

Δάκτυλο 3_1 ΜΙ CC MOM-MI MOM-CC 

3_2 0,37082 0,95044 3,25492 2,62642 

3_3 0,38370 0,94951 3,90065 3,86683 

3_4 0,34486 0,94019 3,12627 3,06850 

3_5 0,38473 0,94507 3,83833 2,67037 

3_6 0,39610 0,95686 1,93418 1,97924 

3_7 0,40153 0,94850 2,28906 2,42816 

3_8 0,32963 0,95499 1,92636 1,92370 

Πίνακας 8 Παράδειγμα αποτελεσμάτων του Συνόλου Α για ένα άτομο. 

 

 

Έχοντας συγκεντρωθεί όλα τα αποτελέσματα και για τα τρία άτομα, υπολογίζονται η 

μέση τιμή του κριτηρίου ΜΟΜ για κάθε συντελεστή ομοιότητας (βλ Πίνακα 9).  
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Σύνολο Α MOM-MI MOM-

CC 

Μέσος 

Όρος 
2,21781 2,31890 

Πίνακας 9 Μέσοι όροι ανεξάρτητου κριτηρίου ΜΟΜ για τους δύο συντελεστές 

ομοιότητας στο σύνολο Α. 

Στον Πίνακα 9  δεν παρατηρείται κάποια διαφορά των δύο συντελεστών όσων 

αφορά την επίδοση τους στην ευθυγράμμιση των εικόνων. Και οι δύο συντελεστές 

κατά την εφαρμογή τους στην σύγκριση ίδιων δακτυλικών αποτυπωμάτων 

λειτούργησαν εξίσου ικανοποιητικά. 

Το Σύνολο Β περιέχει 63 ζεύγη δακτυλικών αποτυπωμάτων που αποτελούνται 

από διαφορετικά δακτυλικά αποτυπώματα. Αυτά είναι μέλη και του Συνόλου 

δειγματοληψίας. Και πάλι η σύγκριση μεταξύ των ζευγών απέφερε τιμές για τους δύο 

συντελεστές ομοιότητας και για το κριτήριο ΜΟΜ (βλ Πίνακα 10). 

 

Σύνολο Β MOM-MI MOM-

CC 

Μέσος 

Όρος 

2,78534 3,72912 

 Πίνακας 10 Μέσοι όροι ανεξάρτητου κριτηρίου ΜΟΜ για τους δύο συντελεστές 

στο σύνολο Β. 

Στον παραπάνω πίνακα φαίνεται ξεκάθαρα πως το κριτήριο ομοιότητας του 

συντελεστή αμοιβαίας Πληροφορίας βελτιώνει την ευθυγράμμιση σε σχέση με το 

Συντελεστή Συσχέτισης. 

 Τέλος, υπολογίζονται οι μέσες τιμές των δύο συντελεστών ομοιότητας για τα 

δύο σύνολα καθώς και η διασπορά των τιμών αυτών. Τα αποτελέσματα φαίνονται 

στον Πίνακα 11 και 12. 
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 Μέση τιμή Συντελεστή Αμοιβαίας 

Πληροφορίας και Διασπορά 

Σύνολο Α ( 63 ζεύγη ίδιων 

αποτυπωμάτων) 
 

Σύνολο Β ( 63 ζεύγη Διαφορετικών 

αποτυπωμάτων) 
 

Πίνακας 11 Μέση τιμή και διασπορά τιμών συντελεστή Αμοιβαίας Πληροφορίας 

στα δύο σύνολα δειγματοληψίας 

 Μέση τιμή Συντελεστή Συσχέτισης 

και διασπορά 

Σύνολο Α ( 63 ζεύγη ίδιων 

αποτυπωμάτων) 
 

Σύνολο Β ( 63 ζεύγη Διαφορετικών 

αποτυπωμάτων) 
 

Πίνακας 12 Μέση τιμή και διασπορά τιμών συντελεστή Συσχέτισης στα δύο 

σύνολα δειγματοληψίας 

Από τα παραπάνω ποσοτικά αποτελέσματα, συμπεραίνουμε ότι και τα δύο κριτήρια 

παρέχουν τη δυνατότητα ταύτισης δακτυλικών αποτυπωμάτων. Αποτελέσματα σε 

περισσότερα δεδομένα θα πρέπει να γίνουν προκειμένου να εξαχθούν ασφαλή 

συμπεράσματα. 
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4.7 Σχόλια  

 Στο παρών Κεφάλαιο εξήχθησαν όλα τα απαραίτητα αποτελέσματα προς την 

κατεύθυνση της αξιολόγησης του αλγορίθμου που προτάθηκε στα πλαίσια της 

διπλωματικής εργασίας. Αρχικά, πραγματοποιήθηκε μία συνοπτική παρουσίαση των 

κριτηρίων που χρησιμοποιήθηκαν για την αξιολόγηση των αποτελεσμάτων. Το 

Κριτήριο Σκακιέρας, Σύγκρισης Διαφορών και Διαφάνειας για τα ποιοτικά 

αποτελέσματα (Εικόνες) και το κριτήριο Μέσης Απόστασης Ακμών (ΜΟΜ) για την 

αξιολόγηση των ποσοτικών αποτελεσμάτων.  

Σε κάθε κατηγορία αποτελεσμάτων (ποιοτικά ή ποσοτικά) παρουσιάστηκαν 

δύο κύρια προβλήματα αξιολόγησης. Το ένα ήταν η επιλογή του καταλληλότερου 

μετασχηματισμού εκ των τριών που χρησιμοποιήθηκαν (Συμπαγής, Ομοιότητας και 

Ομοπαραλληλικός) και το άλλο η επιλογή του καλύτερου εκ των δύο συντελεστών 

ομοιότητας (Συντελεστής Αμοιβαίας Πληροφορίας και Συντελεστής Συσχέτισης) με 

χρήση του κριτηρίου ΜΟΜ. Για την επιλογή του μετασχηματισμού, επιλέχτηκε ένα 

τυχαίο δακτυλικό αποτύπωμα το οποίο μετασχηματίστηκε με βάση 27 γνωστούς 

μετασχηματισμούς (Δx, Δy, Δθ). Διαπιστώθηκε, από τα ποιοτικά και ποσοτικά 

αποτελέσματα, πως ο καταλληλότερος μετασχηματισμός, δηλαδή αυτός που 

«επέστρεφε» την μικρότερη δυνατή απόκλιση από την αρχική θέση είναι ο 

ομοπαραλληλικός. Συνεπώς, ο μετασχηματισμός αυτός χρησιμοποιήθηκε στη 

συνέχεια και στα πραγματικά δεδομένα.  

Το σύνολο δειγματοληψίας των πραγματικών δεδομένων αποτελείται από δύο 

υποσύνολα. Ένα με ζεύγη ίδιων δακτυλικών αποτυπωμάτων με διαφορετικές λήψεις 

και ένα με διαφορετικά δακτυλικά αποτυπώματα. Τα ποσοτικά αποτελέσματα στα 

δύο σύνολα προέκυψαν από την διεπαφή που αναπτύχθηκε για το σκοπό αυτό. Οι 

τιμές των δύο συντελεστών, αν και κανονικοποιημένες στο διάστημα [0,1], δεν 

μπορούσαν να συγκριθούν άμεσα, οπότε χρησιμοποιήθηκε το ανεξάρτητο κριτήριο 

της μέσης απόστασης ακμών. Το τελευταίο έδειξε πως ο συντελεστής Αμοιβαίας 

Πληροφορίας είναι σχετικά αποδοτικότερος ως προς τον συντελεστή Συσχέτισης. 

Τέλος παρουσιάστηκαν οι μέσες τιμές και διασπορές των δύο συντελεστών βάσει των 

οποίων δεν υπήρξαν μεγάλες αποκλίσεις μεταξύ των δύο κριτηρίων ομοιότητας. Και 

τα δύο κριτήρια ομοιότητας ήταν ικανά να διαχωρίσουν τα γνήσια αποτυπώματα από 

τα μη-γνήσια, γεγονός που είναι πολύ ικανοποιητικό. Για πληρότητα, θα πρέπει τα 
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συγκεκριμένα κριτήρια να εφαρμοστούν σε ένα μεγαλύτερο δείγμα δεδομένων από το 

συγκεκριμένο που χρησιμοποιήθηκε για τους σκοπούς της διπλωματικής εργασίας 

προκειμένου να εξαχθούν ακριβή αποτελέσματα.   
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Κεφάλαιο 5 – Παρουσίαση της διεπαφής  

 

5.1 Εισαγωγή  

Στο Κεφάλαιο αυτό πραγματοποιείται η παρουσίαση της διεπαφής που 

αναπτύχθηκε με βάση τον αλγόριθμο του Κεφαλαίο 3. Η διεπαφή χρησιμοποιήθηκε 

για την πραγματοποίηση των μετρήσεων που παρουσιάστηκαν στο Κεφάλαιο 4 και 

στηρίχθηκε στην Borland C++ Builder v6.0. Συγκεκριμένα, παρουσιάζονται τα 

διάφορα τμήματα που αποτελούν το πρόγραμμα και έπειτα αναλύεται κάθε τμήμα 

καθώς και τα εργαλεία που το αποτελούν. Tέλος περιγράφονται τα βήματα που 

ακολουθήθηκαν για την εξαγωγή των ποιοτικών και ποσοτικών αποτελεσμάτων. 

5.2 Γενική παρουσίαση της διεπαφής. 

 Στο Σχήμα 5.1 φαίνεται η κυρία επιφάνεια εργασίας του προγράμματος.  

 

Σχήμα 5.1 Κύρια επιφάνεια εργασίας της διεπαφής 

Συγκεκριμένα, η επιφάνεια εργασίας αποτελείται από τα επόμενα τμήματα:  
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Τμήμα 1ο : Περιέχει τα βασικά μενού της διεπαφής τα οποία, χωρίζονται στα εξής 

1. File (Αρχείο) 

• File -> Open : Άνοιγμα της τρέχουσας εικόνας. 

• File -> Close : Έξοδος από την διεπαφή. 

2. Tools (Εργαλεία) 

• Tools -> Filters -> Average Filter : Εφαρμόζεται ένα φίλτρο μέσου 

όρου στην τρέχουσα εικόνα με σκοπό την απαλλαγή της από θόρυβο. 

• Tools -> Enhancement -> Normalization : Πραγματοποιείται η 

βελτίωση των εικόνων που  εισάγονται στο σύστημα όπως 

περιγράφεται στο Κεφάλαιο 3 στην παράγραφο 3.2.3.1  

• Tools -> Examination -> Chessboard :  Πραγματοποιείται το κριτήριο 

της Σκακιέρας όπως περιγράφεται στο Κεφάλαιο 4 στην παράγραφο 

4.2.1  

• Tools -> Examination -> Compare : Πραγματοποιείται το κριτήριο της 

Σύγκρισης Διαφορών όπως περιγράφεται στο Κεφάλαιο 4 στην 

παράγραφο 4.2.2 

• Tools -> Examination -> Difference : Δημιουργείται ένα αρχείο στην 

διαδρομή (C:\finger.txt) με στοιχεία τις διαφορές των γωνιών 

προσανατολισμού. 

• Tools -> Examination -> Transparency : Πραγματοποιείται το κριτήριο 

της Διαφάνειας όπως περιγράφεται στο Κεφάλαιο 4 στην παράγραφο 

4.2.3 

 

3. Options (Επιλογές) 
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• Option-> Parameters : Εμφανίζεται νέο παράθυρο με τις παραμέτρους 

για το μέγεθος RAW εικόνων, το μέγεθος παραθύρου και φίλτρου 

κατά τον υπολογισμού του πίνακα προσανατολισμού όπως 

περιγράφεται στο Κεφάλαιο 3 στην παράγραφο 3.2.3.2 

• Option -> Histogram : Εμφανίζει το παράθυρο του διπλού 

ιστογράμματος όπως περιγράφεται στο Κεφάλαιο 3. 

4. Help (Βοήθεια) 

• Help -> About : Γενικά στοιχεία της διεπαφής. 

Τμήμα 2ο : Το τμήμα αυτό περιέχει τα πλαίσια που απεικονίζονται οι δύο εικόνες. 

Στο δεξί μέρος εμφανίζεται η εικόνας αναφοράς ενώ στο αριστερό η τρέχουσα 

εικόνα. Επιπλέον περιλαμβάνεται  ένα χρονόμετρο το οποίο εμφανίζει το χρόνο από 

την στιγμή που ξεκινάει η αυτόματη ευθυγράμμιση μέχρι τη στιγμή που 

παρουσιάζεται το αποτέλεσμα αυτής. Τέλος κάτω από το δεξί πλαίσιο βρίσκεται ένα 

κουμπί για την εισαγωγή της εικόνας αναφοράς. 

Τμήμα 3ο: Εδώ περιλαμβάνεται ο χειροκίνητος μηχανισμός που επιτρέπει το 

μετασχηματισμό της εικόνας κατά Δx, Δy, Δθ καθώς και Sx, Sy. Ο μηχανισμός αυτός 

χρησιμοποιείται για τα θεωρητικά ποιοτικά και ποσοτικά αποτελέσματα που 

παρουσιάστηκαν στο Κεφάλαιο 4 με σκοπό την επιλογή του κατάλληλου 

μετασχηματισμού. 

Τμήμα 4ο : Στο τμήμα αυτό αποτυπώνονται τα αποτελέσματα του αλγορίθμου. 

Συγκεκριμένα, η τιμή Συντελεστή Ομοιότητας, ο μετασχηματισμός κατά Δx, Δy, Δθ 

με τον οποίο μετασχηματίζεται η τρέχουσα εικόνα, και τέλος ο αριθμό επαναλήψεων 

της μεθόδου Powell που απαιτούνται για την μεγιστοποίηση του συντελεστή 

ομοιότητας..  

Τμήμα 5ο : Σε αυτό το τμήμα βρίσκονται οι παράμετροι: 

• διαστήματος διακριτικοποίησης (-π/2 , π/2) ή (0, π/2)  

• εύρους διακρητικοποίσης (0 – 255) 

• συντελεστή ομοιότητας ( Συσχέτισης ή Αμοιβαίας Πληροφορίας) 
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•  τύπου μετασχηματισμού (Συμπαγής, Ομοιότητας, Ομοπαραλληλικός) 

Τέλος περιλαμβάνεται το κουμπί έναρξης του αλγορίθμου, “Start”. 

 

5.3 Παράδειγμα εφαρμογής  

Α. Η διαδικασία για τη εξαγωγή των ποσοτικών/ποιοτικών αποτελεσμάτων 

κατά τον προσδιορισμού του καταλληλότερου μετασχηματισμού ακολουθεί τα εξής 

βήματα : 

1. Load template : Άνοιγμα της εικόνας αναφοράς. 

2. File -> Open : Άνοιγμα της τρέχουσας εικόνας. 

3. Τμήμα 3ο : Επιλογή χειροκίνητου μετασχηματισμού στο τρέχον 

αποτύπωμα.  

4. Tools ->Enhancement-> Normalization: Βελτίωση των εικόνων 

δακτυλικών αποτυπωμάτων  

5. Options ->Parameters : Επιλογή παραμέτρων για τον υπολογισμό των 

πινάκων προσανατολισμού 

6.  Τμήμα 5ο : Επιλογή Τύπου Μετασχηματισμού, Διαστήματος 

Διακριτικοποίησης, Εύρους Διακριτικοποίησης και Συντελεστή 

Ομοιότητας. 

7. Τμήμα 5ο : Κουμπί έναρξης διαδικασίας. 

8. Τμήμα 4ο : Παρουσίαση ποσοτικών αποτελεσμάτων. 

9. Tools -> Examination : Εφαρμογή κριτηρίων για τα ποιοτικά 

αποτελέσματα.   

Β. Η διαδικασία για την εξαγωγή των ποσοτικών/ποιοτικών αποτελεσμάτων 

στα πραγματικά δεδομένα είναι η ακόλουθη: 

1. Load template : Άνοιγμα της εικόνας αναφοράς. 
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2.  File -> Open : Άνοιγμα της τρέχουσας εικόνας. 

3. Tools ->Enhancement-> Normalization: Βελτίωση των εικόνων 

δακτυλικών αποτυπωμάτων  

4. Options ->Parameters : Επιλογή παραμέτρων για τον υπολογισμό 

των πινάκων προσανατολισμού 

5. Τμήμα 5ο : Επιλογή Τύπου Μετασχηματισμού, Διαστήματος 

Διακριτικοποίησης,     Εύρους Διακριτικοποίησης και Συντελεστή 

Ομοιότητας. 

6. Τμήμα 5ο : Κουμπί έναρξης διαδικασίας. 

7. Τμήμα 4ο : Παρουσίαση ποσοτικών αποτελεσμάτων. 

8. Tools -> Examination : Εφαρμογή κριτηρίων για τα ποιοτικά 

αποτελέσματα. 

Ο επιστημονικός κώδικας στην γλώσσα προγραμματισμού C++ 

βρίσκεται στο παράρτημα Α.  
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Κεφάλαιο 6 – ΣΥΜΠΕΡΑΣΜΑΤΑ – ΜΕΛΛΟΝΤΙΚΕΣ ΕΠΕΚΤΑΣΕΙΣ 

6.1 Ανακεφαλαίωση  

Στο Πρώτο Κεφάλαιο παρουσιάστηκε ο σκοπός της διπλωματικής εργασίας 

και μία αναλυτική παρουσίαση στους βιομετρικούς παραμέτρους και συγκεκριμένα 

στα δακτυλικά αποτυπώματα ως στοιχεία για την αναγνώριση ή/και ταυτοποίησης 

ατόμων που απαιτείται για την πρόσβαση σε περιοχές ευαίσθητων δεδομένων. 

Παρουσιάστηκαν τα βασικά χαρακτηριστικά των δακτυλικών αποτυπωμάτων και τα 

σημαντικότερα προβλήματα προς την κατεύθυνση της αναγνώρισης και 

ευθυγράμμισης τους. 

Στο Δεύτερο Κεφάλαιο πραγματοποιήθηκε αναλυτική παρουσίαση των 

υπαρχόντων συστημάτων – τεχνικών προς την κατεύθυνση της αυτόματης 

αναγνώρισης δακτυλικών αποτυπωμάτων. Αναλυτικότερα, παρουσιάστηκαν οι 

βασικές περιοχές ενδιαφέροντος σε βάσεις δεδομένων δακτυλικών αποτυπωμάτων 

που χρησιμοποιούνται από διάφορους οργανισμούς ανά τον κόσμο και  περιγράφθηκε 

ο τρόπος αποτίμησης των υπαρχόντων συστημάτων αναγνώρισης δακτυλικών 

αποτυπωμάτων. Στη συνέχεια πραγματοποιήθηκε εκτενής βιβλιογραφική 

ανασκόπηση πρόσφατων τεχνικών από το χώρο της ψηφιακής επεξεργασίας εικόνων 

προς την κατεύθυνση της βελτίωσης  και της αυτόματης ευθυγράμμισης  εικόνων 

δακτυλικών αποτυπωμάτων. 

Στο Τρίτο Κεφάλαιο, πραγματοποιήθηκε αναλυτική παρουσίαση της 

μεθοδολογικής προσέγγισης που προτάθηκε στα πλαίσια της παρούσας διπλωματικής 

εργασίας. Συγκεκριμένα, παρουσιάστηκε το αναλυτικό διάγραμμα μεθοδολογίας  στο 

οποίο στηρίχθηκε η λεπτομερής ανάπτυξη του αλγορίθμου.  Στη συνέχεια, κάθε ένα 

τμήμα του, αναλύθηκε, τόσο σε μαθηματικό όσο και σε  τεχνικό επίπεδο. 

Αναφέρθηκαν διεξοδικά όλες οι πιθανές παράμετροι και ο τρόπος με τον οποίο αυτοί 

επηρεάζουν τη διαδικασία της αυτόματης αναγνώρισης δακτυλικών αποτυπωμάτων. 

Στο Τέταρτο Κεφάλαιο, πραγματοποιήθηκε η παρουσίαση των 

αποτελεσμάτων της αυτόματης αναγνώρισης δακτυλικών αποτυπωμάτων. 

Αναλυτικότερα, η διάρθρωση τους έγινε σε 5 ενότητες. Στις δύο πρώτες 

αναπτύχθηκαν τα θεωρητικά κριτήρια στα οποία στηρίχθηκε η εξαγωγή τόσο των 

ποιοτικών όσο και των ποσοτικών αποτελεσμάτων. Στη συνέχεια παρουσιάστηκαν τα 
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ποιοτικά και ποσοτικά αποτελέσματα σε πραγματικά δεδομένα δακτυλικών 

αποτυπωμάτων ενώ συμπεριλήφθηκαν τα απαραίτητα σχόλια σχετικά με την επίδοση 

των επιμέρους αλγορίθμων που αναπτύχθηκαν βάσει των παραπάνω αποτελεσμάτων 

προς την κατεύθυνση της αναγνώρισής τους. 

Στο Πέμπτο Κεφάλαιο, έγινε παρουσίαση της διαπαφής που αναπτύχθηκε με 

βάση τη θεωρητική προσέγγιση του αλγορίθμου. Η διεπαφή αναπτύχθηκε με την 

βοήθεια της Borland C++ Builder και χρησιμοποιήθηκε για την εξαγωγή των 

αντίστοιχων αποτελεσμάτων. 

6.2 Μελλοντικές Επεκτάσεις  

6.2.1 Σύγκριση του αλγορίθμου με την μέθοδο ευθυγράμμισης με βάση τις ακμές 

των κορυφογραμμών 

 Ο προτεινόμενος  αλγόριθμος  θα μπορεί να συγκριθεί  με τη μέθοδο 

ευθυγράμμισης με βάση τις μικρολεπτομέρειες. Το διάγραμμα μεθοδολογίας της 

μεθόδου ευθυγράμμισης βασισμένου σε μικρολεπτομέρειες δίνεται από το Σχήμα 6.1. 

Για την εξαγωγή των μικρολεπτομερειών, μία εικόνα δακτυλικού αποτυπώματος 

βελτιώνεται [1], ψηφιοποιείται [2] και εξάγονται οι ακμές των κορυφογραμμών αυτής 

[3]. Έπειτα, ανιχνεύονται οι μικρολεπτομέρειες [4]. Στα πειραματικά αποτελέσματα 

της σύγκρισης, ο αλγόριθμος που βασίζεται στις μικρολεπτομέρειες περιγράφεται στο 

[5]. Σε αυτήν την εργασία οι εικόνες δακτυλικών αποτυπωμάτων ευθυγραμμίζονται 

και συγκρίνονται με βάση την ανίχνευση των μικρολεπτομερειών.  

 

Σχήμα 6.1 Μπλοκ διάγραμμα του προτεινόμενου αλγορίθμου με βάση τις 

μικρολεπτομέρειες. 
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 Για τη σύγκριση των παραπάνω μεθόδων θα χρησιμοποιηθεί ένα κριτήριο το 

οποίο περιγράφεται στη συνέχεια. Αρχικά χρησιμοποιούνται οι παράμετροι 

μετασχηματισμού που εξάγονται από την ευθυγράμμιση με βάση το πεδίου 

προσανατολισμού, ώστε να μετατραπούν οι μικρολεπτομέρειες της τρέχουσας 

εικόνας στο σύστημα συντεταγμένων της εικόνας αναφοράς. Στη συνέχεια, οι 

μικρολεπτομέρειες της τρέχουσας εικόνας τοποθετούνται κατά ζεύγη με αυτές της 

εικόνας αναφοράς, χρησιμοποιώντας ένα συγκεκριμένο παράθυρο. Αν και οι δύο 

μικρολεπτομέρειες, πέσουν μέσα σε αυτό το παράθυρο χαρακτηρίζονται ως ζεύγος 

μικρολεπτομερειών. Αν επίσης έχουν και παρόμοιες κατευθύνσεις, χαρακτηρίζονται 

ως ταιριαστές. Λεπτομέρειες για τον ορισμό του κουτιού περιθωρίου υπάρχουν στο 

[5]. Η επίδοση ταιριάσματος μπορεί να υπολογιστεί με την παρακάτω σχέση : 

 

όπου mr, np, nq, είναι ο αριθμός των μικρολεπτομερειών που ταίριαξαν, αυτών που 

εξήχθησαν από την τρέχουσα εικόνα και αυτών που κατεγράφησαν στην εικόνα 

αναφοράς, αντίστοιχα.   

 

6.2.2 Δυνητικό πλαίσιο εφαρμογής του παρόντος αλγορίθμου - Συμπεράσματα  

 Στην παρούσα διπλωματική εργασία παρουσιάστηκε και αναλύθηκε μία 

μέθοδος αυτόματης ευθυγράμμισης και αναγνώρισης δακτυλικών αποτυπωμάτων με 

χρήση μεθόδων ψηφιακής επεξεργασίας εικόνων. Τα αποτελέσματα, ποιοτικά και 

ποσοτικά, που εξήχθησαν με βάση τη διεπαφή που αναπτύχθηκε στα πλαίσια της 

διπλωματικής εργασίας είναι ενδεικτικά της καλής λειτουργίας του αλγορίθμου που 

προτάθηκε. Ωστόσο, για την καλύτερη και πληρέστερη αξιολόγηση του, απαιτείται 

μία εκτενέστερη εφαρμογή πάνω σε μεγαλύτερες βάσεις δεδομένων δακτυλικών 

αποτυπωμάτων, όπως αυτές παρουσιάστηκαν στο Κεφάλαιο 2.  
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ΠΑΡΑΡΤΗΜΑ Α –Επιστημονικός Κώδικας διεπαφής στην γλώσσα C++ 

Στον παρόν παράρτημα παρουσιάζεται μέρος του επιστημονικού κώδικα στην 

γλώσσα προγραμματισμού C++.   

1. Βελτίωση των εικόνων δακτυλικών αποτυπωμάτων 

 

void __fastcall TForm1::NewEnhanment1Click(TObject *Sender) 

{ 

 //---------------------Μεταβλητές---------------------------------------------- 

 double mean,m,l; 

  double var; 

 //------------------- Mean and Variance---------------------------------------- 

 //Αρχικοποίηση 

   mean=0; var=0; m=0;  l=0; 

 

   for(int y=1; y<height-1; y++)     

            { 

                 for(int x=1; x<width-1; x++) 

                { 

                   m=m+I[x+y*width]; 

                 } 

            } 

               mean=m/(double)(width*height);  

 

   for(int y=0; y<height-1; y++)                

{ 

                 for(int x=0; x<width-1; x++) 

                 { 

 

                   l+=((double)I[x+y*width]-mean)*((double)I[x+y*width]-mean); 

 

       } 

            } 

            var= l/(double)(width*height); 

  

double mref,vref; 

mref=100; vref=100;  m=0; 

 

   for(int y=0; y<height-1; y++)     

            { 

                 for(int x=0; x<width-1; x++) 

                 { 

 

                    if (I[x+y*width]>mean) 

                      { 

 

                        I[x+y*width]=mref+sqrt(vref/var)*abs(I[x+y*width]-mean); 

 

                      } 

                   else if (I[x+y*width]<=mean) 

                     { 

 

                       I[x+y*width]=mref-sqrt(vref/var)*abs(I[x+y*width]-mean); 

 

                     } 

 

                 } 
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            } 

               printImage(I,Image1); 

} 

 

 

 

2. Δημιουργία του Πίνακα Προσανατολισμού μιας εικόνας. 

 

float *Pinakas; 

float *B; 

float *S1; 

float *L1; 

float *S; 

float *L; 

BYTE *J; 

float *A; 

float *F; 

void orienmatrix(TImage* Image,BYTE* V) 

{ 

 

    S1 = new float [width*height]; 

    L1 = new float [width*height]; 

    B = new float [width*height]; 

    S = new float [width*height]; 

    L = new float [width*height]; 

    J = new BYTE [width*height]; 

    A = new float [width*height]; 

    F = new float [width*height]; 

    Pinakas = new float[width*height]; 

 

        memset(A,0,width*height*sizeof(float)); 

        memset(F,0,width*height*sizeof(float)); 

        memset(B,0,width*height*sizeof(float)); 

        memset(L1,0,width*height*sizeof(float)); 

        memset(S1,0,width*height*sizeof(float)); 

        memset(S,0,width*height*sizeof(float)); 

        memset(L,0,width*height*sizeof(float)); 

        memset(J,0,width*height*sizeof(BYTE)); 

        memset(Pinakas,0,width*height*sizeof(float)); 

 

    int     step,x1,y1,x2, 

            y2,count,count2,count3, 

            count4,count5; 

 

    double  g,h,q,Fx,Fy,O; 

    double   mean1,mean2; 

    step=0; 

    g=0; h=0; O=0; 

    count4=0; 

    x1=0,y1=0, count2=0; 

    x2=0,y2=0; count=0; count5=0; 

    count3=0; mean1=0.0; mean2=0.0; 

    int  x,y; 

    int  blocklen= RawParameters->Edit1->Text.ToInt(); 

         step=blocklen/2; 

 

for (int z=1; z<height-1; z++) 

{ 

    for (int w=1; w<width-1; w++) 
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    { 

 

 

            A[w+z*width]=((int)V[(w-1)+(z+1)*width]-(int)V[(w-1)+(z-1)*width]+      //Gradient 

Y 

                     (int)2*V[w+(z+1)*width]-(int)2*V[w+(z-1)*width]+ 

                     (int)V[(w+1)+(z+1)*width]-(int)V[(w+1)+(z-1)*width])/8.0; 

 

            F[w+z*width]=((int)V[(w+1)+(z-1)*width]-(int)V[(w-1)+(z-1)*width]       //Gradient 

X 

                     +2*(int)V[(w+1)+z*width]-2*(int)V[(w-1)+z*width]+ 

                     (int)V[(w+1)+(z+1)*width]-(int)V[(w-1)+(z+1)*width])/8.0; 

 

            J[w+z*width]=sqrt(A[w+z*width]*A[w+z*width]+F[w+z*width]*F[w+z*width]); 

 

    } 

} 

         //printImage(J,Image); 

 

         for(y=0; y<height; y++)                                    

         { 

 

               for(x=0; x<width; x++) 

               { 

                   h=0; q=0; g=0; 

 

                for(int z=y-step; z<=step+y; z++)                                

                {                                                                

                    for(int w=x-step; w<=step+x; w++)                            

                                                                                 

                    { 

                        if (z>=0 && w>=0 && w<width && z<height) 

                        { 

//-----------------Estimation of local orientation of each block---------------- 

 

                            h+=(double)2*A[w+z*width]*(double)F[w+z*width];               

 

 

                            q+=(double)F[w+z*width]*(double)F[w+z*width]- 

                               (double)A[w+z*width]*(double)A[w+z*width]; 

                        } 

                                                                                 

                    } 

 

                } 

                         if (q!=0 || h!=0) 

                         { 

                            g=0.5*atan2(h,q); 

                         } 

                            else 

                            { 

                                g=nodata; 

                            } 

 

 

                         if (g<=0) 

                         { 

                            g=g+0.5*pi; 

                         } 
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                            else if (g>0 && g!=nodata) 

                            { 

                                g=g-0.5*pi; 

                            } 

 

 

                     if (g!=nodata) 

                     { 

                        Fx=cos(2*g); 

                        Fy=sin(2*g); 

                     } 

                        else 

                        { 

                            Fx=nodata; 

                            Fy=nodata; 

                        } 

                            S[count]=Fx; 

                            L[count]=Fy; 

                            count+=1; 

 

 

            } 

        } 

 

                        count3=0; 

                        mean1=0.0; 

                        mean2=0.0; 

                        count2=0; 

                      int filtro; 

                      filtro = RawParameters->Edit4->Text.ToInt(); 

                      for(int j=0;j<height;j++) 

                      { 

                        for(int i=0;i<width;i++) 

                        { 

                            if (S[i+j*width]!=nodata && L[i+j*width]!=nodata) 

                            { 

                                count3=0; 

                                count2=0; 

                                mean1=0.0; 

                                mean2=0.0; 

                            for(int l=-filtro;l<=filtro;l++) 

                            { 

 

                                for(int k=-filtro;k<=filtro;k++) 

                                { 

 

                                    if(i+k>=0 && j+l>=0 && i+k<width && j+l<height) 

                                    { 

 

 

                                            if (S[(i+k)+(j+l)*width]!=nodata) 

                                            { 

                                                mean1+=S[(i+k)+(j+l)*width]; 

                                                count2+=1; 

                                            } 

                                            if (L[(i+k)+(j+l)*width]!=nodata) 

                                            { 

                                                mean2+=L[(i+k)+(j+l)*width]; 

                                                count3+=1; 
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                                            } 

 

                                    } 

 

                                } 

                             } 

 

                                            if(count2!=0) 

                                            { 

                                                mean1/=count2; 

                                            } 

                                            else 

                                            { 

                                                mean1=nodata; 

                                            } 

                                            if(count3!=0) 

                                            { 

                                                mean2/=count3; 

                                            } 

                                            else 

                                            { 

                                                mean2=nodata; 

                                            } 

 

 

 

                               }                                                 

                                else 

                                { 

                                    mean1=S[i+j*(width)]; 

                                    mean2=L[i+j*(width)]; 

                                } 

                               S1[count4]=mean1; 

                               L1[count4]=mean2; 

                               count4+=1; 

                              } 

                            } 

 

                                    for (int p=0; p<count4; p++) 

                                    { 

                                        if (S1[p]!=nodata && L1[p]!=nodata) 

                                        { 

                                            if (S1[p]!=0 || L1[p]!=0) 

                                            { 

                                                O=0.5*atan2(L1[p],S1[p]); 

                                            } 

                                                else 

                                                { 

                                                    O=nodata; 

                                                } 

                                        } 

                                        else 

                                        { 

                                            O=nodata; 

                                        } 

                                            Pinakas[count5]=O; 

                                            count5+=1; 

                                    } 
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                count=0; 

                O=0; 

 

                for(y=0; y<height; y++) 

                { 

 

                    for(x=0; x<width; x++) 

                    { 

 

                            O=B[count]; 

                            Pinakas[x+y*width]=(float)B[count]; 

 

                            if (O!=nodata && x%blocklen==0 && y%blocklen==0) 

                            { 

                                x1=x; 

                                y1=y; 

                                x2=x+cos(O)*10; 

                                y2=y+sin(O)*10; 

 

                                Image->Picture->Bitmap->Canvas->Pen->Color=clWhite; 

                                Image->Picture->Bitmap->Canvas->Pen->Width=2; 

                                Image->Picture->Bitmap->Canvas->MoveTo(x1,y1); 

                                Image->Picture->Bitmap->Canvas->LineTo(x2,y2); 

 

                            } 

 

 

                         count++; 

                    } 

                } 

                

                delete[]  A; 

                delete[]  F; 

                delete[]  J; 

                delete[]  S; 

                delete[]  L; 

                delete[] S1; 

                delete[] L1; 

} 

 

3. Δημιουργία εικόνας προσανατολισμού. 

 

void __fastcall TForm1::Orientation1Click(TObject *Sender) 

{ 

    orienmatrix(Image1,P); 

} 

//-----------------------------------------------------------Orientation Image 2 

 

 

//------------------------------------------------------------------------------ 

 

//----------------------------------------------------------Orienmatrix To Image 

short* OrienImage1; 

short* OrienImage2; 

bool best; 

double discr; 

 

void OrienToImage(float* OrienImage,TImage* Image,int ImageNo) 

{ 
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    if(ImageNo==1) 

    { 

        OrienImage1 = new short [width*height]; 

        memset(OrienImage1,0,width*height*sizeof(short)); 

    } 

    if(ImageNo==2) 

    { 

        OrienImage2 = new short [width*height]; 

        memset(OrienImage2,0,width*height*sizeof(short)); 

    } 

    /* 

    float xmax=-100000,xmin=1000000000; 

 

    for (int i=0; i<=width*height; i++) 

    { 

        if(OrienImage[i]>xmax && OrienImage[i]<100000) xmax=OrienImage[i]; 

        if(OrienImage[i]<xmin) xmin=OrienImage[i]; 

 

    } 

    */ 

 

   float axon; 

   float xmax=0; 

   float xmin=0; 

   if (Form1->RadioAlgo->ItemIndex==0) 

   { 

         xmax=pi/2; 

         xmin=-pi/2; 

   } 

   if (Form1->RadioAlgo->ItemIndex==1) 

   { 

         xmax=pi/2; 

         xmin=0; 

   } 

 

   discr = Form1->Edit1->Text.ToDouble(); 

   axon=discr/(xmax-xmin); 

 

   if(ImageNo==1) 

   { 

   for(int y=0; y<height; y++)     

   { 

        for(int x=0; x<width; x++) 

        { 

            if(OrienImage[x+y*width]!=1000000) 

            { 

                if (Form1->RadioAlgo->ItemIndex==0) 

                { 

                    OrienImage1[x+y*width]=(int)(((OrienImage[x+y*width])-xmin)*axon+0.5); 

                } 

                if (Form1->RadioAlgo->ItemIndex==1) 

                { 

                    OrienImage1[x+y*width]=(int)((fabs(OrienImage[x+y*width])-

xmin)*axon+0.5); 

                } 

            } 

                    else{ OrienImage1[x+y*width]=-1; } 

        } 

   } 
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   } 

   if(ImageNo==2) 

   { 

    for(int y=0; y<height; y++)     

   { 

        for(int x=0; x<width; x++) 

        { 

            if(OrienImage[x+y*width]!=1000000) 

            { 

                if (Form1->RadioAlgo->ItemIndex==0) 

                { 

                    OrienImage2[x+y*width]=(int)(((OrienImage[x+y*width])-xmin)*axon+0.5); 

                } 

                if (Form1->RadioAlgo->ItemIndex==1) 

                { 

                    OrienImage2[x+y*width]=(int)((fabs(OrienImage[x+y*width])-

xmin)*axon+0.5); 

                } 

            } 

                    else {OrienImage2[x+y*width]=-1;} 

        } 

   } 

   } 

 

                 if(ImageNo==2) 

                 { 

                    printImage2(OrienImage2,Image); 

                 } 

                 if(ImageNo==10) 

                 { 

                    printImage2(OrienImage1,Image); 

                 } 

} 

 

4. Υπολογισμός Συντελεστή Αμοιβαίας Πληροφορίας 

 

bool imageok=false; 

bool firstime=true; 

double TForm1::CalculateNMI(short* orien1,short* orien2,TImage* Image) 

{ 

 int twoplothistcount[256*256]; 

 double mutualhist[256*256]; 

 BYTE *plot; 

 plot= new BYTE[256*256]; 

 int j=0; 

 double total=0.0; 

 //Form3->Show(); 

 memset(mutualhist,0,256*256*sizeof(double)); 

 memset( twoplothistcount,0,256*256*sizeof(int)); 

 for (int y=0; y<height; y++) 

 { 

    for(int x=0; x<width; x++) 

    { 

        if((int)orien1[x+y*width]!=-1 && (int)orien2[x+y*width]!=-1) 

        { 

            j = (int)((int)orien1[x+y*width]+(int)orien2[x+y*width]*256); 

            twoplothistcount[j]=twoplothistcount[j]+1; 

        } 

    } 
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 } 

 for (int k=0;k<65536;k++) 

mutualhist[k]=(double)((double)twoplothistcount[k]/(width*height)); 

 //for (int l=0;l<65536;l++) total+=mutualhist[l]; 

 imageok=true; 

 

  /* 

  if(firstime && best ) 

  { 

   for(int y=0; y<256; y++)                                                      

   { 

        for(int x=0; x<256; x++) 

        { 

            if(mutualhist[x+y*256]!=0.0) 

            { 

                plot[x+y*256]=1000000*((mutualhist[x+y*256])); 

 

            } 

            else plot[x+y*256]=0; 

        } 

   } 

 

    Image->Picture->Bitmap->Width = width; 

    Image->Picture->Bitmap->Height = height; 

    Image->Picture->Bitmap->PixelFormat = pf24bit; 

             for(int y=0; y<256; y++) 

             { 

                BYTE* ptr = (BYTE*)Image->Picture->Bitmap->ScanLine[y]; 

                for(int x=0; x<256; x++) 

                { 

 

                        ptr[3*x] = plot[x+y*256]; 

                        ptr[3*x+1] = ptr[3*x]; 

                        ptr[3*x+2] = ptr[3*x]; 

 

                } 

            } 

            Image->Refresh(); 

 

    Form3->Image3->Picture->Bitmap->Width = width; 

    Form3->Image3->Picture->Bitmap->Height = height; 

    Form3->Image3->Picture->Bitmap->PixelFormat = pf24bit; 

    for(int y=0; y<256; y++) 

             { 

                BYTE* ptr = (BYTE*)Form3->Image3->Picture->Bitmap->ScanLine[y]; 

                for(int x=0; x<256; x++) 

                { 

 

                        ptr[3*x] = plot[x+y*256]; 

                        ptr[3*x+1] = ptr[3*x]; 

                        ptr[3*x+2] = ptr[3*x]; 

 

                } 

            } 

            Form3->Image3->Refresh(); 

    } */ 

    Application->ProcessMessages(); 

 

    double HI1=0,HI2=0,HII=0; 
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    double P1[256],P2[256]; 

    for(int k=0; k<256; k++) 

    { 

        P1[k]=0; P2[k]=0; 

    } 

    for(int j=0; j<256; j++) 

    { 

        for(int i=0; i<256; i++) 

        { 

            P1[j]+=(double)mutualhist[i+j*256]; 

 

        } 

 

    } 

    for(int i=0; i<256; i++) 

    { 

        for(int j=0; j<256; j++) 

        { 

            P2[i]+=(double)mutualhist[i+j*256]; 

 

        } 

 

    } 

    for(int i=0; i<256; i++) 

    { 

    if(P1[i]!=0) 

    { 

        HI1+=-(double)P1[i]*(double)log((double)P1[i]); 

    } 

 

    if(P2[i]!=0) 

            { 

                HI2+=-(double)P2[i]*(double)log((double)P2[i]); 

            } 

    } 

    for(int j=0; j<256; j++) 

    { 

        for(int i=0; i<256; i++) 

        { 

            if(mutualhist[i+j*256]!=0) 

            { 

                HII+=-(double)mutualhist[i+j*256]* 

                      (double)log((double)mutualhist[i+j*256]); 

            } 

        } 

    } 

 

    NMI=(double)(((double)HI1+(double)HI2)-(double)HII)/(double)HII; 

    delete[] plot; 

    return NMI; 

} 

 

5. Υπολογισμός συντελεστή Συσχέτισης δύο εικόνων 

 

double TForm1::Correlation(short* orien1,short* orien2) 

{ 

 double Ix,Iy,Ixx,Iyy,Ixy; 

 int cc; 

 Ix=0; 
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 Iy=0; 

 Ixx=0; 

 Iyy=0; 

 Ixy=0; 

 cc=0; 

 double res; 

 for (int y=0; y<height; y++) 

 { 

    for(int x=0; x<width; x++) 

    { 

        if((int)orien1[x+y*width]!=-1 && (int)orien2[x+y*width]!=-1) 

        { 

            Ix+=orien1[x+y*width]; 

            Iy+=orien2[x+y*width]; 

            Ixx+=orien1[x+y*width]*orien1[x+y*width]; 

            Iyy+=orien2[x+y*width]*orien2[x+y*width]; 

            Ixy+=orien2[x+y*width]*orien1[x+y*width]; 

            cc++; 

        } 

    } 

 } 

    NMI= (cc*Ixy-Ix*Iy)/sqrt((cc*Ixx-Ix*Ix)*(cc*Iyy-Iy*Iy)); 

    return NMI; 

 

} 

 

6. Συνάρτηση που εισάγεται στην Powell  

 

   float mi; 

    int iter; 

    float fret; 

    double NMIBEST=-10000; 

    float t1,t2,t3,t4,t5,t6,t7; 

float func(float* T) 

{ 

 

 

        Form1->tranform(T,Pinakas); 

        if(Form1->RadioMutual->ItemIndex==0) 

        { 

            Form1->CalculateNMI(OrienImage1,OrienImage2,Form3->Image3); 

        } 

        if(Form1->RadioMutual->ItemIndex==1) 

        { 

            Form1->Correlation(OrienImage1,OrienImage2); 

        } 

        t1=(float)T[1]; t2=(float)T[2]; t3=(float)T[3]; 

        t4=(float)T[4]; t5=(float)T[5]; t6=(float)T[6]; 

        t7=(float)T[7]; 

        if (Form1->RadioTransform->ItemIndex==0) 

        { 

            if(t1>0.35  || t1 <-0.35) { Form1->NMI=0;return  Form1->NMI;} 

            if(t2>1.03 || t2 <0.97) { Form1->NMI=0;return  Form1->NMI;} 

            if(t3>1.03 || t3 <0.97) { Form1->NMI=0;return  Form1->NMI;} 

            if(t4>0.1  || t4 <-0.1) { Form1->NMI=0;return  Form1->NMI;} 

            if(t5>0.1  || t5 <-0.1) { Form1->NMI=0;return  Form1->NMI;} 

            if(t6>80   || t6 <-80) { Form1->NMI=0;return  Form1->NMI;} 

            if(t7>80   || t7 <-80) { Form1->NMI=0;return  Form1->NMI;} 

        } 
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        if (Form1->RadioTransform->ItemIndex==1) 

        { 

            if(t1>0.35  || t1 <-0.35) { Form1->NMI=0;return  Form1->NMI;} 

            if(t2>1.03 || t2 <0.97) { Form1->NMI=0;return  Form1->NMI;} 

            if(t3>1.03 || t3 <0.97) { Form1->NMI=0;return  Form1->NMI;} 

            if(t4>0.1  || t4 <-0.1) { Form1->NMI=0;return  Form1->NMI;} 

            if(t5>0.1  || t5 <-0.1) { Form1->NMI=0;return  Form1->NMI;} 

            if(t6>80   || t6 <-80) { Form1->NMI=0;return  Form1->NMI;} 

            if(t7>80   || t7 <-80) { Form1->NMI=0;return  Form1->NMI;} 

        } 

 

        double NMIndex=Form1->NMI; 

        best=false; 

        if(NMIndex > NMIBEST && NMIndex!=NMIBEST) 

        { 

 

            NMIBEST=Form1->NMI; 

            printImage2(OrienImage1,Form1->Image1); 

            best=true; 

        } 

        delete[] OrienImage1; 

        return -(Form1->NMI); 

 

} 

 

 

7. Αρχικοποίηση και εκτέλεση της Powell  

 

void __fastcall TForm1::PowellClick(TObject *Sender) 

{ 

 

 

  int n ; 

  float **xi=0; 

  float *p=0; 

  Timer1->Enabled = false; 

  CurrentTickValue = GetTickCount(); 

  orienmatrix(Image2,I); 

  OrienToImage(Pinakas,Image2,2); 

  J=P; 

  orienmatrix(Image1,J); 

  OrienToImage(Pinakas,Image1,1); 

  Form3->Image3->Refresh(); 

  if(Form1->RadioTransform->ItemIndex==0)     /*Affine*/ 

  { 

  n = 7; 

  p=vector(1,n); 

  xi = matrix(1,n,1,n); 

  xi[1][1]=1.0; xi[1][2]=0.0; xi[1][3]=0.0; xi[1][4]=0.0; xi[1][5]=0.0; xi[1][6]=0.0; 

xi[1][7]=0.0; 

  xi[2][1]=0.0; xi[2][2]=1.0; xi[2][3]=0.0; xi[2][4]=0.0; xi[2][5]=0.0; xi[2][6]=0.0; 

xi[2][7]=0.0; 

  xi[3][1]=0.0; xi[3][2]=0.0; xi[3][3]=1.0; xi[3][4]=0.0; xi[3][5]=0.0; xi[3][6]=0.0; 

xi[3][7]=0.0; 

  xi[4][1]=0.0; xi[4][2]=0.0; xi[4][3]=0.0; xi[4][4]=1.0; xi[4][5]=0.0; xi[4][6]=0.0; 

xi[4][7]=0.0; 

  xi[5][1]=0.0; xi[5][2]=0.0; xi[5][3]=0.0; xi[5][4]=0.0; xi[5][5]=1.0; xi[5][6]=0.0; 

xi[5][7]=0.0; 
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  xi[6][1]=0.0; xi[6][2]=0.0; xi[6][3]=0.0; xi[6][4]=0.0; xi[6][5]=0.0; xi[6][6]=1.0; 

xi[6][7]=0.0; 

  xi[7][1]=0.0; xi[7][2]=0.0; xi[7][3]=0.0; xi[7][4]=0.0; xi[7][5]=0.0; xi[7][6]=0.0; 

xi[7][7]=1.0; 

        p[1]=0.0; 

        p[2]=1.0; 

        p[3]=1.0; 

        p[4]=0.0; 

        p[5]=0.0; 

        p[6]=0.0; 

        p[7]=0.0; 

        powell(p,xi,n,1e-5,&iter,&fret,func); 

        Edit5->Text=iter; 

        Edit8->Text=(float)-fret; 

        Edit9->Text=(float)((t1*180/pi)); 

        Edit10->Text=(float)t6; 

        Edit12->Text=(float)t7; 

 

  } 

  if(Form1->RadioTransform->ItemIndex==1)        /*Rigid*/ 

  { 

        n = 3; 

        p=vector(1,n); 

        xi = matrix(1,n,1,n); 

        xi[1][1]=1.0; xi[1][2]=0.0; xi[1][3]=0.0; 

        xi[2][1]=0.0; xi[2][2]=1.0; xi[2][3]=0.0; 

        xi[3][1]=0.0; xi[3][2]=0.0; xi[3][3]=1.0; 

        p[1]=0.0; 

        p[2]=0.0; 

        p[3]=0.0; 

        powell(p,xi,n,1e-5,&iter,&fret,func); 

        Edit5->Text=iter; 

        Edit8->Text=(float)-fret; 

        Edit9->Text=(float)(p[1]*180/pi); 

        Edit10->Text=(float)t2; 

        Edit12->Text=(float)t3; 

 

   } 

   if(Form1->RadioTransform->ItemIndex==2)              /*Similitude*/ 

   { 

        n = 4; 

        p=vector(1,n); 

        xi = matrix(1,n,1,n); 

        xi[1][1]=1.0; xi[1][2]=0.0; xi[1][3]=0.0; xi[1][4]=0.0; 

        xi[2][1]=0.0; xi[2][2]=1.0; xi[2][3]=0.0; xi[2][4]=0.0; 

        xi[3][1]=0.0; xi[3][2]=0.0; xi[3][3]=1.0; xi[3][4]=0.0; 

        xi[4][1]=0.0; xi[4][2]=0.0; xi[4][3]=0.0; xi[4][4]=1.0; 

        p[1]=0.0; 

        p[2]=0.0; 

        p[3]=0.0; 

        p[4]=1.0; 

        powell(p,xi,n,1e-5,&iter,&fret,func); 

        Edit5->Text=iter; 

        Edit8->Text=(float)-fret; 

        Edit9->Text=(float)(p[1]*180/pi); 

        Edit10->Text=(float)t2; 

        Edit12->Text=(float)t3; 

   } 

   trans(J); 
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   Edit2->Text=(float)Calculate_MOM(TransImage,J,480,504); 

   if (xi) free_matrix(xi,1,n,1,n); 

   if (p) free_vector(p,1,n); 

   Timer1->Enabled = true; 

   TimeElapse = GetTickCount(); 

 

} 

 

8. Η συνάρτηση μετασχηματισμών  

float Pinakas_fl; 

 

void TForm1::tranform(float* F,float* pin1) 

{ 

 

 

    Pinakas_fl=new float[width*height]; 

    int x=0,y=0; 

    float det=0.0; 

    memset(Pinakas_fl,0,width*height*sizeof(float)); 

 

    if (Form1->RadioTransform->ItemIndex==0) 

    { 

        float g =F[1]; 

        float sx=F[2]; 

        float sy=F[3]; 

        float Hx=F[4]; 

        float Hy=F[5]; 

        float dx=F[6]; 

        float dy=F[7]; 

        if(Hx*Hy!=1) {det=(float)(1/(fabs(1-Hx*Hy)));} 

        float cosg = (float)cos(g); 

        float sing = (float)sin(g); 

 

        for(int j=0; j<height; j++) 

        { 

 

            for(int i=0; i<width; i++) 

            { 

 

 

                    int i1=i-width/2; 

                    int j1=j-height/2; 

                    x= (cosg/(det*sx)+(Hx*sing)/det)*(i1-dx)+(sing/(det*sx)-Hx*cosg/det)*(j1-dy); 

                    y= ((-Hy*cosg)/det-sing/(det*sy))*(i1-dx)+(-Hy*sing/det+cosg/(det*sy))*(j1-dy); 

                    x+=width/2; 

                    y+=height/2; 

                    int ix=(int)x; 

                    int iy=(int)y; 

                    float hx=x-ix; 

                    float hy=y-iy; 

                    float hxx=(float)(1-hx); 

                    float hyy=(float)(1-hy); 

                    if (ix>=0 && iy>=0 && ix<width-1 && iy<height-1) 

                    { 

 

 

 

                        Pinakas_fl[(int)i+(int)j*width]=(float)((pin1[ix+iy*width]*hxx*hyy) 

                                            +(pin1[(ix+1)+(iy)*width]*hx*hyy) 
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                                            +(pin1[ix+(iy+1)*width]*hxx*hy) 

                                            +(pin1[(ix+1)+(iy+1)*width]*hx*hy)); 

 

 

                    } 

                    else 

                    { 

                        Pinakas_fl[i+j*width]=nodata; 

                    } 

 

                } 

            } 

 

                OrienToImage(Pinakas_fl,Image1,1); 

    } 

    if(Form1->RadioTransform->ItemIndex==1)          /*Rigid*/ 

    { 

        float g=F[1]; 

        float b0=F[2]; 

        float b1=F[3]; 

        float co=cos(g); 

        float si=sin(g); 

 

        for(int j=0; j<height; j++) 

        { 

 

            for(int i=0; i<width; i++) 

            { 

             int i1=i-width/2; 

             int j1=j-height/2; 

             x=co*(i1-b0)-si*(j1-b1); 

             y=si*(i1-b0)+co*(j1-b1); 

             x+=width/2; 

             y+=height/2; 

             int ix=(int)x; 

             int iy=(int)y; 

             float hx=x-ix; 

             float hy=y-iy; 

             float hxx=(float)(1-hx); 

             float hyy=(float)(1-hy); 

                if (ix>=0 && iy>=0 && ix<=width-1 && iy<=height-1) 

                { 

 

 

 

                    Pinakas_fl[(int)i+(int)j*width]=(float)((pin1[ix+iy*width]*hxx*hyy) 

                                            +(pin1[(ix+1)+(iy)*width]*hx*hyy) 

                                            +(pin1[ix+(iy+1)*width]*hxx*hy) 

                                            +(pin1[(ix+1)+(iy+1)*width]*hx*hy)); 

 

 

                } 

                else 

                { 

                    Pinakas_fl[i+j*width]=nodata; 

                } 

 

            } 

        } 
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                OrienToImage(Pinakas_fl,Image1,1); 

 

    } 

     if(Form1->RadioTransform->ItemIndex==2)            /*Similitude*/ 

     { 

        float g=F[1]; 

        float b0=F[2]; 

        float b1=F[3]; 

        float r=F[4]; 

        float co=cos(g); 

        float si=sin(g); 

        for(int j=0; j<height; j++) 

        { 

 

            for(int i=0; i<width; i++) 

            { 

             int i1=i-width/2; 

             int j1=j-height/2; 

             x=r*co*(i1-b0)-r*si*(j1-b1); 

             y=r*si*(i1-b0)+r*co*(j1-b1); 

             x+=width/2; 

             y+=height/2; 

             int ix=(int)x; 

             int iy=(int)y; 

             float hx=x-ix; 

             float hy=y-iy; 

             float hxx=(float)(1-hx); 

             float hyy=(float)(1-hy); 

             if (ix>=0 && iy>=0 && ix<=width-1 && iy<=height-1) 

                { 

 

 

 

 

                    Pinakas_fl[(int)i+(int)j*width]=(float)((pin1[ix+iy*width]*hxx*hyy) 

                                            +(pin1[(ix+1)+(iy)*width]*hx*hyy) 

                                            +(pin1[ix+(iy+1)*width]*hxx*hy) 

                                            +(pin1[(ix+1)+(iy+1)*width]*hx*hy)); 

 

 

                } 

                else 

                { 

                    Pinakas_fl[i+j*width]=nodata; 

                } 

 

            } 

        } 

 

                OrienToImage(Pinakas_fl,Image1,1); 

 

        } 

                delete[] Pinakas_fl; 

  } 

 

9. Κριτήριο Σκακιέρας  

 

void __fastcall TForm1::ChessBoard1Click(TObject *Sender) 
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{ 

        int t1=0; 

        int t2=0; 

        int t3=0; 

        int step=21; 

        int quot; 

        int rem; 

        int index; 

        div_t divresult; 

        for(int y=0; y<height; y+=step) 

        { 

 

            for(int x=0; x<width; x+=step) 

            { 

                for(int z=y; z<step+y; z++) 

                { 

                    for(int w=x; w<step+x; w++) 

 

                    { 

                        if (z>=0 && w>=0 && w<width && z<height) 

                        { 

                            index = x+y*width; 

                            divresult = div(index,step); 

                            t1 = divresult.quot; 

                            divresult = div(t1,2); 

                            t2 = divresult.rem; 

                            divresult = div(y,2); 

                            t3 = divresult.rem; 

                            if(t3!=0) 

                            { 

                                if(t2!=0) 

                                { 

                                    itemp1[w+z*width]=temppic[w+z*width]; 

                                } 

                                else  itemp1[w+z*width]=I[w+z*width]; 

                               } 

                            else 

                            { 

                                if(t2!=0) 

                                { 

                                    //itemp1[w+z*width]=itemp2[w+z*width]; 

                                    itemp1[w+z*width]=I[w+z*width]; 

                                } 

                                else itemp1[w+z*width]=temppic[w+z*width]; 

                            } 

                        } 

                    } 

                } 

            } 

 

        } 

        printImage(itemp1,Image1); 

} 

 

10. Κριτήριο Διαφάνειας  

 

void __fastcall TForm1::TrackBar6Change(TObject *Sender) 

{ 

    float i=TrackBar6->Position/100.0; 
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    for(int y=0; y<height; y++) 

        { 

 

            for(int x=0; x<width; x++) 

            { 

 

               itemp1[x+y*width] = i*temppic[x+y*width]+(1-i)*I[x+y*width]; 

            } 

        } 

        printImage(itemp1,Image2); 

} 

 

11. Κριτήριο Σύγκρισης Διαφορών 

 

void __fastcall TForm1::CompareActionExecute(TObject *Sender) 

{ 

     if(Form1->RadioTransform->ItemIndex==1)            /*Rigid*/ 

     { 

        float g=t1; 

        float b0=t2; 

        float b1=t3; 

        float co=cos(g); 

        float si=sin(g); 

        float x,y; 

        temppic=new BYTE[width*height]; 

        memset(temppic,0,width*height*sizeof(BYTE)); 

        for(int j=0; j<height; j++) 

        { 

 

            for(int i=0; i<width; i++) 

            { 

             int i1=i-width/2; 

             int j1=j-height/2; 

             x=co*(i1-b0)-si*(j1-b1); 

             y=si*(i1-b0)+co*(j1-b1); 

             x+=width/2; 

             y+=height/2; 

             int ix=(int)x; 

             int iy=(int)y; 

             float hx=x-ix; 

             float hy=y-iy; 

             float hxx=(float)(1-hx); 

             float hyy=(float)(1-hy); 

                if (x>=0 && y>=0 && x<=width-1 && y<=height-1) 

                { 

 

 

 

                    temppic[(int)i+(int)j*width]=(int)((itemp1[ix+iy*width]*hxx*hyy) 

                                            +(itemp1[(ix+1)+(iy)*width]*hx*hyy) 

                                            +(itemp1[ix+(iy+1)*width]*hxx*hy) 

                                            +(itemp1[(ix+1)+(iy+1)*width]*hx*hy)); 

 

 

                } 

                else 

                { 

                    temppic[i+j*width]=255; 

                } 
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            } 

        } 

     } 

 

 

     if (Form1->RadioTransform->ItemIndex==0) 

    { 

        float g =t1; 

        float sx=t2; 

        float sy=t3; 

        float Hx=t4; 

        float Hy=t5; 

        float dx=t6; 

        float dy=t7; 

        float det=0.0; 

        int x=0,y=0; 

        temppic=new BYTE[width*height]; 

        memset(temppic,0,width*height*sizeof(BYTE)); 

        if(Hx*Hy!=1) {det=(float)(1/(fabs(1-Hx*Hy)));} 

        float cosg = (float)cos(g); 

        float sing = (float)sin(g); 

 

        for(int j=0; j<height; j++) 

        { 

 

            for(int i=0; i<width; i++) 

            { 

 

 

                    int i1=i-width/2; 

                    int j1=j-height/2; 

                    x= (cosg/(det*sx)+(Hx*sing)/det)*(i1-dx)+(sing/(det*sx)-Hx*cosg/det)*(j1-dy); 

                    y= ((-Hy*cosg)/det-sing/(det*sy))*(i1-dx)+(-Hy*sing/det+cosg/(det*sy))*(j1-dy); 

                    x+=width/2; 

                    y+=height/2; 

                    int ix=(int)x; 

                    int iy=(int)y; 

                    float hx=x-ix; 

                    float hy=y-iy; 

                    float hxx=(float)(1-hx); 

                    float hyy=(float)(1-hy); 

                    if (ix>=0 && iy>=0 && ix<=width-1 && iy<=height-1) 

                    { 

 

 

 

                        temppic[(int)i+(int)j*width]=(int)((itemp1[ix+iy*width]*hxx*hyy) 

                                            +(itemp1[(ix+1)+(iy)*width]*hx*hyy) 

                                            +(itemp1[ix+(iy+1)*width]*hxx*hy) 

                                            +(itemp1[(ix+1)+(iy+1)*width]*hx*hy)); 

 

 

                    } 

                    else 

                    { 

                         temppic[i+j*width]=255; 

                    } 
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                } 

            } 

 

 

    } 

     if(Form1->RadioTransform->ItemIndex==2)            /*Similitube*/ 

     { 

        float g=t1; 

        float b0=t2; 

        float b1=t3; 

        float r=t4; 

        float co=cos(g); 

        float si=sin(g); 

        float x,y; 

        temppic=new BYTE[width*height]; 

        memset(temppic,0,width*height*sizeof(BYTE)); 

        for(int j=0; j<height; j++) 

        { 

 

            for(int i=0; i<width; i++) 

            { 

             int i1=i-width/2; 

             int j1=j-height/2; 

             x=r*co*(i1-b0)-r*si*(j1-b1); 

             y=r*si*(i1-b0)+r*co*(j1-b1); 

             x+=width/2; 

             y+=height/2; 

             int ix=(int)x; 

             int iy=(int)y; 

             float hx=x-ix; 

             float hy=y-iy; 

             float hxx=(float)(1-hx); 

             float hyy=(float)(1-hy); 

             if (ix>=0 && iy>=0 && ix<=width-1 && iy<=height-1) 

                { 

 

 

 

                    temppic[(int)i+(int)j*width]=(int)((itemp1[ix+iy*width]*hxx*hyy) 

                                            +(itemp1[(ix+1)+(iy)*width]*hx*hyy) 

                                            +(itemp1[ix+(iy+1)*width]*hxx*hy) 

                                            +(itemp1[(ix+1)+(iy+1)*width]*hx*hy)); 

 

 

                } 

                else 

                { 

                    temppic[i+j*width]=255; 

                } 

 

            } 

       } 

     } 

 

        FILE *p; 

        p = fopen("C:\\finger.raw","w"); 

        fwrite(temppic,width*height,sizeof(BYTE),p); 

        fclose(p); 

        for(int j=0; j<height; j++) 
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        { 

 

            for(int i=0; i<width; i++) 

            { 

 

                itemp1[i+j*width] = abs((int)temppic[i+j*width]-(int)I[i+j*width]); 

            } 

        } 

 

            printImage(itemp1,Image1); 

} 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


